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Introduction 
GEOPAK is a comprehensive software package that covers every project phase from 
conceptualization to final quantities and construction stake-out.  The software works within the 
MicroStation graphic environment providing true interactive design.  For example, a horizontal 
alignment can be created graphically, it can be calculated with the coordinate geometry component of 
GEOPAK or some interactive combination of the two.  Dynamic on-screen design provides immediate 
interpretation of plan view geometrics for making design choices through visualization. 

Using GEOPAK will help ensure consistency and accuracy of design work and generate a significant 
time savings in the overall effort of producing construction plans. 

1.1   File Names 
GEOPAK uses and/or creates files during the design process.  Several of the more common files are 
detailed in the table below.  

job###.gpk This binary file is created when the user starts a coordinate geometry 
(COGO) session for the first time or created through Project Manager.  
The file may be appended to during the design process. All coordinate 
geometry elements are stored in this file.  Multiple users can access this 
file at the same time, and only one file should be created for each project.  
The "###" is the only variable in this filename.  It represents a job number 
(up to 3 alphanumeric characters) unique to a project and is defined by the 
user upon creation. 

fname###.ioc 
Example: 
align999.ijd 

ASCII input file for loading data during a COGO session. "###" represents 
the job number and "oc" is the operator code (users initials). Filename 
characters are limited to 5 characters plus the 3 job number character 
designation as indicated with the example. 

fname###.ooc 
Example: 
align999.ojd 

ASCII output file created by GEOPAK during a COGO session. Variables 
are the same as defined above.  Filename characters are limited to 5 
characters plus the 3 job number character designation as indicated with 
the example. 

fname.inp  
Example: desxs.inp 

Any ASCII input file for running GEOPAK processes.  Name is user 
defined with a .INP extension.  

fname.dat 
 

A binary file that contains string and point information to be used for digital 
terrain model construction. 

fname.tin A binary file containing triangular surfaces also known as the digital terrain 
model (DTM). 

Project-name.prj Binary file resulting from the creation of a new project. 
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1.2   Accessing GEOPAK 
GEOPAK is started upon entering a MicroStation File.  To verify that GEOPAK is active, scan the 
MicroStation menu bar where the Applications menu appears.  Simply select Applications > 
GEOPAK Road.  When each GEOPAK tool is selected, the corresponding dialog box(es) will appear. 

 

To close a dialog box, the following options are available: 

  Click the X in the upper right corner of the dialog box 
  Select the File > Exit option 
  Or click Cancel on the dialog box 

 
 Use one of the above options that appear in the dialog box. 
 
Exiting the MicroStation file automatically closes all GEOPAK dialog boxes. 

1.3   User Preferences 
When a user begins Geopak for the first time or after Geopak has been reloaded, there are certain 
User Preferences the user needs to set.  The User Preferences dialog box can be accessed from 
Applications > Geopak Road > User Preferences.  The following dialog box appears. 

1  VDOT Road I Training GEOPAK 2001MR-2    
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Most of the settings in this dialog box can be defined when a project is created within Project 
Manager (See Chapter 2). 

The Working Directory identifies where the data files for a particular project can be found.  If a user 
does not want to work within a specific project, the field may be left blank, and Geopak uses the 
directory wherein the open MicroStation file is located. 

By clicking the Feature Preferences button, the following dialog box is invoked. 

 

This defines the default file utilized for representation of coordinate geometry and survey elements 
when visualization is utilized during an active coordinate geometry session as well as the scale in 
which these elements will be displayed. 

By pressing the COGO Preferences button, the following dialog box is invoked. 

GEOPAK 2001MR  1-Introduction   3 
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The Job Directory field specifies the location of the GPK file.  Since multiple people can read and 
write the GPK file simultaneously, it is possible to have this file on a server or in a shared folder.  If 
any of the above directory fields are blank, they will default to the Working Directory set in the 
GEOPAK User preferences dialog box. 

By pressing the Superelevation Preferences button, the following dialog box is invoked if your 
preferences are set to GEOPAK 2000. 

 

This dialog box allows either a standard superelevation preference file to be opened for the active 
GEOPAK session or user defined settings to be supplied for the current session.  

The Plan & Profile Sheet Compatibility option menu can be set to Classic, GEOPAK 2001+ or 
GEOPAK 2001+ with Raster Manager.  Classic enables the original GEOPAK Plan & Profile clip 
sheet tool, whereas the 2001+ option utilizes a new tool for Plan and Profile sheet generation. 
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LAB 1:  User Preferences 
Review of Steps to Define Design Preferences 

Step 1. Execute C:\data\geo\vdot\road1\LAB1.EXE.  

 Note: Make sure you accept the path and unzip the files to C:\. 

GEOPAK 2001MR 

Step 2. Open the MicroStation file C:\data\geo\vdot\road1\d17682des.dgn 

Step 3. Access the GEOPAK User Preferences dialog box from the Applications pulldown.  
Applications > GEOPAK Road > User Preferences. 

 The User Preferences dialog box appears as shown. 

 

Step 4. Click the Feature Preferences button and set the Plot Scale to 100 as shown and toggle 
on Apply Best Match Feature. 

 

 Click OK. 
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Step 5. Make sure that the Superelevation Preferences option is set to GEOPAK 2000. 

 Also, set the Plan & Profile Sheet Compatibility option to GEOPAK2001+. 

  

Step 6. On the GEOPAK User Preferences dialog box, click OK. 

Step 7.  Exit Microstation. 
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Project Manager 

2.1   Introduction 
Objectives Learn how to set up a project using Project Manager. 

Learn how to utilize Project Manager as a workflow guide. 
Learn how to access GEOPAK dialog boxes from the Project Manager. 

Menu Bar Application Applications > GEOPAK Road > Project Manager 

Road Tool Frame 

  

 

Project Manager is a GEOPAK tool that associates a project with its respective coordinate geometry 
job number, users, working directories and project files.  Project Manager provides the user with an 
easy workflow system that keeps records of processes run throughout the design of a project. 

2.2   Accessing Project Manager 
To access Project Manager, select Applications > 
GEOPAK Road > Project Manager or click the Project 
Manager icon.  The adjacent dialog box appears. 

The current directory is displayed at the top of the dialog  
box.  This may be modified by traversing to a different 
directory in the Directories list box.  Project files (.prj) are 
displayed in the projects list box.   

The remainder of the Project Manager dialog box displays 
information after a project has been selected from the 
Projects list box.  At the bottom of the dialog box are the 
OK and Cancel buttons.  To exit Project Manager, click 
the Cancel button.  To continue in the Project Manager 
process, click the OK button. 

 

2.3   Project Manager Menu Bar 
There are three options on the Menu Bar: Projects, Directory and Admin.  Each of these choices 
has tools contained in the pull down. 
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2.3.1   Project Tools 
There are four options under the Projects pull down, New, Edit, Delete and Exit as shown below. 

 

The New menu option is used to create a new project.  The .prj file is stored in the directory shown in 
the Directory path at the top of the Project Manager dialog box.  When the New menu option is 
selected, the following Create New Project dialog box appears. 

 

The Project Name can be any number of alphanumeric characters.  The Working Directory 
specifies the location of the project data files and may be manually entered.  In lieu of typing, the 
Select button may be clicked and the appropriate directory selected.  

The Working Directory can be left blank if it is desired to have all of the MicroStation and GEOPAK 
files in a single directory. 

The next field is for keying in the COGO Job Number or the Select button may be clicked and the 
appropriate COGO job number selected. 
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Next, the Preferences button should be clicked, invoking the Project Preferences dialog box.  

 

The user may click on COGO Preferences, then set the particular parameters for each project as well 
as the directories for the COGO job number, COGO input files and COGO output files.  By setting 
these parameters for each project, the user can open a design file in one directory and then open 
another design file in a different directory and still access the correct .gpk file and also save Cogo 
input and output files to the proper directory.  The user simply chooses the project and all parameters 
are automatically set.  After all the information is entered, the OK button is clicked or if the user 
wishes to abort, the Cancel button may be clicked.   

 

NOTE:  If these fields are left blank, the project working directory is used. 

 

Shown below is a sample project that includes a project description, which may be keyed in at the 
bottom of the Create New Project dialog box or added later by accessing it from the Edit menu. 

 

The Edit option on the pull down menu is used to change any settings associated with the currently 
selected project. 

The Delete option on the pull down menu is used to delete any project that has been stored.  The user 
highlights the project in the Projects list box and selects Delete. 
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The Exit option on the pull down menu closes the Project Manager and writes the settings to a 
resource file. 

2.3.2   Directory Tools 
There are two options under the Directory pull down, Create New Directory and Current Working 
Directory as shown. 

 

The Create New Directory option creates a new directory on your computer within the current 
directory.  If the Current Working Directory option is chosen, the directory path in Project Manager is 
changed to that directory.  

2.3.3   Administration Tools 
The Administration menu option is used to set a password on a project, if desired.  

 

2.4   Project Users Dialog Box 
Once a project is highlighted and OK is selected, the Project Users dialog box appears. 

 

This dialog box has three sections: Project Users, User Info and Description.  The Project Users 
list displays a list of users that have been created to work with any project that resides in the current 
projects home directory.  The names shown in Project Users will be the user id’s of the people 
working on that project as specified in the Start Job dialog box.  Within the User Info group box, the 
Full Name field further identifies the user, and displays the full name of the user that is currently 
selected.  The OP Code field displays the Geopak Operator Code of the currently selected user.  The 
Geopak Operator Code is used for all coordinate geometry operations during this session.  The 
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Operator Code, along with the Job Number will be utilized whenever a COGO input or output file is 
created by the software.  The Operator Code is typically the user’s initials.  The Description field 
displays the description of the currently selected user. 

Four tools are supported on the Project Users pulldown as depicted in the exploded view below.  

 

New The New pull down menu option creates new users.  This option will create 
users only for the selected project. 

Edit Enables the user to change any of the parameters of the currently selected user.  
(Note: The User cannot be changed.)  This changes the user information for 
the current project only. 

Delete Deletes the highlighted user. 

Password Creates or modifies a password for the selected user.  If the selected user 
already has a password, the user will be prompted to enter the current password 
before continuing. 

Exit Closes the User Dialog box and returns back to the Project Manager dialog box. 

 

2.5   Road Project Dialog Box 
After a minimum of one user has been defined, click the OK button in the lower left corner of the 
Project Users dialog box or double click on a Project User opens the Applications dialog box as 
depicted. 
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When the Road option is clicked, the following dialog box appears. 

 

The top of the dialog box displays the Working Directory, Working Alignment (if defined), User and 
GEOPAK Job Number.  In addition, a toggle for Working Alignment Influence Runs is also 
supported.  The bottom portion of the dialog box displays the various processes supported during the 
design process.  The small square in the upper right corner will condense the dialog box as depicted 
in the graphic below.  

 

2.5.1   Road Project Dialog Menu Bar 
There are two pull down menu bar options: File and Remember.  When the File option is 
selected, Close and Exit are supported.  

If the Close option is selected, the user is returned to the Applications dialog box.  If Exit 
is selected the user is exited from the Project Manager.  

 
When the Remember option is selected, the user can instruct the software 
to remember the Project, User, or Road in subsequent sessions.  For 
example, if all three toggles are activated, and the Project Manager is 
completely closed (all dialog boxes), the invocation of the Project Manager 
immediately invokes the Road Project dialog box (flow chart) and utilizes 
the project name, user name, etc., which were active when the Remember 
toggles were selected.  
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If only the Project and User toggles are activated, the user is returned to the Project dialog box in 
later sessions.  If only the Project toggle is activated, the user is returned to the Project Users dialog 
box in subsequent sessions.  This option is particularly useful when numerous users are working on 
one project.  

When the Auto Sink option is enabled, the Road Project flow chart sinks 
behind all open views when any tool is selected from the flow chart.  
Once the tool is closed, the Road Project flow chart will be brought to the 
top of the view window.  

2.5.2   Working Alignment 
The concept of a working alignment enables the designer to organize a project and to access project 
information without continually typing the required information.  On a simple project, only one working 
alignment may be needed.  However, on a more complicated project, an unlimited number of working 
alignments may be defined.  With each working alignment, the designer can define associated data, 
i.e., name of cross section and plan view files, element symbology, etc.  The designer can easily 
change from one working alignment to another by highlighting the desired alignment listed in the 
Select dialog box.  Once the working alignment is selected, all previously stored data is utilized in 
subsequent processing.  Three tools relating to working alignments are located at the top of the Road 
Project dialog box: 

? Select Button 
? Define button 
? Working Alignment Influence Runs (toggle on left side of dialog box) 
 

 

The Port Viewer (covered in detail in Chapter 13) is a tool that enables the user to view and 
manipulate all three major aspects of a road design simultaneously, even though they are located in 
different files.  The Port Viewer tool is only available while working within the Project Manager 
application. The applicable views for design display include: 

• Plan view layout 
• Profile 
• Cross sections 
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2.5.2.1   Select Option 

 

When the Select button is clicked, the Select Working Alignment dialog box appears as depicted to 
the right.  If no working alignments have been defined, UNTITLED appears in the Run List box.  If 
working alignments have been defined, they are listed with the last run time.  The description of the 
working alignment can be seen in the bottom of the dialog box when each Name is highlighted.  To 
select a previously defined working alignment, highlight the run from the list, then click the OK button 
at the bottom of the dialog box.  Double clicking on the Name also selects a previous working 
alignment for subsequent processing.  Clicking the Cancel button will close the Select Run dialog box 
without any File selection.  Several Run options are supported as depicted in the exploded view below.   

 

These are detailed in the table below. 

New Create a new working alignment 

Copy Copy a run from an existing Project, a User in the same project or Run 
created by the current user. 

Modify Change the name of the existing working alignment. 

Delete Delete an existing working alignment. 
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2.5.2.2   Define Option 
Once a Run has been selected, clicking the Define button invokes the dialog box depicted below. 

 

The information that can be associated with a working alignment is listed in the left portion of the 
dialog box.  As each option is chosen, the right side of the dialog box will change to reflect the 
information needed as can be seen in the dialog box to the right after Profile View was selected.  

All information entered in these fields can be used in subsequent processes run from Project 
Manager.  In the beginning of a project, much of this information will not be known, but as the user 
goes through the design process, it can be added to the working alignment definitions.  

For example, as soon as a chain has been stored in COGO, the user can enter that information in the 
Plan View fields on the right side of the dialog box.  For a more complete explanation of each option 
shown, please see the GEOPAK Manual or On-Line Help. 

2.6   Project Manager Process 
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The primary Project Manager dialog box is depicted above.  The advantage of utilizing the Project 
Manager rather than selecting functions directly from the Road menu is that pertinent information 
stored within the Project Manager is automatically displayed within the invoked dialog box.  Therefore, 
job numbers, chain names, stationing, file names and data associated with the project do not have to 
be typed in each time a dialog box is utilized.  However, if the user chooses to change the fields, they 
have that option. 

Many of the Project Manager processes function identically to their corresponding dialog boxes 
invocation from the Road menu.  However, some of the procedures invoke the Select Run dialog box 
prior to invoking the actual dialog box.  The Select Run dialog box enables the user to set up different 
options to use in alternative design choices or different typicals. 

2.7   Online Help 
More information can be found under Applications > GEOPAK Road > Help > Project Manager. 
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LAB 2:   Project Manager 

Introduction 
Step 1. Execute C:\data\geo\VDOT\road1\LAB2.EXE. 

Step 2. Open the MicroStation file C:\data\geo\VDOT\road1\d17682dtm.dgn 

Step 3. Invoke the Road Tools tool frame from the MicroStation menu bar by selecting 
Applications > GEOPAK Road > GEOPAK Road Tools. 

 

Step 4. Access Project Manager using the Project Manager icon from the Road Tools tool frame.  

 

Step 5. From the right side of the Project Manager dialog box, in the Directories list box, ensure 
that the project directory is set to: 

  C:\data\geo\VDOT\road1  

  

You can navigate quickly to your current working directory by 
using the pulldown Directory > Current Working Directory. 

 

 Select the Projects > New pulldown and create a new project as defined in the table 
below: 

Project name: 17682 

Working Directory:  

Job Number: 101 

Project Description: GEOPAK Road 1 Course Project 
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 After filling out the dialog box as shown below, click Preferences. 

 

Step 6. Set the project preferences as shown in the dialog box below. Click OK when complete. 

 

Step 7. After exiting the Preferences dialog box, you will return to the Create New Project dialog 
box.  If everything here is satisfactory, click the OK button. An Alert message is displayed 
stating that Job 101 was not found in the Working Directory in which you defined.   

 

 Click Yes to automatically create this job file. 
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Step 8. The main Project Manager dialog box is now displayed and the project has been created 
and ready to be accessed.  To access the project, select the project by single clicking on 
name of the project in the dialog box.  The project is highlighted as shown in the dialog 
box with all pertinent information displayed.  

 

  Click OK to invoke the Project Users dialog box as shown in Step 8. 

Step 9. Create a new user by selecting Users > New from the Project User pull down menu bar. 
Complete the New User dialog box with the name and operator code as shown. 
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Step 10. After populating the dialog box click OK. When prompted to define a password for this 
user, click No. 

 

Step 11. At this point double click the user and the following dialog box opens. You now have the 
option of accessing the Road or Survey workflow.  Click Road. 

 

Step 12. You will now see the main Workflow dialog box. 

 

Step 13. Lastly, use the Remember option to have Project Manager remember our Project, User 
and Road and enable the Autosink option. 

Step 14. Exit Microstation. 

 

 

To create a project, contact the AES Help Desk. 
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Digital Terrain Model 

3.1   Introduction 
Objectives Learn how to display and analyze DTMs for use in roadway design. 

Project Manager Existing Ground 

Tools 

 

Menu Bar Application GEOPAK Road > DTM Tools 

 

A Digital Terrain Model (DTM) represents the topography of a project in the form of a triangulated 
network.  The DTM can be drawn in a 2D or 3D file, and then rotated to see the existing surface of the 
project area. 

Digital Terrain Models can be generated from various sources including MicroStation Elements, 
survey data, photogrammetry data, GEOPAK cross-sections, and geometry data. 

Triangulation is a mathematical process applied to ground points and vertices along longitudinal 
features to create planar surfaces.  The result of triangulation is the creation of triangles connecting 
these points. These triangles are included in the GEOPAK TIN file from which existing ground profiles 
and existing ground cross sections can be generated. 

3.2   Accessing 
Clicking the Existing Ground button from the Road Project: Road1.prj dialog box 
within Project Manager invokes the tool frame shown to the right.  All of the DTM 
tools can be accessed from the tool frame or from the DTM menu that can be 
accessed from the top/left icon on the tool frame. 
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3.3   Load DTM Features 

Tool 
 

 

Menu Bar Load > DTM Feature 

 

Load is the process by which we can visualize the DTM data, TIN model, lattice model, and contours.  
By selecting the Load DTM Feature icon, the following dialog box appears.   

 

The user can choose to load the DTM data (.dat), the TIN file (TIN), or the Lattice file (.lat).  Each of 
these files can be loaded for the model extents, within a fence, or selected view. 

Activating the Display Only toggle enables the user to view the elements without writing them to the 
MicroStation file (temporary display).  Conversely, deactivating the toggle writes the DTM features to 
the MicroStation design file at the defined symbology. These elements can be placed as a graphic 
group when Display Only is deactivated. 

 

 Activates the display of all Features. 

 Turns off the Display of all Features. 

 Turns on only the selected Feature. This can also be accomplished by activating the toggle 
(below the list box) or double-clicking on an item that is turned off within the list box. 
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 Will turn off only the selected item. This can also be accomplished by activating the toggle 
(below the list box) or double-clicking on an item that is turned on within the list box. 

3.4   Analysis Tools 
Tools 

 

Menu Bar Analysis > Height 
Analysis > Profile 
Analysis > Volumes 
Analysis > Elevation Differences 
Analysis > Slope Area 
Analysis > Themes 
Analysis > Drainage Tools 
Analysis > Visibility 
Analysis > Trace Slope Path 

 

The Analysis tools allow the user to visually analyze the digital terrain model utilizing numerous tools 
as a profile analysis, thematic analysis, drainage flow patterns, and visual portions on the model from 
any given location. 

 

Height To determine the height and other associated data dynamically based on user-defined 
data points within the model. 

Profile View a profile based on a user defined MicroStation element. 

Volumes To compute the volume between two TIN models, the volume between a TIN model and 
a plane, or the cut and fill totals between two TIN models while applying a 
shrinkage/swell factors. 

Elevation 
Differences 

Will display the elevation difference, or the amount of cut and fill between two TIN 
models, or a TIN model and a plane of constant elevation. 

Slope Area The Slope Area tool displays the horizontal area and actual slope area (area following 
the terrain of the Model). 

Themes Displays the digital terrain model based on different user definable themes such as 
elevation ranges, slope percentage, slope degree, or aspect. 

Drainage Displays and analyzes drainage patterns within a TIN model.  Tools include delineating 
watersheds, drawing flow arrows, determining upstream and downstream traces, finding 
high and low points, and ridge and sump lines. 

Visibility Based on a user-defined point of origin, GEOPAK visually displays which triangles can 
and cannot be seen, or what is visible between two points. 

Trace Slope Path Traces a path along a TIN file using a user specified slope and method. 
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 Lab 3:   Digital Terrain Modeling 

3.1   Accessing DTM Tool via Project Manager 
Step 1. Execute C:\data\geo\VDOT\road1\LAB3.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682dtm.dgn.   

 Access Project Manager.  It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

Step 3. Select the Existing Ground tool from the Project Manager Road dialog box. 

Step 4. Create a new run ground1.  

          

Step 5. After creating the run, select the run by highlighting the name of the run in the dialog list 
box and click OK. 
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This invokes the DTM Tool Frame.   

 

3.4   Load DTM Features 
 

  

 

Step 1. Select the Load DTM 
Features icon from the tool 
frame to invoke the 
following dialog box. 

Step 2. Change the Load File 
option to TIN. 

Step 3. Select the TIN file 
‘SURVEY.TIN’ by clicking 
the Files button. 

Step 4. Enable the toggles for 
Graphic Group but leave 
the Display Only disabled. 

 

Step 5. Select the Triangles Feature by highlighting in the list box. Notice that initially the display 
is set to OFF. You can control the display of an item three ways: 

  Use the “lightbulb” icons to the right of the dialog box 

  Double-click on an item 

  Use the “display” toggle in the lower right corner of the dialog box 

 Set the Triangles display to ON. At this point your dialog box should resemble the 
following: 
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Step 6. Set the display symbology for the Triangles as indicated below: 

 

Step 7. Select the Tin Hull (the boundary of the surface model) feature. Activate the Display of 
the feature and set the symbology as follows; Level = 30, Color = 0, Weight = 0, Style = 0. 

Step 8. Click Load and review the results.  When complete, toggle OFF the triangles and tin hull. 

Step 9. Select the Contours feature. Activate the Display Feature.   

 Verify that On is set in the Display field. 

Step 10. Complete the bottom of the dialog box as indicated below. To complete the Minimum and 
Maximum Z, Click the Read button, which will review the active TIN file and determine 
these values. 

 Enable the Display Only toggle since we only want to “preview” our contours but not 
actually write them to the design file. 
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Step 11. Activate the Display of the Contour Lines and Labels and set the symbology as indicated 
below: 

 Level Color Weight Style Font TH / TW Distance 

Major Lines 10 4 3 0    

Major Labels 10 5 3 0 0 TH=3, TW=3 200 

Minor Lines 9 1 1 0    

 

 

The contour symbology standards should be the same as Survey’s and are documented 
in CAICE_2000.doc. 

 

Step 12. Click the Load button to initiate the process. 

Step 13. Close the Load DTM Features dialog box and Save Settings. 

3.5   Analysis Tools 
We will review several analysis tools in the following exercises.  These include the height, themes and 
profiles tools. 

3.5.1   Height Tool 

 

 
 

Step 1. Select the Height icon from the tool frame to invoke the following dialog box. 
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Step 2. Activate the Show Contour and Show Flow Arrow 
toggles. The color may be altered to your choice of 
colors from the active color table on the Height dialog 
box. The weight of the contour line and arrow are 
controlled by the active Microstation settings. 

Step 3. Click the Dynamic button and scan the surface 
model with the cursor to display the values for xyz 
and the slope on the model at the cursor point. 

Step 4. The DP option can be utilized to review this 
information at a specific location and the Draw option 
will label the elevation at the selected data point. 

Step 5. Close the Height dialog box.  

 

3.5.2   Themes Tool 

 

 

 

Step 1. Select the Themes icon from the Analysis tool box to invoke the dialog box depicted 
below. 
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Step 2. Ensure that all graphic elements are Fit in 
View 1. 

Step 3. We will determine the Elevation Range first 
for the TIN File ‘SURVEY.TIN’. (This is the 
first icon on the dialog box). 

Step 4. Activate the Display Only toggle and the 
Fill toggle. 

 

 

Step 5. Next, click the Set Range button to access the following dialog box. 

 

 As shown on the right of the Minimum and Maximum Elevation Fields, the values for the 
active TIN elevations are listed.  By clicking these buttons individually, the elevation fields 
will automatically be populated. 

Step 6. Set the Range option to Auto Range Increment. 

Step 7. Set the Auto Range Options as shown below: 
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Step 8. Click the Set Range button to populate the list box on the bottom portion of the dialog 
box. 

 Selection of any list of elevations will populate the fields at the bottom.  

 

 Utilizing the buttons on the right side of the list box will permit additional ranges to be 
included in the list, modifications to be made to elevation ranges (or the color display of 
this range), or deleting a particular elevation range. 

 

Step 9. Close the Elevation Range dialog box (select the X in the upper right hand corner of the 
dialog box). 

Step 10. Click the Process button to initiate the display of the Elevation Ranges for the surface 
model. 

Step 11. Close the Themes dialog box and Save Settings. 

3.5.3   Profile Tool 

 

 

 

Step 1. Select the Profile icon from the Analysis tool box to invoke the following dialog box. 
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Step 2. Use the Selection tab to identify your surface model (TIN File) which you will generate a 
profile from, and the symbology for your profile. 

Step 3. Select the Tin File “SURVEY.TIN” by using the Files button. 

Step 4. Double-click on the 
symbology box (field 
to the right of the 
Files push button) to 
set the symbology 
representing the 
ground surface 
profile. You may 
choose any 
symbology you wish. 
Once the symbology 
has been set, click 
OK. 

Step 5. Click the Add icon 
(top icon next to the 
list box) to add the 
feature to the 
collection box.  

Step 6. Select the Profile Tab. 

Step 7. Click the Place Element button to cut your actual profile at any desired area by just 
placing two data points (i.e. a line) or a series of data points (i.e. a line-string) across your 
surface model at any location. 

 

Step 8. You can use the Preferences tab to set up a grid for your profile if desired. 

Step 9. Close the Profile dialog box and remove the DTM Tools tool frame. 
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3.6   Working Alignment 
Before leaving this exercise, let’s go ahead and begin to set the stage for further design via the 
Project Manager by defining the Working Alignment.  You will usually create a Working Alignment 
for each alignment on your project, but because of time constraints we’ll only do it for alignment 
MAINLINE on our sample project. 

To do this, we’ll need to use the Select and Define buttons on the Project Manager Workflow dialog 
box.  The Project Manager workflow dialog box should still be active (we ‘sank’ it earlier in the lab). 
Access the dialog box by selecting  Window > Road Project: 17682.prj from the MicroStation menu 
bar. 

Step 1. Click the Select button to create a new Working Alignment.  This will be very similar to 
creating a run as we did earlier in this exercise. The Working Alignment is the active chain 
that we are designing for. 

 

Step 2. Create a new Working Alignment called MAINLINE as shown below and click OK. 

 

Step 3. After creating the run, select the run by highlighting it in the dialog box and clicking OK. 



___________________________________________________________GEOPAK® 

GEOPAK 2001MR Lab 3:   Digital Terrain Modeling    3-13 

 

Step 4. You will now return to the main Workflow dialog box.  Click the Define button to access 
the Working Alignment Definition dialog box. 

Step 5. Select the DTM item in the list box and complete the DTM definitions as shown below: 

 

Step 6. Click OK to exit the Working Alignment Definition dialog box. 

Step 7. Exit MicroStation. 
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Coordinate Geometry 

4.1   Introduction 
Objectives Learn to set up and access the coordinate geometry database file. Become 

proficient in using GEOPAK Coordinate Geometry. 

Project Manager Coordinate Geometry 

Tool 

  

Menu Bar Application GEOPAK Road > Geometry > Coordinate Geometry 

 

The Coordinate Geometry database file (*.GPK file) is comprised of stored geometric elements such 
as points, lines, curves, spirals, chains, parcels and profiles.  When COGO calculations are 
completed, the results are stored in the binary database file, which is then utilized throughout the 
design process with many other applications. 

4.2   Accessing COGO 
When Coordinate Geometry is started, the Start-Up Dialog box appears. 

 

The fields in the Start-Up dialog box are detailed below. 

Project Name Name displayed on reports.  This is an optional entry, with a maximum of 60 
alphanumeric characters.  If Project Manager is active, this field is 
populated automatically. 

Job Number Identifies coordinate geometry database file and is a required field. The job 
number is a maximum of three alphanumeric characters.  If Project 
Manager is active, this field populated automatically. This field is required. 

Operator Code Unique 2-character code which enables multiple users access to database 
file.  The user’s initials are suggested.  Note this field is not required for 
single user access, but highly recommended.  If Project Manager is active, 
this field is populated automatically. 

Subject Description of coordinate geometry work (could relate to the project) with a 
maximum of 48 alphanumeric characters.   



GEOPAK®___________________________________________________________ 

4-2    VDOT Road I Training GEOPAK 2001MR 

This field is optional. 

After the dialog box is populated, and the OK button is clicked, the main coordinate geometry dialog 
box is invoked. 

4.3   Coordinate Geometry   

 

The coordinate geometry dialog box is made up of three separate display areas: 

? Tool Bar (1) consisting of drop down options and icons.  The display of specific icons is 
customizable. 

? COGO Key-in (2) this field enables manual entry of COGO commands.  The drop down 
button allows for a history of commands to be reviewed. 

? Output Display Window (3) shows the results generated by the commands. 
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4.3.1   File Commands 

 

The File commands (as displayed in the exploded view above) are detailed in the table below. 

Append This command is for input files only. A new input file is created by copying the contents of 
an existing input file to the end of the current input file.  The Save command must be used 
in order to store this new file. 

Catalog When selected, a menu appears listing all saved input files (under the current operator 
code) in the project directory.  This is for reference only no action is taken. 

Delete When selected, a menu appears listing all saved input files. Highlight a file, then click the 
OK button to remove this file from your project directory.  Although the file is deleted, the 
elements stored as a result of processing the commands are not deleted. 

Load When selected, a menu appears listing all saved input files. Highlight a file, then click the 
OK button. The input lines from the highlighted file are now displayed in the display 
window for viewing, editing, or processing. 

Output  Writes an ASCII file of the current display for reviewing and / or printing. (Fname999.ooc, 
where 999 is the current job number and oc is the operator code). 

Print  Sends your output/input file to the printer. 

Restore Loads an ASCII file of GEOPAK commands into the display window.  Note no processing 
occurs.  The file must be named j999ooc.inp, where 999 is the current job number and oc 
is the operator code. 

Save Saves the current audit trail to a file. (Fname999.ioc, where 999 is the current job number 
and oc is the operator code.). 

Export  Exports GEOPAK points, chains and profiles into formats for use in various data 
collectors.  

Import  Imports horizontal and vertical alignments and points from RDS and SDMS format into the 
GEOPAK .gpk file. 

Exit Closes the COGO dialog box and ends the coordinate geometry session. A prompt to save 
the session appears. Yes saves the audit trail, No exits without saving, Cancel returns to 
the COGO session. Whether you pick Yes or No everything you did is still saved in the 
.gpk file. 
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4.3.2   Edit Commands 

 

The Edit commands (as displayed in the exploded view above) are detailed in the table below. 

Clear Empties the memory of the current audit trail without saving and initializes the line 
numbers to begin a new sequence of commands.  Note this does not clear the display 
window. 

Delete Deletes input commands in the input buffer by line number (or range of line numbers) and 
re-sequences the line numbers for the remaining commands. 

Editor Opens the GEOPAK COGO Command Editor, which enables the user to edit the current 
input file. 

Insert  Adds a command line to the current input buffer before a specified line number; 
subsequent command lines shift down and line numbering is automatically re-sequenced. 

Modify  Changes a fragment in a command line. The modified command line is not processed until 
a Read command is performed. 

Read All Processes the specified lines in the audit trail. This may be done for the entire file (All) or 
by specifying a range of line numbers (Line Range). 

Type All Displays the content of the audit trail, (All) or a portion of the audit trail by specifying a 
range of line numbers (Line Range). 

Line Range Allows you to specify a beginning line number and ending line number. This range of lines 
can then be either “read” into COGO or just typed/listed in the display window. 
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4.3.3   Element Commands 
The mainstay of GEOPAK Coordinate Geometry are the various element commands.  Tools are 
supported for storing, stationing, adding additional data, deleting, etc.  GEOPAK supports a wide 
variety of elements:  points, curves, spirals, chains or alignments, parcels, and profiles.  Each element 
is detailed below. 

4.3.3.1   Element > Point 

 

One of the most utilized sets of COGO tools are the point commands, as detailed in the table below. 

Cell Assigns a cell name to a previously stored point. This point and associated cell can 
then be plotted later through D&C Manager. 

Copy Copies points or a point range to a new point number or range within the same 
GEOPAK database file 

Delete Deletes a point number (or range of numbers) from the database file. 

Elevation Assigns an elevation to a previously stored point 

Equate Stores a new point with the same values as a previously stored point 

List/Print  Input a range of point numbers.  List displays the point numbers (but no associated 
data) currently stored in the .gpk file within the specified range.  Print displays point 
number, x, y, z coordinates, station value and other stored information in the display 
output window for the requested points.  

Station Adds a station to a previously stored point. 
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Store Stores a point by key-in coordinates or by 
selecting a location graphically.  A station, 
elevation, point code, cell, feature, or 
description can be optionally stored with the 
point. 

  
Transformation Performs coordinate transformations based on user-defined control pairings 

Compare Points 
to TIN 

Utilizing a set of COGO points (with elevations) compares the COGO elevation to the 
TIN elevation and completes statistical analysis for "goodness of fit." 

Set Elevation 
from TIN 

Utilizing this command, GEOPAK adds or updates an elevation to a previously defined 
point, based on a TIN model. 

 

4.3.3.2   Element > Curve 

 

The Curve commands (as displayed above) are detailed in the table below. 

Copy Copies a specified curve to another curve name. 

Data Calculates the geometric parameters of a curve, displaying values for Delta, Degree, 
Tangent, Length and Radius. 

Delete Deletes selected curve from the database file. 

List/Print  List displays only the curve names currently stored in the .gpk file.  Print displays the curve 
data of the selected curve.  

Segment Defines new curves by dividing a stored curve into segments. 

Station By identifying a curve and a control point on the curve (PC, PI, or PT), a station value may 
be assigned. 
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Store Provides various options for defining and storing lines and curves such as Store Curve 
from Tangents as shown below.  

 

Transpose Reverses a previously stored curves direction. 

4.3.3.3   Element > Spiral 

 

The Spiral commands (as displayed in the exploded view above) are detailed in the table below. 

Copy Copies a specified spiral to another spiral name. 

Delete Deletes the selected spiral from the database file. 

List/Print  Displays all spiral data for the selected curve.  List displays only the spiral names currently 
stored in the .gpk file.  Print displays the spiral data of the selected spiral.  

Store Provides various options for defining and storing spirals. 
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4.3.3.4   Element > Chain 

 

The Chain (GEOPAK alignment) commands (as displayed in the exploded view above) are detailed in 
the table below. 

Area Calculates the area of a closed chain 

Delete Deletes selected chains from .gpk database file. 

Layout Offset Project points onto a chain or compute offset distance and direction between two chains at 
each control point or at user defined intervals of a specified station range. 

Describe / List / 
Print  

Displays chain information.  Print displays the name of each chain element.  Describe 
displays the alignment data of each element in the selected chain. 

Stationing Provides a method for stationing or re-stationing a chain. 

Station 
Equation  

Provides a method for applying a station equation to a chain. 

Store Provides three options for storing a chain in the database file, From Elements, From 
Offset Chain and Transition Chain.  (Chain name can be between 1-9 alphanumeric 
characters)  
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4.3.3.5   Element > Parcel 

 

The Parcel commands (as displayed in the exploded view above) are detailed in the table below. 

Delete Deletes selected parcels from the database file. 

Describe /  
List /  
Print  

Displays parcel information.  Describe displays the elements of composition, the area of 
tract stored, taken and remaining and a point, bearing, distance description of the specified 
tract.  Print displays the elements of composition, the area of tract stored, taken and 
remaining. 

Store Stores a parcel by adding points, curves and spirals. 

Subdivide Divides a parcel into individual lots. 

Editor Edits a parcel. 

 

4.3.3.6   Parcel Commands (Manual Entry) 
Several parcel commands are supported only by manual entry and have no associated dialog boxes. 

Store Taken Store the portion of a parcel taken by entering point and curve names in either a clockwise 
or counterclockwise direction. 

Store Easement  Store easements by entering point and curve names in either a clockwise or 
counterclockwise direction. 

Own Parcel  Stores the names of the owners associated with previously stored parcels.  

Make Legal  Creates a metes and bounds description and writes it to a user named text file. See also 
Legal Description Editor for the ability to create detailed and customizable legal 
descriptions. 
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4.3.3.7   Element > Profile 

 
The Profile commands (as displayed in the exploded view above) are detailed in the table below.  
Note additional commands are supported as keyin only commands.   

Delete Deletes selected profiles from the database file. 

Elevation Provides three options for reporting elevations along a selected profile, Station, Even Station, 
Incremental Stations. 

List/Print  Displays profile information. Print displays the data of the selected profile from the database file. 

Offset Stores a new profile within a specified Station Range at a defined vertical offset from the original 
profile. 

4.3.4   View Commands 

 
The View commands (as displayed in the exploded view above) are detailed in the table below. 

Icons Enables the user to customize which icons appear in the tool bar. 

Redefine Displays the Redefine box on the tool bar. 

Visualization Displays the visualization items on the tool bar. 

Format Displays the format items (i.e. number of decimals, station format, etc.) on the tool bar. 

COGO Key-in Displays the COGO Key-in box for entering commands in the dialog box. 

Command 
Output 

Displays the Command Output Window in the dialog box, and controls options for the 
Command Output Window.  The Command output window can also be saved to a text 
file in lieu of using the File > Output command. 

Error Alert Enables the user to activate a beep and/or restore a minimized COGO dialog box when 
an error occurs. 
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4.3.5   Tools Commands 
The Tools commands are detailed in the table below. 

Intersect  Stores a point at the intersection of any two COGO elements. 

 

Locate Stores a point or series of points not by specifying coordinates, but based on a 
previously stored point using several methods.  To locate a point by distance 
and bearing, use the Tools > Locate > Traverse as depicted in the dialog 
box below. 

 

Superelevation Calculates the superelevation transitions for a given chain and design speed 
by the Classic Methods delivered prior to GEOPAK 2000. 

Inverse Calculates the distance and direction between points.   

Navigator Invokes the COGO Navigator. See Section 4.4. 
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Best Fit  Calculates a best-fit chain through a set of points. 

Translation and Rotation  Moves, rotates, and scales a data set. 

Map Check  Edits a parcel. 

Roadway Intersections Calculates data for the intersection of two COGO elements, usually chains. 

Cul-de-sacs  Calculates data for a cul-de-sac. 

Redraw Visualized 
Elements  

Re-syncs the visualized COGO elements in the MicroStation file with the 
coordinate geometry data. 

Clear Visualized Elements 
(Temporary)  

Removes all temporary visualized elements from the view. 

Clear Visualized Elements 
(All)  

Clears all temporary and permanent visualized elements from the Microstation 
file. 

 

4.3.6   User Preferences 

 

The User Preferences (as displayed in the exploded view above) are detailed in the table below. 

Dialog Allows access to COGO Preferences dialog box. 

Redefinition of Elements Toggles the Redefine option on/off.  If Redefine is on, COGO data can be 
redefined/overwritten. 

Visualization Enables the elements to be displayed in the MicroStation file permanently, 
temporarily, or not at all. 

Coordinate Display Toggles between displaying NE or XY coordinates. 

Angle Display Toggles between displaying Bearing or Azimuth. 
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4.4   COGO Navigator 
Feature / Function View, edit and display COGO elements. 

Tools 

 

COGO Menu Bar Tools > Navigator 

 

The COGO Navigator is a tool utilized to easily view and edit COGO data. Store, delete, edit, print 
elements, plus visualization and selection set commands are easily accessible via the Navigator. The 
Navigator can be accessed by the pull down menu COGO > Tools > Navigator or by the Navigator 
icon.  The following dialog box opens. 

 

From the Navigator, points, curves, spirals, chains, survey chains, parcels, and profiles  (all COGO 
elements contained in the coordinate geometry database file; *.gpk) can be added, deleted, modified, 
identified, visualized, printed, or selected. 
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4.4.1   Navigator > Select Tools 
A variety of selection tools can be invoked via the Select pulldown, as depicted in the exploded view 
below. 

 

The Select tools are detailed in the table below. 

Select All Selects all data items of a certain type.  (i.e. all points) 

Invert Selection Selects all items not previously selected, and unselects all items previously 
selected. 

Clear Selection Unselects all items. 

Selection Set Allows the user to create a selection set that meets particular criteria.  Same 
as using the Selection Set icon 

Fit View (Selection Set) Fits the selected items to the active MicroStation window. 

Show Selected Elements 
Only 

Only the items in the selection set are displayed in the MicroStation window. 

Show All Elements All items in database file are displayed in the MicroStation window. 
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4.4.2   Navigator > Tools 

A variety of tools can be invoked via the Tools pulldown, as depicted in the exploded view below.  
Many can also be invoked via the shortcut icons displayed at the top of the Navigator. 

 

Add Element 

 

Enables the selected type of element to be stored.  When selected, the 
appropriate Store Element dialog box is invoked. 

Delete Element 

 

Deletes the highlighted element. 

Edit Element 

 

Invokes the appropriate Store Element dialog box, populated with the 
associated data of the selected element for editing. 

Identify Element 

 

When clicked and a COGO element is graphically selected, the element is 
highlighted in the display field.  If the selected element is not the displayed 
element type (i.e., curve or point), the element type is also changed.   

Print/Describe Element 

 

Displays the selected element’s data. 

Edit Element Feature Changes the feature code of the element. 

Visualize Element 

 

Displays the selected elements according to their feature code or default 
symbology. 

Unvisualize Element Removes display of  selected elements. 

Visualize All Displays all of the elements of a certain type, or all elements. 

Redraw Visualized 
Elements 

Re-syncs the coordinate geometry data with the data displayed in the 
MicroStation file. 

Clear Visualized 
Elements (Temporary) 

Clears only temporary visualized elements from the view. 

Clear Visualized 
Elements (All) 

Clears all visualized elements from the MicroStation file. 
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Settings Enables the user to define certain actions and behaviors of the Navigator. 
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LAB 4:   Coordinate Geometry 

4.1   Accessing COGO 
Step 1.  Execute C:\data\geo\VDOT\road1\LAB4.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn. 

 Access Project Manager.  It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

Step 3. Select the Coordinate Geometry icon from the Road Project: 17682.prj workflow dialog 
box. 

 The following COGO startup dialog box opens.  Notice that the Project, Job Number and 
Operator Code fields are populated automatically.  This information is taken from the 
project information that we defined when creating the project in Exercise one. 

 

Step 4. Click OK to access the coordinate geometry dialog box shown below. 

 

  This dialog box is completely re-sizable, so you can position it where you’re most 
comfortable. 
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4.2   Store Geometry 
Our course project has 4 alignments. We’ll store two of them using Coordinate Geometry. The first 
alignment will be called MAINLINE and is shown below: 

 

 

4.2.1   Store Points 
Step 1. Select the visualization option Permanent Visualization on the main COGO dialog box. 

Step 2. Access the Store Point dialog box by pressing the Store Point icon 

   

  or using the Element > Point > Store pulldown. 
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Step 3. To store point D500, manually enter the point number and coordinates as indicated in the 
dialog box below. Activate the Auto Increment toggle which will automatically increment 
the point number by 1 for subsequent Store Point commands. 

 

Step 4. Press the Apply button to store the point into the COGO database. 

Step 5. Continue storing points D501-D503 by utilizing the coordinates shown on the alignment 
diagram. When complete, exit the Store Point dialog box by pressing the “X” in the upper 
right hand corner. 

 

Note that the following point naming conventions should be followed: 

Design – All points should begin with D (e.g. D501, D502, etc.). 

Hydraulic – All points should begin with H (e.g. H501, H502, etc.) 

Survey – All points should begin with S (e.g. S501, S502, etc.) 

Traffic – All points should begin with T (e.g. T501, T502, etc.) 

Right of Way – All points should begin with R (e.g. R501, R502, etc.) 

Environmental – All points should begin with E (e.g. E501, E502, etc.) 

Utilities - All points should begin with U (e.g. U501, U502, etc.) 
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4.2.2   Store Curves 
Step 1. Access the Store Curve from Tangents dialog box by pressing the Store Curve from 

Tangents icon 

  

 or select Elements > Curve > Store > From Tangents from the COGO menu bar. 

Step 2. To store Curve ML-1, complete the dialog box as shown below and press Store. 

 

NOTE: Pressing the “picture” buttons allows you to select from multiple 
methods of defining the Back and Ahead Tangents 

 

 

Step 3. To store Curve ML-2, complete the dialog box as shown below and press Store. 

 

NOTE: Visualized points may be selected to complete any field that 
requires defined points or directions. 
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Step 4. Dismiss the Store Curve from Tangents dialog box by pressing the “X” in the upper right 
hand corner. 

4.2.3   Store Chain 
Step 1. Invoke the Store Chain dialog box by pressing the Store Chain icon 

  

 or select Element > Chain > Store > From Elements from the COGO menu bar. 

Step 2. Fill in the dialog box as shown below. 

 

 

NOTE: You can enter the elements manually or select the visualized 
elements graphically in order to fill in the dialog box. 

 

Step 3. Press Apply and dismiss the Store Chain dialog box. The chain MAINLINE should be 
visualized in the design file. 
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4.2.4   Describe Chain 
From the COGO dialog window, let’s preview the geometry of the chain we just stored. 

Step 1. Select the COGO Navigator icon 

  

 or use the Tools > Navigator option on the COGO 
menu bar to access the COGO Navigator dialog box. 

Step 2. Set the element option to Chain and highlight the 
chain MAINLINE. 

Step 3. Press the “printer” icon. 

 

 

Step 4. The chain geometry output will be displayed in the main COGO window. 
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Step 5. To save an input trail of your commands, select File > Save from the COGO menu bar. 
Fill out the dialog box as shown below and press OK. The saved file will be called 
‘ML101.ivd’. 

  

Step 6. To save an output file with the actual results of the computations, select File > Output 
from the COGO menu bar. The saved file will be called ‘ML101.ovd’. 

 

Step 7. From the Edit pulldown, select Edit > Clear to ‘clear’ out all the commands that we just 
previously typed in. 

 

This will not remove the stored data from COGO.  
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4.3   Working Alignment 
Now that we have our alignment, we have another piece of information for the Working Alignment 
definition.  

Step 1. Access the Project Manager Road workflow dialog box. 

Step 2. Click the Define button to access the Working Alignment Definition dialog box. 

Step 3.  Highlight the Plan View option and use the File and Select buttons to populate the 
Design File and Chain fields as shown: 

 

Step 4. Click OK. 
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4.4   Store Another Alignment 
Using the same general steps we learned in storing the previous alignment, use the diagram below to 
store another chain ‘EBL460’. The beginning station of the chain will be 107+00. 

 

 

Save an input trail of your commands. 

Exit COGO.  

Exit MicroStation. 
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Horizontal Alignment Tools 

5.1   Introduction 
Objectives Create and store horizontal chains using MicroStation elements. 

Project Manager Horizontal Alignment 

Tool 

 
 

Menu Bar Application GEOPAK Road > Geometry > Layout Alignments Horizontal 

 

The Horizontal Layout Tools enable the user to create or modify horizontal geometry (using numerous 
tools) including placing spirals, curves, tapers, specified bearings and curves, complex ramp loops 
and connectors, and all to user-defined parameters. 

When selected, a dialog box is invoked that gives the user a chance to utilize either GEOPAK 98 
(Graphic Element Based) or GEOPAK 2000 (COGO Element Based) design tools as depicted below. 

 

 

NOTE:  When set to COGO Element Based (New), an active session of COGO must be 
active. 

 

Once Horizontal Alignment Generator is selected, the dialog box below appears. 
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When User > Preferences is selected the User Preferences dialog box below appears and allows 
the user to set certain preferences. 

 

The Design Tables option allows the user to set up Design Tables for Symmetrical 3 Centered 
Curves, Asymmetrical 3 Centered Curves, Taper Curves, and Spiral Curves.  These files are stores in 
an ASCII format. 

 

The Tools option allows the user to open the Main dialog box or any of the dialog boxes needed do 
store a Horizontal Alignment. 

 

Values within the dialog boxes dynamically change simultaneously with dynamic graphic 
modifications. 

 

 

Spiral and compound curve commands do not support dynamic manipulation. 
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5.2   Lines / Curves Tools 

 

The Place Line / Curves Commands are detailed in the table below. 

 
Store Line By 2 Points 

The store line by two points command requires two new points and a new line.  The command 
draws the line and the new points. 

 
Store Tangent Line 

The Store Tangent Line tool stores a line and its two endpoints in the coordinate geometry 
database. 

 
Store Curve By 3 Points 

The Store Circular Curve by Three Points tool stores a circular curve (using chord definition). 

 
Store Curve By Center 

This tool enables the user to store a circular curve by defining the center point, radius, and 
sweep angle. 

 
Store Tangent Curve Unconstrained 

The Store an Unconstrained Tangent Curve tool places a curve through a specified point 
tangent to the specified curve or line. 

 
Place Curve Between Two Elements 

This tool enables the user to store a circular curve between two elements.  Options include 
offsets, truncate, and the ability to modify once the first curve is displayed. 

 
Place Simple Transition Element 

This tool enables the user to draw a transition element between two arcs.  Options for the 
Transition element include:  Tangent, Curve, or Spiral.  As the Transition option is changed, the 
dialog box dynamically changes to reflect the selection.   
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5.3   Curve Combinations Tools 

 

The Curve Combinations Commands are detailed in the table below. 

 
Place Compound Curves 

This tool enables the user to draw a compound curve between two elements. 

 
Place Three Centered Curves 

This tool enables the user to draw a three-centered curve between two elements.  The Design 
Vehicles group enables the user to select the desired vehicle, based on the data from files stored 
in the User Preferences. 

 
Place Reverse Curves 

This tool enables the user to store reverse curves between two elements.  An option is supported 
for an intermediate user-defined Tangent Length. 

 
Place Taper Curves 

This tool enables the user to draw taper curves between two elements.  The Design Vehicles 
group enables the user to select the desired vehicle, based on the data from files stored in the 
User Preferences. 

5.4   Spiral Combinations Tools 

 

The Curve Combinations Commands are detailed in the table below. 

 
Place SC Tangent To Line 

This tool enables the user to store a spiral / curve combination tangent to a line. 

 
Place ST Tangent To Curve 

This tool enables the user to store a spiral / tangent combination tangent to a curve.   

 
Place SC Tangent To Curve 

This tool enables the user to store a compound spiral / curve combination tangent to a curve. 

 
Place SCS (Intersecting Elements) 

This tool enables the user to store a spiral / curve combination tangent to a line.  The Design 
Table enables the user to select the desired Design Speed / Lanes and Degree based on the 
data from files stored in the User Preferences. 

 
Place STS (Disjoint Curves) 

This tool enables the user to store a spiral tangent spiral combination tangent between two 
elements. 

 
Place SCS (Disjoint Curves) 

This tool stores a spiral curve spiral combination between two curves.  Note the tool also works 
with overlapping curves.  The Design Table enables the user to select the desired Design Speed / 
Lanes and Degree or Radius based on the data from files stored in the User Preferences. 
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5.5   Complex Transitions Tools 

 

The Complex Transitions Commands are detailed in the table below. 

 
Place Complex Ramp 

This versatile tool enables the user to draw simple to complex ramp geometry. 

 
Place Ramp Connector 

This versatile tool enables the user to draw simple to complex ramp connectors, with a variety of 
options. 

5.6   Alignment Tools 

 

The Alignment Commands are detailed in the table below. 

 
Place Dynamic Alignment 

The first Alignment tool is placing a dynamic alignment. You initially select and accept a 
beginning element. By moving the cursor, the length of curve and dynamic ahead element 
change.  Continue placing data points to create curves and intermediate tangents.  At any time 
during the process, the Entry Radius may be changed.  Any subsequent curves are placed with 
the revised Radius. 

 
Store Chain 

The second Alignment tool is storing a chain comprised of graphical elements. This works 
similar to Automatic Create Complex Chain, while the chains are automatically being stored into 
the COGO database file. 

 

 



GEOPAK®___________________________________________________________ 

5-6    VDOT Road I Training GEOPAK 2001MR 

5.7   Manipulate Tools 

 

The Manipulate Commands are detailed in the table below. 

 
Move Plan View Element 

The Move a Plan View Element enables the user to move / translate an element or to make 
copies. 

 
Rotate Plan View Element 

The Rotate Plan View Element rotates the selected element about a user-defined point.  The 
Angle may be manually entered and locked, or dynamically changing. 

 
Extend Plan View Element 

The Extend Plan View Element tool can extend or shorten any element.   

 
Delete Element  

When using the Delete Element tool, no tool settings dialog box opens. 

Select and accept the element to be deleted.  The element is removed from the coordinate 
geometry database.  This tool works with a MicroStation selection set if present.  Warning:  
there is no undo for this command. 
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LAB 5:   Horizontal Alignment Tools 

5.1   Accessing Horizontal Alignment Tools 
Step 1. Execute C:\data\geo\VDOT\road1\LAB5.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn. 

 Access Project Manager.  It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

Step 3. Select the Horizontal Alignment icon from the Road Project: 17682.prj workflow dialog 
box. 

Step 4.  You will see the following dialog box: 

 

  Set the option to COGO Element Based (NEW) as shown and press OK. 

Step 5. You will see the following dialog box. Click YES. 

 

Step 6. You will see the following dialog box. Click YES. 
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Step 7. Activate COGO by pressing OK on the next dialog box. 

 

Step 8. Enable Permanent Visualization, then you can either move the COGO window out of the 
way or “sink” it using the Bentley icon.  

 

Step 9. You should now see the Horizontal Alignment Generator menu bar. 

 

5.2   Preferences 
Step 1. Use the File > Preferences pulldown to access the Preferences dialog box. Select the option for 

COGO Element Names and complete the dialog box as shown. 
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Step 2. Select the Curve Design Tables option. Using the Files button, select the appropriate file for 
each option. The files are located in the following directory: 

  C:\data\geo\vdot\road1\standards\geopak\ 

Symmetrical 3 Centered Curve 
Design Table 

HA_3CenteredCurve_Symmetrical_2001English.tbl 

Asymmetrical 3 Centered Curve 
Design Table 

HA_3CenteredCurve_Asymmetrical_2001English.tbl 

Tapered Curve Table HA_TaperCurve_2001English.tbl 

 

Step 3. Select the Spiral Design Tables option. Using the Files button, select the appropriate file. The 
file is located in the following directory: 

  C:\data\geo\vdot\road1\standards\geopak\ 

Spiral Design Table  HA_Spiral_Rural_VDOTEnglish.tbl 

 

  When complete, dismiss the dialog box by pressing the “X” in the upper corner. 

5.3   Store a Complex Ramp 
Step 1. Use the Tools > Complex Transitions pulldown to access the following menu bar: 

 

Step 2. Select the first of the two icons to access the Place Complex Ramp dialog box and fill out the 
dialog box as shown below: 
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Step 3.  Chains MAINLINE and EBL460 should be visualized in the design file from our previous 
exercise. Use your cursor to ID chain MAINLINE with a datapoint, then issue another 
datapoint to accept it. 

  Next, use your cursor again to ID chain EBL460 with a datapoint. 

  The ramp will now dynamically visualize.  

 

NOTE: As you move the cursor into any of the 4 quadrants of the intersection of 
the two alignments, the ramp will re-calculate and re-visualize in that quadrant.  

 

Step 4. Issue a datapoint in the westernmost quadrant to store the ramp as shown in the diagram  
below: 

 

Step 5. Dismiss the Complex Ramp dialog box and review the COGO output window. Notice that 
the 3 curves were automatically stored into the COGO database. 
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Step 6. Use the Tools > Alignment pulldown to access the following menu bar: 

 

Step 7. Select the second of the two icons to access the Store Chain dialog box. Fill out the 
dialog box as shown below: 

 

Step 8. With your cursor, issue an initial datapoint to ID the northernmost curve of the  ramp. 
Issue a second datapoint to accept it. 

Step 9. The entire chain will highlight and you’ll see some directional arrows. Issue another 
datapoint to accept the direction of the chain. 

Step 10. Dismiss the Store Chain dialog box. Review the output in COGO and notice the chain 
RAMPA has been stored into COGO. 
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Step 11. Save your input file. 

 

Step 12.  Exit COGO. 

Step 13. Exit MicroStation. 
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Graphical COGO 

6.1   Introduction 
Objectives Create and store COGO elements using Graphical Coordinate Geometry 

tools 

Project Manager Coordinate Geometry 

Tool 

 
 

Menu Bar Application GEOPAK Road > Geometry > Graphical Coordinate Geometry 

 

Graphical Coordinate Geometry is a tool that allows the user the ability to store coordinate geometry 
elements into the COGO database (GPK file) graphically.  Points, curves, lines, spirals, chains, and 
parcels can be stored, modified, or deleted.   The COGO elements can be manipulated by key-in or a 
click of the mouse and are stored directly into the COGO database. 

 

Note:  Graphical Coordinate Geometry does not read the exclusive MicroStation graphics. 

 

If the user attempts to access Graphical Coordinate Geometry without having an active COGO 
session invoked, the following dialog box will appear: 

 

After Coordinate Geometry is activated and Graphical COGO is selected, the main COGO dialog box 
will appear as below. 
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6.2   Store Elements 

The Store Elements tool box contains eleven icons. 

 

As elements are stored, the visualization parameters in the SMD file (as defined in the user 
parameters) are utilized.  This assumes that the temporary or permanent visualization is activated.  If 
no visualization is active, no elements are visualized. 

When a Store Element command is selected, a sub pallet will appear to allow the user to enter data if 
necessary as depicted below. 

 

The Store Elements commands are detailed in the table below. 

 
Store Point 

The Store Point tool enables the user to store points utilizing Cartesian coordinates (x, y, z 
or N, E, Z) or Curvilinear (station, offset, elevation). 

 
Store Equally Spaced Points 

The Store Equally Spaced Points stores a user-defined number of  points between two 
previously defined points or any two data points.  A line drawn between the two previously 
defined points is not necessary.   

 
Locate Point 

The Locate Point command stores a point based on the distance and direction from a 
previously defined visualized point. 

 
Store Line From Existing Points 

The Store Line from Existing Points utilizes two previously stored points to store a line.   

 
Store Line By 2 Points 

In contrast to the Store Line by Existing Points, the store line by two points command 
requires two new points, rather than existing points.  The command stores the line and the 
new points, utilizing the "next" available point and line names. 
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Store Tangent Line 

The Store Line Tangent To Element tool stores a line and its two endpoints in the 
coordinate geometry database. 

 
Store Curve By 3 Points 

The Store Circular Curve by Three Points tool stores a circular curve (using chord 
definition).  The stationing is set to 0+00 at the P.C.  The Radius can be manually typed in 
or defined dynamically. 

 
Store Curve By Center 

This tool enables the user to store a circular curve by defining the center point, radius, and 
sweep angle. 

 
Store Tangent Curve Constrained 

The Store a Constrained Tangent Curve tool places a curve tangent to the specified curve 
or line. 

 
Store Tangent Curve Unconstrained 

The Store an Unconstrained Tangent Curve tool places a curve through a specified point 
tangent to the specified curve or line. 

 
Store Tangent Spiral 

The Store Transition Spiral tool quickly places and visually modifies spirals based on an 
initial line or curve. 

6.3   Modify Elements 

 

When a Modify command is selected, a sub pallet will appear to allow the user to enter data if 
necessary as depicted below. 
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The Modify Elements commands are detailed in the table below. 

 
Partial Delete 

The Partial Delete tool enables the user to delete part of a COGO line or curve, creating 
two separate elements. 

 
Extend Plan View Element 

The Extend Plan View Element tool can extend or shorten any COGO element. 

 
Trim Elements 

The Trim Elements tool trims numerous elements to their intersection with another 
element. 

 
Intersect Elements 

The Compute Intersection of Two Element tool stores a new point by trimming or 
extending one element to its intersection with another element.  Note the two elements 
remain intact. 

 
Extend Element to Intersect 

The Lengthen or Shorten an Element tool works functionally the same as its MicroStation 
counterpart. 

 
Extend Elements to Intersect 

The Lengthen or Shorten Both Elements tool works functionally the same as its 
MicroStation counterpart. 

 
Construct Circular Fillet 

The Construct a Fillet Between Two Elements tool works functionally the same as its 
MicroStation counterpart and stores a circular curve between two elements. 

 
Construct Chamfer 

The Construct a Chamfer Between Two Elements tool works functionally the same as its 
MicroStation counterpart and stores a line between two elements.  Both the line and two 
new endpoints are stored in coordinate geometry. 

 
Cut Element 

The Cut Elements into Smaller Elements tool cuts elements into segments. 
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6.4   Manipulate Elements 

 

When a Manipulate command is selected, a sub pallet will appear to allow the user to enter data if 
necessary as depicted below. 

 

The Manipulate Elements commands are detailed in the table below. 

 
Move Plan View Element 

The Move a Plan View Element enables the user to move an element or to make copies. 

 
Rotate Plan View Element 

The Rotate Plan View Element rotates the selected element about a user-defined point.  
The Angle may be manually entered and locked, or dynamically changing. 

 
Copy Parallel 

The Copy Parallel tool works functionally the same as its MicroStation counterpart. 

 
Delete Element 

When using the Delete Element tool, no tool settings dialog box opens. 

Select and accept the element to be deleted.  The element is removed from the coordinate 
geometry database.  This tool works with a MicroStation selection set if present.  Warning:  
there is no undo for this command. 
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6.5   Groups 

 

When a Group command is selected, the Tool Settings opens to allow the user to enter data if 
necessary as depicted below. 

 

The Groups Commands are detailed in the table below. 

 
Store Chain 

The Store Chain command works in the same manner as the MicroStation Automatic Create 
Complex Chain with the additional benefit that the chain is automatically stored in the COGO 
database. 

 
Store Parcel 

The Store Parcel tool enables the user to store parcels, takings, easements, and other types 
of right of way features.  It is very similar to the Store Chain tool with many of the same 
options. 
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LAB 6:   Store a Chain with Graphical COGO 
Step 1. Execute C:\data\geo\VDOT\road1\LAB6.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn.   

 Access the Saved View (Utilities > Saved Views) named “REDBUD”. 

 Access Project Manager.  It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

In the following steps, we’re going to store a chain (REDBUD) that will look similar to the following: 

 

Step 3. Select the Coordinate Geometry icon from the Road Project: 17682.prj workflow dialog 
box. Press OK on the dialog box to access COGO. 

 

Step 4. Enable the Permanent Visualization option and then sink the COGO window. 

Step 5. Access Graphical COGO from the Road Tool Palette using the icon shown below 

 

or you can access it using the Applications > Road > Geometry > Graphical 
Coordinate Geometry pulldown. The tool frame depicted below will activate. 
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Step 6. Access the Store Point tool in Graphical COGO and fill out the dialog box as shown: 

 

 After filling out the dialog box, you’ll notice the point is visualized (represented by a circle) 
in the dgn file. Issue a DP anywhere in the dgn file to accept the location of the point. 

Step 7. Access the COGO Window and review the output. Notice that point D700 was stored into 
COGO. 

  

Step 8. Next, access the Locate Point dialog box and fill out as shown: 

 

 Note: The directional bearing is N 49 04 17.00 E. 
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 With your cursor, ID point D700 that was visualized in Step 5. Issue a second DP 
anywhere in the dgn file to validate the location of point D701. Point D700 and Line L1 will 
be visualized in the design file and stored into COGO. 

 NOTE: The correct location for our project is to the northeast of the chain Mainline. 

Step 9. Access the Store Tangent Curve Constrained dialog box and fill out as shown: 

 

 With your cursor, ID the line that was visualized in the previous step. 

 Issue a second DP to accept the line. 

 Issue a third DP to identify the direction of the curve. 

 Issue a fourth DP to validate the solution and store the curve. 

    

Step 10. Access the Locate Point dialog box once again and fill out as shown: 

 

    

 With your cursor, ID the visualized PT point of the curve. 

 Issue a second DP to validate the solution and store the point. 

Step 11. Access the Store Chain dialog box and fill out as shown: 
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 With your cursor, ID the visualized line running between points D700 and D701. 

 Issue a second DP to accept the line. 

 Issue a third DP to accept the direction of the chain and store it into COGO. 

Step 12. Describe chain REDBUD and review the output in COGO. 

Step 13. Clear all the visualized elements from the file using the Tools > Clear Visualized 
Elements (ALL) pulldown.  

 

Step 14. Save your input file. 

 

Step 15. Exit COGO. 

Step 16. Exit MicroStation. 



_____________________________________ CHAPTER 7 

Design and Computation Manager 
7.1   Introduction 
Objectives Understand the use of the D&C Manager to plot horizontal alignments into 

MicroStation.  
Understand the format of the hierarchical database and how to use it. 
Be able to use the D&C Manager in conjunction with other GEOPAK tools & 
MicroStation to draw and manipulate elements. 

Project Manager Plan View Design 

Road Tool Frame  

                     

Menu Bar Application GEOPAK Road > Design and Computation Manager 
GEOPAK Road > Plans Preparation > DP Station Offset 
GEPAK Road > Plans Preparation > Draw Transition 

GEOPAK 2001MR 

 

The Design and Computation Manager (D&C Manager) is a tool that allows the user to standardize 
graphics elements for drafting and pay item quantities. 

A hierarchical database is used with the Design and Computation Manager. This database stores 
information concerning functional classification and display preferences for each feature and item 
used in a MicroStation file. This file is commonly referred to as the ddb file (*.ddb). 

Categories are used to group and classify the features and items used in creating construction 
drawings.  In the example below, Location & Design and Right of Way are both categories.  
Categories are represented with a folder icon. 
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These categories each may contain sub-categories.  The sub-categories break down each 
classification into more specific items.  For example, Traffic may be broken into several additional 
categories such as Existing and Proposed. 

 
Within a category, the items that are included are designated according to the process that they will 
be used for (as a drafting item indicated by a paintbrush shown in the following diagram): 

 
Each entry represents a specific item.  The various icons representing the function they will be 
utilized for can identify items. 

 Paintbrush (draw design elements) 

 Calculator (quantities calculations) 

 Report icon (default, pavement design, pavement markings, etc.) 

 
See calculator icons in diagram below: 
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The database may also be password protected if desired. This can be used as a security measure to 
protect the integrity of the database file and ensure its consistent application within an organization. 

7.2   Accessing the Design and Computation Manager 
When the Design and Computation Manager is accessed, two dialog boxes are displayed. 

 

The main D&C Manager dialog box is composed of two distinct areas: 

• Across the top are icons for the various modes.  The D&C Manager may be configured to 
operate in seven different modes: Display, Design, Set, Compute, Shape, Pavement 
Marking and Preferences.  As various modes are selected, more icons are displayed within 
this area. 

• The Path box displays the name of the attached database file and your current position 
within the database structure.  It lists the categories, sub-categories and items available for 
selection.  This hierarchical data structure functions much like a directory. Double clicking 
enables the user to move up or down within the database. 

 
A second dialog box appears differently depending on the mode of operation.  This dialog box  
enables the user to set other options not available on the main dialog box. The dialog box below 
appears when you click on the Design Icon. 

 

7.2.1   File Commands 

 

For the GEOPAK designer, the only file command options needed are Open and 
Exit.  The other commands such as Save, Merge and Compress are used by 
personnel who maintain the database. 

As mentioned previously, the Password option may be used to password protect 
the database so a user would not be able to make changes to it. 
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7.2.2   Edit Commands 
As a designer, the most-used Edit commands will be Find, Identify and 
Review Item.  

Find – This tool will search the database (from your current location) 
for an item or category.  If the database is password protected, all other 
items will be disabled. 

Identify – This tool will allow you to select an element in the design file 
to identify which item it matches in the database. 

Review Item – This tool will allow you to review the settings/symbology 
for a particular item in the database. 

 

7.2.3   Settings 
Display Settings - temporarily changes the display of 
elements on the screen to one common color, then the 
user may specify additional elements to be viewed in their 
original colors.  This tool enhances visualization when 
working on a complex project. 

Design Settings - sets the maximum gap tolerance and 
deduction tolerance used in computations and the drawing 
scale for placing cells.  

Dialog – This option controls how the level up and level down icons function when clicked when 
using D&C Manager in toolbox mode. 

Criteria Viewer – This toggle is used when a criteria writer is troubleshooting new 3PC. 

Hierarchical Paths - This dialog box is utilized to define the path(s) for use in the Symbols option 
within the D&C Pavement Marking tool. 

Computation Units – This dialog box shows the computational units available for the current system 
- English or Metric. 

Computation Unknowns – This will display the file containing all user defined unknowns. 

Compute – This dialog box contains fields and options specific to the Compute process. 

7.2.4   Favorites 
Add to Favorites - saves current D&C Manager path for easy recall in the 
future. 

Organize Favorites – allows the organization of previously saved paths.  
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7.3   Operational Mode - Design 
The Design mode enables the user to draw each roadway element or COGO element (and 
associated attributes) in the design file based on drafting item parameters.  

First, the desired item is highlighted in the main dialog list box, i.e., alignment, edge of pavement, etc. 

 

The Place Influence option sets the level, symbology and attribute tags of elements drawn or copied 
using MicroStation commands.  When the Place Influence toggle is activated, elements are drawn 
using the level, symbology and attributes as defined in the GEOPAK database.  When Place 
Influence is off, elements are drawn using the active level, symbology and attributes of MicroStation. 

 

The Draw Cogo Element button is for drawing COGO elements to a design file.  A single click to this 
button prompts the user for a job number, then opens a dialog box that enables the user to choose a 
COGO item to draw. 

 

If an alignment, profile or parcel item is chosen, the Draw Cogo Element button changes to Draw 
Plan and Profile. 

 

From the secondary dialog box that is opened, click the Draw Plan & Profile button to initiate the 
drawing of COGO elements into the design file. Clicking this button prompts the user for a job number 
(the coordinate geometry database file wherein the COGO elements are stored), and then opens a 
dialog box that enables the user to choose a COGO item to draw. Do Not activate the Place 
Influence toggle when using Draw Plan & Profile. 

 

If utilizing the Design & Computation Manager within Project Manager, you are not 
prompted for a job number since this is associated with the active project. 
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Eight operations may be accessed from the Plan 
and Profile Draw dialog box: Points, Lines, 
Curves, Spirals, Chains, Stationing, Parcels, and 
Profiles.  Each of these operations dynamically 
changes the dialog box to reflect the selection 
with the various draw and label features used 
when placing a COGO element in a graphics file. 

 

 

The points and lines dialog boxes have a key-in 
field that allows the user to specify the names of 
the COGO elements to be drawn.  To use the line 
operation, the user must use point numbers to 
specify the ends of the line.  The points/lines are 
drawn immediately after you enter their respective 
names and press the enter key.  To draw more 
than one point or line, place a dash in-between 
the point numbers.  To draw a line without using 
consecutive point numbers, use a forward slash 
(i.e. 10/11). 
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The dialog box settings for curves, spirals, chains, 
stationing, parcels, and profiles have a list box 
that display the names of all curves, spirals and 
chains stored in the active coordinate geometry 
database file.  Highlighting one of the available 
elements initiates further commands to draw the 
element into the design file.  Each type of item 
has a list of parameters that can be optionally 
plotted. 

 

 

 

 

GEOPAK can draw elements to non-active levels.  After elements are drawn, it may be 
necessary to turn on appropriate levels and use the MicroStation fit command to view the 
elements. 

 

7.4   DP Station/Offset 
Feature / Function Utilize any station / offset in MicroStation commands requiring a data point. 

Tools 

  

Menu Bar Application GEOPAK Road > Plans Preparation > DP Station Offset 

 

The DP Station/Offset command works in 
conjunction with MicroStation commands and the 
D&C Manager.  It can be used as the data point for 
any MicroStation command.  DP Station/Offset 
provides precision placement of elements based on a 
station and offset of a stored chain.  Uses for this 
command include precision placement of elements 
and window functions.  
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7.5   Draw Transition 
Feature / Function Draw transition based on a two sets of station / offsets. 

Tools 

  

Menu Bar Application GEOPAK Road > Plans Preparation > Draw Transition 

 

The Draw Transition tool draws a line/curve based on a beginning station/offset and an ending 
station/offset relative to a selected chain.  Use of this command includes turn lanes, mailbox 
widening, curve widening and lane transitions.  

 

 

Elements placed with Draw Transition have MicroStation element type curve when the 
beginning and ending offsets are different and MicroStation element type line and/or arc 
when the beginning and ending offsets are the same. 
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LAB 7:   D&C Manager – Plans Production 
7.1   Accessing Design and Computation Manager 

Step 1.  Execute C:\data\geo\VDOT\road1\LAB7.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn 

Step 3. Access Project Manager.  It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

Step 4. Select the icon Plan View Design button from the Road 
Project: 17682.prj workflow dialog box, which opens the Plan 
View Design tool box.  

7.2   Drawing Alignments 
Step 1. Select the Design and Computation Manager icon (as indicated above) to invoke the 

Design and Computation Manager shown below. A secondary dialog box will appear to 
be used in conjunction with the Design and Computation Manager dialog box. 

 

Step 2. Select the item shown in the dialog box below.  
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Step 3. Next, select the Draw Plan and Profile 
button from the secondary dialog box: 

 
Step 4. Select the Chains operation.  Each of 

the chains will be displayed in the list 
box as shown.  Notice that the options 
that are to be drawn with the chain are 
already activated. Set the Label Scale 
to 25. 

Step 5. To draw the chains, click each name in 
the list box. Only click once!! Each time 
you ID a chain it will be plotted into the 
design file. 

 

 

 

Step 6. Change the Operation to Stationing 
and modify the dialog settings as shown 
in the image to the right.  

 Annotate each alignment by clicking the 
chain names in the list box. 

Step 7. Review the results of Steps five and six. 

Step 8. Notice that we are forcing all the labels 
and tic marks to the left. This looks a 
little odd for RAMPA, so let’s change 
that. 

 Make sure that Graphic Group lock is 
ON, then delete the tic marks and 
stationing for RAMPA. 

 

 
Step 9. Change the options as shown to the 

right and re-station RAMPA. 

Step 10. Exit the Plan and Profile Draw dialog 
box but remain in D&C Manager. 
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7.3   Drawing Other Plan View Features 
We are going to develop roadway features representing the proposed roadway.  The roadway is 
made up of 4 distinct sections: 

• 4 lane divided highway with depressed median from Sta. 200+00 to Sta. 202+00. Left side of 
the roadway will be resurfacing while the right side is new construction. 

• 4 lane divided highway with raised median from Sta. 202+00 to Sta. 204+25. Left side of the 
roadway will be resurfacing while the right side is new construction. 

• 4 lane undivided highway from Sta. 204+25 to Sta. 211+00. 
• 2 Lane highway with Entrances and Exit Ramps from Sta. 211+00 to Sta. 220+00. 
 

To perform these tasks, two specific GEOPAK tools will be utilized: D&C Manager to determine 
element symbology and Draw Transition to place the elements between specific pairs of stations 
and offsets. Because of time constraints, we will not develop the planametrics for the entire project, 
but just for a select area. 

Step 1. Navigate to the item Location & Design > Pavement > 900344 Edge of Pavement.   

Step 2. Select the item  900344 Edge of Pavement  and then enable Place Influence. 

Step 3. If desired, click on the Switch to Toolbox Mode (left most icon) icon on D&C Manager. 

 

Step 4. Open the Draw Transition tool from the Plan View Design palette.  Fill in the values as 
shown below then click Apply.  This will draw the right edge of pavement between the 
given station range. 

 

Step 5. Next, modify the dialog box as shown to draw the edge of pavement transitioning from 
204+00 to 205+00. 
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Step 6. Draw the additional features shown in the following table.  Check that the correct feature 
is selected in D&C Manager before continuing.  When completed, disable Place 
Influence, then close D&C Manager and Draw Transition. 

 Note: All items shown in the table fall under the category Location & Design. 

Feature Beg. Station Beg. Offset End Station End Offset 

Curbing > 012600 Standard. Comb. 
Curb & Gutter CG-6 205+00 26.0 211+00 26.0 

Walks > 013220 Hydraulic Cement 
Conc. Sidewalk 4 205+00 28.5 211+00 28.5 

Walks > 013220 Hydraulic Cement 
Conc. Sidewalk 4 205+00 33.5 211+00 33.5 

Pavement > 900344 Edge of 
Pavement 211+00 24.0 212+00 12.0 

Pavement > 900344 Edge of 
Pavement 212+00 12.0 216+00 12.0 

Pavement > 900344 Edge of 
Pavement 216+00 12.0 217+00 24.0 

Pavement > 900344 Edge of 
Pavement 217+00 24.0 218+08.66 24.0 

Pavement > 900346 Paved 
Shoulder 211+00 34.0 212+00 22.0 

Pavement > 900346 Paved 
Shoulder 212+00 22.0 216+00 22.0 

Pavement > 900346 Paved 
Shoulder 216+00 22.0 217+00 34.0 

Pavement > 900346 Paved 
Shoulder 217+00 34.0 218+08.66 34.0 

 

Step 7. Exit MicroStation. 
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Existing Ground Profiles 
8.1   Introduction 
Objectives Learn to draw and store existing ground profiles extracted from a surface 

model. 

Project Manager NOTE: This application is not available through Project Manager 

Tools 

 
 

Menu Bar Application GEOPAK Road > Plan Preparation > Draw Profile 

GEOPAK 2001MR 

 

The Draw Profile tool enables the user to draw several profiles from a variety of sources 
simultaneously. 

• GEOPAK coordinate geometry database wherein the vertical alignment is stored.   
• GEOPAK binary TIN file, Site Model or Site Object.  The Site Model or Object are created 

utilizing GEOPAK Site Modeler software and are stored within the GEOPAK Site project (gsf) 
file. 

 

In addition, if the source data is TIN files or site components, the resultant profile may optionally be 
stored within the coordinate geometry database. 
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8.2   Invoking the Draw Profile Tool 
The generation of profiles must be invoked from within the 2D MicroStation design file wherein the 
profile is to be drawn.  When the tool is selected, the dialog box depicted below opens.   

 

The initial entries that are required are the Job Number and Chain name.  Once selected, click the 
Dialog Profile Cell Control icon(to the right of the Job Number field).  This will invoke the Profile 
Cell Control window shown below.   

 

Select the Active Chain that the new or existing profile is to be stationed along.  If no profile cell 
exists, click the Place Profile Cell icon along the right side of the window to place a new cell.  If 
multiple profile cells exist, highlight the desired cell and click the Activate Profile Cell icon. 

8.2.1   Update Options 
Four update options exist that allow the user the control needed to tell the software what to do if a 
profile has been previously drawn in the file and needs updated.  The options are toggled off / on by 
each selection of the option by clicking the Update Options pulldown.  The check to the left of the 
option indicates the option is active.  Only one option may be active at any given time, therefore, if an 
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option is selected, the previous active option is de-activated.  The four options are detailed in the 
table below. 

Delete Existing Elements and 
Redraw 

When this option is activated, any profiles previously drawn with 
this tool are deleted and new ground lines are drawn. 

Delete Non-Modified Elements 
and Redraw 

When this option is activated, any profiles previously drawn with 
this tool and not modified with any MicroStation commands are 
deleted and new ground lines are drawn. 

Draw on Top of Existing When this option is activated, any previously drawn profiles are 
ignored and a new set is drawn, resulting in multiple copies of 
each profile. 

Query When activated, the user is prompted each time the Draw button 
is pressed. 

 

8.2.2   Surfaces Tab 
The Surfaces tab defines the surfaces utilized as source data when drawing profiles.  Multiple 
surfaces from a variety of sources can be drawn in a single processing.  When the tab is selected, 
the dialog box dynamically changes as depicted below. 

 

Each surface to be drawn must be added to the list box.  This is accomplished via the action / edit 
buttons on the right side of the dialog box.  Each surface draws a cross section line string or lines.  
When a line is added to the list box, the profile is drawn.  Note:  clicking on the draw toggle in the list 
box deletes or redraws the profile. 
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To add to the list box, simply select the source data and method, Display Settings, Tolerances and 
Offsets, and then add the profile to the list.  Once a profile is drawn, it may be updated at any time by 
using the Update Profile icon.  Refer to the Update Options section to review those options.  Any 
profile may optionally be stored to the GPK file if desired. 

8.2.3   Display Settings 
The Display Settings group box specifies the element symbology of the cross section elements being 
generated.  The symbology may be specified using Level Symbology or a feature selected from a 
D&C Manager database. 

To use By Level Symbology, set the option to By Level Symbology, then double click on the 
graphic.  This opens the Set Feature dialog box, wherein the symbology can be specified.  Click OK 
when completed. 

To use By Feature, set the option to By Feature.  Next, press the Paintbrush icon, which invokes the 
current Design and Computation Manager.  Select the desired item, and then press the OK button, 
which closes the Design and Computation Manager, and populates the Draw Profile Display Settings 
group box. 

8.2.4   Filter Tolerances 
Both Horizontal and Variance filter tolerances are considered together for each pair of profile 
segments.  The middle point is deleted if both segment lengths are less than the Horizontal filter 
tolerance while the projected distance between the mid-point and the chord between the two end 
points is less than the Variance tolerance. 

 

8.2.5   Offsets 
Vertical or Horizontal Offsets may be specified in terms of master units (i.e., feet or meters).  The 
Horizontal Offset is the distance offset from the Chain.  Once the horizontal location for the profile is 
determined, the data source is utilized to determine the profile.  Any Vertical Offset is applied after 
the profile is generated from the source data. 
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8.2.6   Store Profile to COGO 

 
When the profile is drawn, it may also be stored in COGO by 
pressing this button, which opens the dialog box depicted 
below left. 

 

The profile may be stored, or just the input file may be 
created.  If an input file is created, the Operator Code and 
File Name are required.  If the dialog box is invoked while in 
a 3D file, the user may toggle on the option to create a 3D 
profile string. The 3D profile string consists of the circles 
denoting every location where the design centerline 
intersects topographic elements.  If the circles are not 
deleted at this time, they can be deleted at any time with a 
single application of the MicroStation "Delete Element" 
command. 

 

8.2.7   Cogo Tab 
The Cogo Tab is utilized for drawing any profile that has been previously stored into the GPK file. 

 

To draw a profile, first select the Profile Name to be drawn.  The Vertical Offset defaults to a value 
of 0, but can be set to any value.  This instructs the software to draw the profile at a distance above 
or below the elevations in the GPK file.  Station Limits may also be specified to have the software 
draw only a portion of the profile.  If the Display Settings are set to By Feature and a feature is 
selected, the Options area of the dialog box is un-ghosted.  This is where various labeling options for 
the profile can be specified.  If a value is given for the Strip Grade Increment, elevations will be 
placed at that increment along the bottom of the profile. 
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8.3   Profile Report 
To review a textual report listing stations and elevations of a ground profile, open the GEOPAK 
Coordinate Geometry dialog box.  A couple of different methods can be used to create this listing for 
any profile.   

By selecting Element > Profile > List/Print then 
highlighting a specific profile name and clicking Print.  
The results of this command will be displayed in the 
Command Output window of the Coordinate 
Geometry dialog box.  To obtain a hardcopy of this 
information, create an output file using the File > 
Output command and supply a filename of 1-5 
characters.  Then use the File > Print > Output File 
command to print this to the default system printer. 

 

The second method utilizes the COGO Navigator tool 
to create the Print Profile command.  The 
advantage to this method is that multiple profiles can 
be identified at once and printed to the Command 
Output window.  Start the COGO Navigator by 
clicking Tools > Navigator or selecting the icon from 
the COGO dialog box.  Change the Element to 
Profile then highlight the desired profile(s).  Once 
selected, click the printer icon on the Navigator to 
process the profile(s). 

 

8.4   Drawing Profiles with D&C Manager 
As with other COGO elements, 
Design and Computation Manager 
will be utilized to draw any type of 
profile into a MicroStation file:  
existing roadway, proposed 
roadway, utility, special ditch, etc.  
To get started, open D&C Manager 
then navigate to the desired item for 
plotting of the profile.  Upon 
selecting an item, click on the Draw 
Plan & Profile button on the 
supplemental D&C dialog box. 
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The next dialog box that appears is the GEOPAK Draw Plan & Profile window, as depicted below. 

 

If it is not already selected, change the Operation to Profiles.  Displayed in the window is a list of 
profiles currently stored in the GPK file.  Along the right side of the window are labeling options for the 
profile that is to be plotted.  Configure these as desired before selecting a profile to plot.   

• VPI Labels – Labels the station and elevation of the VPI – typically turned off for plotting of 
existing profiles. 

• Horizontal Axis – Places stations along the bottom of the profile. 
• Vertical Axis – Places elevations along the left side of the profile. 
• VC Parameters – Labels the length of the vertical curve if applicable. 
• VPC/VPT Labels – Annotates the station and elevation of a vertical curves control points. 
• Stopping Sight Distance – Places text for crest vertical curves representing the curves 

stopping sight distance as defined by AASHTO. 
 

After selecting a profile to plot, the dialog box below opens.  Since a profile does not have XY 
coordinates, the user must specify a location in the MicroStation file to place the profile and a scale at 
which to plot the profile.  When using a ratio other than 1:1, the horizontal dimensions of the profile 
remain true and the vertical is exaggerated. 
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The location can be selected by clicking on the 
DP button then specifying a location in the file by 
issuing a data point in the view.  The coordinates 
can also be keyed in to the dialog box.  A Profile 
Cell can be drawn into the file to represent the 
location of the data point and associated 
information.  This cell can be used in any other 
GEOPAK tool that needs to know the location of 
the profile.  A PGL Chain must be selected before 
drawing the profile cell.  This chain will be the 
chain that the profile is stationed along.   

If a value is specified for the Strip Grade 
Increment, elevations will be calculated at the 
desired interval along the profile and placed just 
above the Horizontal Axis Labels (stations). 

Click OK to draw the profile. 

 

8.5   Projecting Profiles with D&C Manager 
In this option, the selected profile is projected 
back onto the reference chain, whose stationing is 
utilized for drawing.  Of the standard Profile 
options, only the VPI Labels and Label Scale 
option are supported.  The Extract Elev from TIN 
File toggle allows a survey chain to be draped 
over a TIN and the elevation extracted from the 
TIN.  The name of the TIN File may be manually 
entered or selected via the Files icon.  If the 
toggle is NOT active, then the elevations for the 
profile are determined from the Survey Chain 
plus.  The Depth of Cover keyin field allows a 
value to be entered that will raise or lower the 
elevations of the generated profile.  The Depth of 
Cover is useful for drawing the profiles at an 
average depth of cover elevation while the actual 
profiles were field located on top of the existing 
ground. 

Note:  The list box changes slightly when the 
Project Profile option is activated, as survey 
chains are displayed in addition to profiles.  
Profiles are listed first (above the dashed line), 
then survey chains are below the dashed line as 
shown on the right. 
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LAB 8:   Existing Ground Profiles 
In this exercise, existing ground profiles will be drawn representing the centerline of chain MAINLINE. 

8.1   Draw Existing Ground Centerline Profile 
Step 1. Execute C:\data\geo\VDOT\road1\LAB8.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682prof.dgn 

 Access Project Manager.  It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

Step 3. The file d17682des.dgn should be attached as a reference. 

Step 4. Select the Draw Profile tool from the Road Tools palette.   

 

 The dialog box below will open. 
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Step 5. Select chain MAINLINE. 

Step 6. Click the Dialog Profile Cell Control icon (to the right of Job Number).   

 

 Set the Active Chain to MAINLINE. 

 

Step 7. Click the Place Profile Cell icon on the right side of the dialog box.  This will open the 
Place Profile Cell dialog box. 

 

Step 8. Fill the dialog box out as shown above and then DP somewhere to the right of the plan 
view reference file in order to place the profile cell into the design file.   

 Fit the view contents.   

 Close the Profile Cell Control dialog box. 

Step 9. From the Surfaces tab, select the folder icon in the Details area, then select the 
SURVEY.TIN file for the TIN File to cut the profile.  Set the Method to Triangles.  This 
instructs the software to compute elevations at each location that the chain intersects a 
triangle leg from the TIN. 
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Step 10. Use By Feature mode in the Display Settings area of the dialog box.  Click the 
Paintbrush icon and select the item shown below. 

 

 

 Press OK. 

Step 11. Click the Add Surface Settings icon to add the profile to the list box as well as draw the 
profile into the Microstation file. 

 

8.2   Store Profiles into COGO Database 
Step 1. Click the Store Surface in COGO icon.   
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 This will invoke the Store Profile dialog box. 

 

Step 2. Fill out the dialog box as shown above and click Apply.  Close the Store Profile dialog 
box. 

Step 3. Click the Remove Surface icon.  This will erase the profile from the DGN file.  We will re-
draw the profile shortly. 

 

8.3   Review Profiles in COGO 
Step 1. Access the coordinate geometry tool.  (Press the Coordinate Geometry button on the 

workflow dialog box). Press OK to accept your project name, etc. This will open the 
Coordinate Geometry dialog box. 

Step 2. Select Element > Profile > List/Print from the COGO menu bar to invoke the List/Print 
dialog box. 

 

Step 3. Select the profile ‘MLGROUND’ and press Print. 

Step 4. Review the profile information in the COGO output display window. 

Step 5. Close the Coordinate Geometry dialog box (use X in upper right corner of the dialog box).  
When prompted to save the COGO session select NO. 
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8.4   Drawing & Labeling the Existing Centerline Profile 
Next, we are drawing and labeling the existing profile utilizing the Draw Profile tool’s COGO tab. 

Step 1. Click the COGO tab and set the Label Scale to 25 in the upper right hand corner. 

Step 2. Select Profile Name MLGROUND from the drop down list in the Details area. 

Step 3. Under the Display Settings set the option to By Feature.  Select the feature shown 
below and click OK. 

 

Step 4. Click General in the Options area and set the Strip Grade Increment to 50.  This will 
label the elevations every 50’ along the bottom of the profile area. 

 

Step 5. Click the Add Cogo Profile Settings icon to draw the profile.  This will draw the existing 
ground profile with the proper symbology in addition to labeling the stations and 
elevations along the bottom of the profile and the elevations along the left side of the 
profile. 

Step 6. Dismiss the Draw Profiles dialog box. 
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8.4   Project Manager - Define 
We are completing the Profile View and Location sections of the Working Alignment Definition in 
Project Manager. 

Step 1. From the Workflow dialog box of Project Manager, press the Define button. 

Step 2. Highlight the Profile View option and populate the dialog box as depicted below. 

 

 

 

We have not designed the proposed profile; therefore, we will return to populate this field in 
a later exercise. 

 

Step 3. Highlight the Location option.  To quickly populate this category within working 
alignment, click Identify Cell, then data point on the cell for the centerline profile in the 
file and accept. 

Note:  Your coordinates may be different than those shown below.  That is not a problem. 

 

Step 4. Press the OK button to save the updates and close the dialog box. 

Step 5. Exit MicroStation. 
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Vertical Alignment Generators 
9.1   Introduction 
Objectives To create and store vertical alignments using the Vertical Alignment 

Generator. 

Project Manager Vertical Alignment 

Tools 

       

Menu Bar Application GEOPAK Road > Geometry > Layout Profiles (VPI Based) 

GEOPAK Road > Geometry > Layout Profiles (Component Based) 

GEOPAK 2001MR 

 

GEOPAK has a variety of tools for generating and storing a proposed profile.  Those tools include: 

The Vertical Alignment Generator (VPI Based) is a GEOPAK tool that can 
graphically create and modify proposed design profiles or modify an existing ground 
profile.  The designer can generate a profile based on VPI data, design speeds, 
stopping sight distances, and K values.  These operations may be accomplished 
through a dialog box and/or by dynamic manipulation of graphic elements. 

• 

• 

• 

The Component Based Vertical Alignment tools provide the user with a myriad of 
tools to place, modify and delete profile components.  Tool boxes organize tools to 
include the placement of tangent lines, a variety of vertical curves.  Components 
interact with each other to automatically trim vertical curves, connect various 
elements, and modify, copy and rotate components.  The user also has the option to 
store completed profiles in the coordinate geometry database. 

A profile may also be created with Coordinate Geometry (COGO) input (key in 
commands).  In addition, there are VC commands that compute and display vertical 
geometry and the parameters associated to aid in the development and generation of 
vertical alignments used in conjunction with Store Profile commands.  VC commands 
define parabolas for various combinations of stations, elevations, grades, slopes and 
the rate of vertical curvature (K value), and also define the tangents between two 
parabolas or between a parabola and a point. 

This chapter focuses on the two graphical based tools - Vertical Alignment Generator and 
Component Based Vertical Alignment. 

Vertical Alignment Generators    9-1 



GEOPAK® __________________________________________________________  

9.2   Vertical Alignment Generator 

9.2.1   Accessing 
When selecting the Vertical Alignment generator, the first dialog 
box that appears is labeled Settings, as depicted here.  The 
entries in this box set the parameters and define the location 
within the design file where the profile components are to be 
displayed.  All fields must be completed before the design 
process can begin.  Once the OK button is pushed, the Vertical 
Profile Generator dialog box appears. 

Note: This tool also utilizes the cell that was drawn in the 
previous exercise by using the Identify Cell button.. 

 

9.2.2   Using the Vertical Alignment Generator 
This tool enables a user to load a previously stored profile or create a new profile.  You will notice the 
dynamic changes in the dialog box throughout the vertical alignment design. 
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Various design parameters must be defined prior to designing a new profile; which are discussed in 
the options supported under the three menu options; File, Tools, and User. 

9.2.3.1   File 
 

 

Clear - clears the profile display from MicroStation graphics and removes all VPI’s 
from the dialog box. 

Draw - write the graphic elements of the profile to the MicroStation file. 

Load - retrieves a previously stored profile from the coordinate geometry database 
(.gpk) 

Save - stores a new profile or updates (redefines) a previously stored profile under the 
same name. 

Save As - is used to store the profile or to save a modified profile under a different 
name. 

Exit - ends the process. 

9.2.3.2   Tools 
 

 

Critical Points - Vertical curves may also be defined by one or two critical points – i.e. 
the curve will pass through these points  If mathematically solvable, the vertical curve 
will be drawn and the design speed display adjusted to fit the current parameters. 

Issue Data Point - Permits the user to type in stations and elevations, issue a data 
point that can be part of a MicroStation place line, place a cell or perform other generic 
operations.  This is useful in displaying visual references within the profile that need to 
be considered in design of the vertical profile. 

9.2.3.3   User 
 

 

Preferences - sets the rounding parameters for each of the items listed in the dialog box.  
Also contains a toggle that will force the dialog box to window center the view on the current 
VPI.   

K Values - is a table of stopping sight distance K-values for crest and sag conditions for 
various design speeds.  These values are based on the AASHTO Green Book. 
Settings - recalls the Settings dialog box that first appeared upon initializing Vertical 
Layout. 
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9.2.4   Creating A New Profile 

 

The enter/tab key must be used to ensure values are accepted. 

 

A new profile can be created with the following steps: 

Step 1. Place the first VPI using one of the four supported options. 

Type station and elevation of the VPI into the appropriate fields in the Profile 
Generator dialog box. 

• 

• 

• 

• 

Enter station of VPI as precision input (type in value), and allow the elevation to be 
defined through dynamic cursor placement on screen. 

Elevation is defined via precision input, and the station is defined through dynamic 
cursor placement on screen. 

Both values for the VPI can be established dynamically on screen by clicking on the 
Dynamic button and placing a DP in the view at the desired station and elevation. 

 
Step 2. Define ahead (or back tangent) 

 Station, elevation, grade and length parameters may be defined via precision input, 
dynamic manipulation or a combination of both. 

Step 3. Define remaining VPI’s and Grades 

 A repetition of Step 2 with an option to insert VPI’s between two existing VPI’ s. 

Step 4. Define Vertical Curves 

 Simply define the design speed from the Speed option button and GEOPAK will 
reference the K-value table and draw the vertical curve.  If a curve overlap occurs, an 
overlap message will be displayed in the dialog box along with the overlap length.  
Length of Curve or K-value may also be keyed in. 

Step 5. Adjusting Curve Lengths 

 The vertical curve can be modified by directly keying in either the K-value, curve length or 
defining the design speed in the dialog box.  You will see the values computed 
automatically adjust to reflect the results of any modifications. 

Step 6. Save the Profile 

 Click File > Save As to name and save the newly created profile.  The names of profiles 
are any 1-9 alphanumeric characters. 
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9.2.5   Precision Placement Options 
 

 

Options available for creating or modifying vertical curves, VPI’s and grade lines:  
• OFF - Values change. 
• INC (Increment) - Ensures that the designated profile parameter will be adjusted as 

defined in the Preferences dialog box. 
• LCK (Locked) - Forces selected operations to maintain the designated profile 

parameters. 

9.3   Component Based Vertical Alignment 
This tool requires COGO and the active chain control to be active.  If a COGO session in not open, 
an Alert message is displayed.   

9.3.1   Accessing 
When the tool is selected, the tool frame illustrated below opens.   

 

The 2x2 tool frame is similar to the MicroStation main tool frame.  It is not resizable, but dockable.  
Each icon in the tool frame is a tool box that one can "tear off" to become a "tool box." The individual 
tool boxes can be docked and resized.  There are four tool boxes, with the following titles: 

• Place Vertical Alignment Lines 
• Place Vertical Alignment Curves 
• Profile Tools 
• Manipulate Vertical Alignment Elements 

9.3.2   Place Vertical Alignment Lines 

 

The Place Vertical Alignment Lines tools are detailed in the table below. 

 
Create a Profile Line by Two Points 

This tool enables the user to place a profile line by defining two points.  Optionally the 
slope or length of the line may be fixed. 

 
Create a Profile Line Tangent to One Element 

This tool enables the user to place a profile line tangent to a curve. 

 
Create a Profile Line Tangent to Two Elements 

This tool enables the user to create a Vertical Alignment line tangent to two curves. 
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9.3.3.   Place Vertical Alignment Curves 

 

The Place Vertical Alignment Curves tools are detailed in the table below. 

 
Place a Vertical Curve by Three Points 

This tool enables the user to place a profile curve by three points. 

 
Place a Vertical Curve by High Point 

This tool enables the user to place a vertical curve by defining a high point (or in the 
case of a sag curve, the low point). 

 
Place a Vertical Curve Tangent to One Element and Through One Point 

This tool enables the user to place a profile curve tangent to one element (line or curve) 
and defining a pass through point. 

 
Place a Vertical Curve Tangent to One Element Given High Point 

This tool enables the user to place a profile curve tangent to one element and defining a 
high point or low point. 

 
Place a Vertical Curve Tangent to Two Elements 

This tool enables the user to place a profile curve tangent to two elements (any 
combination of lines and curves). 

9.3.4   Manipulate Vertical Alignment Elements 

 

The Manipulate Vertical Alignment Elements tools are detailed in the table below. 

 
Move a Profile View Element 

This tool enables the user to move an element or to make copies.  Note the moved or 
copied element must remain within the confines of the profile cell and associated delta 
top and bottom values. 

 
Rotate a Profile View Element 

This tool rotates the selected tangent about a user-defined point. 

 
Extend a Profile View Element 

This tool can extend or shorten any Vertical Alignment element, either tangent or 
vertical curve. 
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9.3.5   Profile Tools 

 

The Profile Tools tools are detailed in the table below. 

 
Store a Vertical Alignment in COGO 

This tool enables the user to store graphical profile components (lines and curves) into 
coordinate geometry.   

 
Graphical Profile Preferences 

This tool enables the user to define the preferences utilized within the Component 
Based Profile Generator such as the profile element symbologies and the profile name 
prefix. 

 
Import Vertical Alignment from COGO 

This tool enables the user to import (draw) a previously stored profile from the 
coordinate geometry database. 

 
Place Profile Cell Anchor 

This tool enables the user to place the profile required as a prerequisite to any profile 
creation.  Note the profile cell may be placed by many other applications in GEOPAK, 
i.e., D&C Manager, Vertical Alignment Generator, Project Manager and Plan / Profile 
Sheets. 

 
Profile Cell Control 

The Profile Cell Control dialog box enables the user to place or manipulate profile cells 
and associated data. 

 

9.4   Active Chain Control 
The GEOPAK Active Chain Control is an excellent tool, enabling the user to manage plan, profile, 
and cross section views simultaneously.  It also allows usage of MicroStation tools to place elements 
in any view in accordance with the curvilinear coordinates settings. 

The Active Chain Control requires COGO to be running.  If the tool is selected without COGO 
activated, the Chain list is empty.  In addition, the files must be referenced (i.e., plan, cross section, 
and profile) before utilizing the tool. 

When invoked, the dialog box depicted below opens. 

 

First, select the desired chain from the Chain list box at the left end of the tool box, as depicted 
below.  This list is updated each time a chain is created/deleted or a new GPK file is opened. 
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Four icons are supported to the right of the chain list field and are detailed in the table below. 

 
Graphically select the active chain candidate.   

 
Opens the “Precise Curvilinear Coordinates” dialog box, that allows entering 
precise curvilinear coordinates relative to the active chain. 

 
Activates the current Profile system, which is associated to a Profile Cell.  
The Profile Cell can stay in the master file or in any of the reference files.  If 
there are several Profile cells relative to the active chain, it is possible to 
designate the active one in the Profile Cell Control dialog box.  When the 
right button is pressed, a pop-up menu appears : 

 

The first option of the pop-up menu allows placing a Profile cell.  The second 
option allows getting information about Profile cells that stays in master and 
reference files and select the active one if there are several profile cells. 

 
Activates the current Cross Section system.  If there are several reference 
files containing XS cells relative to the active chain, it is not possible to 
activate the Cross Section Representation System.  In this case, an alert 
dialog box is displayed. 

 

The right side of the toolbox has eight icons, which set each view to plan, profile or cross section 
view.  By right clicking an icon, any view can be set to any of the 3 possible views.  For example, if 
there is an active profile cell, setting a view to profile will immediately fit the profile within the limits of 
the view. 
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LAB 9:   Proposed Profiles 
9.1   Generate the Proposed Profile 

Step 1. Execute  

 C:\data\geo\VDOT\road1\LAB9.EXE. 

Step 2. Open the MicroStation file: 

 C:\data\geo\VDOT\road1\d17682prof.dgn 

 Access Project Manager.  It should 
automatically access the Road workflow dialog 
box since we “remembered” the options in 
Exercise 2. 

Step 3. Select the Vertical Alignment button from the 
Road Project: 17682.prj workflow dialog box. 

 

 

Step 4. All of the information in the invoked Settings dialog box should be automatically 
populated based upon the information we provided in the DEFINE dialog box in Exercise 
8. 

Step 5. Press the OK button to commence development of the proposed profile. 

Step 6. Provide the initial VPI Station = 200+00 and the initial VPI Elevation = 2021.53 as shown 
in the diagram below. Be sure to press Enter after each entry is made. 
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Step 7. Press the Insert After button and complete the VPI Station and Elevation of the 
subsequent VPIs as detailed in the table below. 

VPI Station Elevation 

2 202+00 2029.88 

3 206+50 2011.02 

4 216+00 2095.00 

5 222+00 2099.00 

Step 8. Press the Prev VPI button to return to VPI 2 as shown in the diagram below. 

 

Step 9. Enter a symmetrical vertical curve Length of 300.  (The K value and Design Speed are 
automatically computed.) 

 

Step 10. Using the table below, enter the following vertical curve lengths. 

VPI Length 

3 400 

4 550 
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Step 11. When completed, select File > Save As from the Profile Generator to save the profile 
MAINLINE.  

 

Step 12. Exit the profile generator.  When prompted to save your profile, answer No since we did 
that in Step 10.  When prompted to save your Vertical Alignment settings, press Yes. 

Step 13. Open Cogo and use the Element > Profile > List/Print tool to see a listing of information 
about the profile.  The Element > Profile > Elevations tool will provide elevations at any 
station or increment of stations desired. 

 

Step 14. Exit the Coordinate Geometry dialog box. 
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9.2   Drawing the Proposed Centerline Profile 
Next, we are drawing the proposed profile utilizing the Draw Profile tool’s COGO tab. 

Step 1. Open the Draw Profile tool. 

 

Step 2. Set Chain to MAINLINE by selecting it from the dropdown list. 

 

Step 3. Click the COGO tab and set the Label Scale to 25 in the upper right hand corner. 

Step 4. Change the Profile Name to MAINLINE.  Set the feature as shown below and click OK. 
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Step 5.  Under the Options section of the dialog, select General.  Populate the dialog box as 
below. 

   

Step 6.  Under the Options section of the dialog, select VPI.  Populate the dialog box as below. 

   

Step 7.  Under the Options section of the dialog, select VC.  Populate the dialog box as below. 

   

Step 8. Click the Add Cogo Profile Settings icon to draw the proposed profile for the project. 

Step 9. Exit the Draw Profiles dialog box. 

Step 10. Review the proposed vertical alignment. 
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9.3   Update the Project Manager 
We are completing the Profile View of the Working Alignment Definition in Project Manager. 

Step 1. Press the Define button from the Workflow dialog box of Project Manager, 

Step 2. Highlight the Profile View option and populate the Proposed Profile field as depicted 
below. 

 

Step 3. Press the OK button to save the updates and close the dialog box. 

Step 4. Exit MicroStation. 
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Existing Ground Cross Sections 

10.1   Introduction 
Objectives To generate existing ground cross sections based on a horizontal alignment 

and the surface model beneath the alignment, and to review the sections 
utilizing the Cross Section Navigator tool. 

Project Manager Draw Pattern and Existing Ground Cross Section 

Tools 

          

Menu Bar Application GEOPAK Road > Cross Sections > Draw Pattern by Station Range 
GEOPAK Road > Cross Sections > Ground Cross Sections from DTM 
GEOPAK Road > Cross Sections > Navigator 

 

The prerequisites to generate existing cross-sections utilizing digital terrain modeling are: 

? GEOPAK coordinate geometry database wherein the horizontal alignment is stored. 
? GEOPAK binary TIN file, Site Model or Site Object.  The Site Model or Object are created 

utilizing GEOPAK Site Modeler software and are stored within the GEOPAK Site project (gsf) 
file. 

? Pattern lines if pattern by design is to be utilized. 
 

The generation of existing ground cross sections must be invoked from within the 2D MicroStation 
design file wherein the sections are to be drawn.  GEOPAK does not create this MicroStation design 
file.  The user creates the blank design file utilizing the desired seed file, and then GEOPAK draws 
into it. 

10.2   Pattern Lines 
Project Manager Draw Pattern 

Tools 

      

Menu Bar Application GEOPAK Road > Cross Sections > Draw Patterns By Station Range 

 

Pattern lines are graphical lines and/or line strings in a MicroStation design file that define locations at 
which the cross sections will be cut. 
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From the Project Manager you will select Draw Pattern, and create or select an existing run.  When 
completed, the following Draw Pattern Lines dialog box appears.  

 

Once all of the fields have been completed, and the application is initiated, graphic lines (on the 
specified level, color and style) are drawn along the chain.  This is a visual representation of the 
location of the cross sections to be generated. 

Six methods are supported for drawing the pattern lines: 

? Increment – starts at the beginning station, and draws a pattern line at the given increment. 
? Even – draws pattern lines at stations divisible by the given value. 
? Once – draws a pattern line at a given station. 
? Critical Points Horizontal – draws a pattern line at each of the critical point (i.e. POT, PC, PT, 

etc.) within a chain. 
? Critical Points Vertical – Draws a pattern line at each VPC and VPT in addition to the sag and 

crest station of vertical curves based on the profile defined in the dialog box. 
? Superelevation Transitions - The current design file is scanned for Superelevation shapes 

created with the specified chain.  A pattern line is drawn at the beginning and end of each 
Superelevation shape, ignoring the beginning and ending station fields in the dialog box.  Note 
the Superelevation shapes cannot be in a reference file. 

 

The pattern lines are drawn into the current MicroStation design file.  The user can use the 
MicroStation Place Smartline or Place Line command to draw additional pattern lines at any user 
defined location.  In addition, MicroStation commands can be utilized to modify pattern lines drawn via 
the dialog box to lengthen, shorten, delete, copy, move, etc.   

NOTE: This should be completed before the existing ground cross sections are generated. 
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10.3   Generating Cross Sections 
Project Manager Existing Ground Cross Section - Note a run must be created. 

Tools 

  

Menu Bar Application GEOPAK Road > Cross Sections > Draw Cross Sections from Surfaces 

 
Once the pattern lines have been drawn, the cross sections can be generated.  Note the Job Number 
must be defined in order to populate the Chain list.  Once the Chain is defined, the dialog box 
unghosts as depicted below. 

 

The rest of the dialog box consists of a menu bar with three listings: 

File Standard file utilities to load, or save settings, plus a dialog box exit 
option. 

Edit Options to Cut, Copy and Paste rows in the surfaces list box.  Also, 
save and restore settings in the RSC file or clear list of all surfaces. 

Update Options: User-defined options on how the software handles the redrawing of 
cross sections. 

Delete Existing Elements 
and Redraw  

When this option is activated, any existing ground lines previously 
drawn with this tool are deleted and new ground lines are drawn. 

Delete Non-modified 
Elements and Redraw  

When this option is activated, any existing ground lines previously 
drawn with this tool are deleted and new ground lines are drawn. 

Draw on Top of Existing  When this option is activated, any previously drawn ground lines are 
ignored and a new set is drawn, resulting in two sets of ground lines. 
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Query When activated, the user is prompted each time the Draw button is 
clicked. 

 

 

Two tabs on the dialog box support the input data required to draw cross sections: 

XS Cells  Defines the location of cross sections utilizing either pattern by station or 
pattern by design.  In addition, the scale and spacing are defined within this 
tab. 

Surfaces Define the surfaces utilized for drawing cross sections.  Note multiple surfaces 
may be drawn in a single processing.  Source data includes GEOPAK TIN 
files, Site Models, or Site Objects. 

 

On the XS Cells tab, the Pattern group box has three choices: 

Pattern by Station  Utilizes Begin and End Station values in addition to an Increment/Even option 
and Left and Right Offset fields to determine cross section location.  This 
works well when no sections are needed that are at odd stations, skewed or 
kinked relative to the Chain. 

Pattern by DGN  This method utilizes graphical representation and draws one cross section for 
each line or line string of the specified parameters.  Those parameters include 
Design File which is the name of the file that contains the lines and line strings 
in addition to their associated symbology. 

In Existing Only  No user input is required, as this option draws ground lines only for cross 
section cells which were previously drawn.  Therefore, no other pattern 
requirements are needed. 

 

On the Surfaces tab, the (Filter Tolerances group box has two fields: Horizontal and Variance.  Both 
Horizontal and Variance filter tolerances are considered together for each pair of cross section 
segments.  The middle point is deleted if both segment lengths are less than the Horizontal filter 
tolerance while the projected distance between the mid-point and the chord between the two end 
points is less than the Variance tolerance. 
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10.4   Cross Section Navigator 
Project Manager Not accessible from within Project Manager 

Tools 

  

Menu Bar Application GEOPAK Road > Cross Sections > Navigator 

 

The Cross Section Navigator tool is used to view and traverse between cross sections.  It can also be 
used to draw cross section information. 

When the Navigator is invoked, the following dialog box appears.  

 

The user can scan through the cross sections by either choosing the station from the drop down list, 
or by using the First Section, Previous Section, Next Section, or Last Section icons (arrowheads).  The 
Reset Navigator icon window centers the current station to the view.   

 

The Open View Control Dialog Box enables the user to open several windows to 
view different portions of the cross section at the same time.  The user can view the 
whole cross section in view 1, the left side in view 2, and the right side in view 3, etc. 

 

Cross section elements can be added or modified using MicroStation tools or GEOPAK cross section 
drawing tools, as detailed in the table below. 

DP Offset Elevation 

 

Data points at a given offset/elevation, or find the offset/elevation of the 
cursor location. 

 

DP Delta Distance 
Slope 

 

Draws a line at a given horizontal distance and slope.  

 

XS Active Angle 
Tool 

 

Sets the active angle to the given value.  If a MicroStation tool is used with 
the active angle option, this value is used. 
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Draw XS Line  

 

Draws a cross section line.  The length and/or slope can be specified.  

 

10.5   Summary - Basic Steps to Creating Existing Ground 
Cross Sections from a DTM 

Step 1. Requires a horizontal alignment stored in  *.GPK file. 

Step 2. Requires an existing triangle file (TIN) from a DTM. 

Step 3. Draw pattern lines. 

Step 4. Process cross sections using Draw Cross Sections tool. 

Step 5. Review and modify (if necessary). 
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LAB 10:   Existing Ground Cross Sections 

10.1   Draw Patterns 
The first step is drawing MicroStation lines or line strings to define the location of the existing ground 
cross sections.  

Step 1.  Execute C:\data\geo\VDOT\road1\LAB10.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682work.dgn 

 Access Project Manager.  It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

Step 3. Select the Draw Pattern button from the Road Project: 17682.prj workflow dialog box. 

Step 4. Create a new run called MAINLINE. 

Step 5. Populate the dialog box as depicted below.  

 

Step 6. Click Apply to initiate the plotting of the patterns into the design file. 

Step 7.  Change the station range and color as depicted below: 

 

Step 8. Click Apply to initiate the plotting of the additional patterns into the design file. 
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Step 9. Review the pattern lines. 

Step 10. Exit the Draw Pattern dialog box and Save Settings. 

10.2   Update Project Manager 
We are completing the Pattern section of the Working Alignment Definition in Project Manager. 

Step 1. From the Workflow dialog box of Project Manager, click the Define button. 

Step 2. Highlight the Pattern option and populate the dialog box as depicted below. Since we are 
in the pattern file, you can use the Select button to accomplish this task rather than 
manually typing in the information. 

 

Step 3. Click OK to close the Working Alignment dialog box. 
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10.3   Generate Existing Ground Cross Sections 
Step 1. Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsmainline.dgn 

Step 2. Click the Existing Ground Cross Sections button on the Project Manager dialog box. 

Step 3. Create a run called MAINLINE. 

Step 4. Generate the existing ground cross-sections by populating the dialog box as shown on 
the following dialog boxes and clicking the Draw button to initiate the routine. 

Note:  The Display Settings for the existing ground line are set to level 1, color 1, weight 5, style 2.   

   

Step 5. Exit the dialog box and Save Settings. 
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10.4   Review Cross Sections 

      

 

Step 1. Select the Cross Section Navigator tool from the Road Tools tool frame. 

 

Step 2. Use the Cross Section Navigator to browse and check your existing cross sections.  

Step 3. Exit the XS Navigator dialog box when done.  

 

10.5   Update Project Manager 
We are completing the Cross Section and Existing Ground sections of the Working Alignment 
Definition in Project Manager. 

Step 1. Highlight the Cross Section View option and populate the dialog box as depicted below: 
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Step 2. Highlight the Existing Ground option and populate the dialog box as depicted below 

 

Step 4. Click the OK button to close the dialog box. 

Step 5. Upon reviewing the sections, it is desirable to “lock” the elements to prevent accidental 
deletion or modification in later steps.   

 Select Edit > Select All from the MicroStation menu bar.  Then select Edit > Lock to lock 
the elements. 

Step 6.  Exit MicroStation. 
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Superelevation 
11.1   Introduction 
Objectives Learn to use GEOPAK Automated Superelevation dialog box and 

Autoshape Builder to apply superelevation to a roadway. 

Project Manager Calculate Superelevation 

Tools  

                         
 

          

 

 

 

 

Menu Bar Application GEOPAK Road > Cross Sections >Superelevation Shape Manager Tools 

GEOPAK 2001MR  11-

 

GEOPAK supports a myriad of options for the definition of pavement on proposed cross sections.  
They range from a single slope specification emanating from a baseline / profile on each section, to a 
complicated multiple roadway, each with its own superelevation transitions. 

The most basic is the project where no superelevation transitions are required, i.e., the roadway 
slope for all pavement (if any) can be specified as a single value.  In this case, the slope can be 
defined with the proposed cross section processing and any additional superelevation work is not 
required. 

Another option is the definition of superelevation when roadways are constant widths without tapers, 
i.e., turn lanes, acceleration and deceleration lanes, etc.  In these areas, the automated 
superelevation can be utilized, based on a user-defined design speed and considering the geometry 
of the specified roadway.  After careful review of the data (in ASCII format) and overriding the 
computed values, GEOPAK draws pavement representations as complex shapes into a MicroStation 
2D design file. 

A third option is the definition of superelevation when roadways are not constant widths, i.e., gore 
areas, turn lanes, acceleration and deceleration lanes, etc.  In these areas, graphic elements within a 
MicroStation 2D design file are utilized to create complex shapes which define the superelevation 
transitions. 

A combination of these tools can be combined with a project, or even within a single roadway.  The 
shapeless mode is excellent for rural applications, low volume city streets, frontage roads, etc., while 
the automated method quickly generates automated shapes for more complex roadways.  Any area, 
which cannot be defined via the automated method, can be augmented by the graphical method.  

For some users, only simple narrow shapes will be required when designing new roadways or 
performing slope correction for reconstruction projects.  The proposed cross section criteria will 
stretch the pavement out to the true proposed edge of pavement based on finding plan view elements 
that represent the EOP. 

Superelevation   1 
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11.2   Automated Superelevation (AutoShape Input File Maker) 
Project Manager Calculate superelevation 

Tools 

      

 

The GEOPAK Superelevation package enables the user to create, edit, and run an autoshape input 
file quickly, basing it on an existing COGO alignment. 

A rich set of preferences is available which gives the user complete control over every aspect of the 
standardization of the superelevation design process.  AASHTO Method V is available as a default, 
along with the ability to employ user-defined lookup tables both for e (superelevation rate) and for 
runoff length.  User-defined equations may also be entered to compute these values.  A thorough set 
of options is available for resolving the superelevation conflicts of Reverse Curves, Compound 
Curves, Broken Back Curves, and Short Curves.  

GEOPAK calculates superelevation transition 
locations for any alignment stored into the 
coordinate geometry database.  The main 
superelevation dialog box is simple and 
straightforward, allowing the user to select 
which preference file is to be used for the 
current session, as well as enabling the entry 
of the typical section lane configuration in the 
simple engineering terms of Number of 
Lanes, Lane Widths, Median Width (if any), 
and Cross Slope.  More complex lane 
configurations may be represented as 
needed. 

Upon computation of the superelevation 
parameters (cross slopes and stationing), the 
information is stored in an ASCII file, where 
the user may review and modify the 
transitions, if desired.  After reviewing the 
information, the ASCII file is executed from 
the Autoshape Builder to generate 
superelevation shapes. 

 

 

 

Job Coordinate geometry database wherein the desired chains and profiles are 
stored. 

Chain GEOPAK baseline chain dictating the horizontal geometry for which 
superelevation transitions are calculated.  This chain is also called the Shape 
Cluster Baseline in the Auto Shape input file.   
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Begin Station When the chain is defined, GEOPAK populates the Begin Station with the 
default beginning of the chain.  To compute superelevation for part of a chain, 
adjust the station.  

End Station When the chain is defined, GEOPAK populates the End Station with the 
default beginning of the chain.  To compute superelevation for part of a chain, 
adjust the station.  

Design Speed Design speed that determines what Design Speed is to be used either in the 
tables or equations for e and length computations. 

Preference File 
   e selection 
L selection 

The Preferences File combo box selects which Preference File is to be used 
for this computation.  The various Preferences Files which are available in the 
combo box are determined by what files have the .sep file extension in the 
Preference Files Path on the User Directories dialog box.  When it is set, the 
available e and length Selection combo boxes are filled in according to the csv 
file names as specified in the Preferences File.  Those combo boxes 
determine which table within the .csv file will be used for computation. 

Facility Facility determines whether the roadway cross section is to be divided or 
undivided.  This option determines two things.  For the dialog box box, it 
determines whether or not the values Profile, Tie (Offset or PGL), and or the 
Tie or PGL values may be different.  If they are different then two shape 
clusters are to be generated, which usually is required for a median.  The state 
of the Facility option button also determines which Preference is used as found 
on the Distribution tab of the Preferences dialog box.   

Left / Right tabs The area enclosed in the Left / Right tabs are for the determination of values 
specific to shape clusters.    

NOTE: The right and left tabs contain data pertaining to each lane within each 
roadway.  If the Facility is undivided, then the left tab is for the left lane(s) while 
the right tab is for the right lane(s).  If the Facility is divided, then the right tab is 
for the entire right roadway, while the left tab is for the left roadway.   

Create Input File ASCII file wherein GEOPAK creates the autoshape input file.  DO NOT include 
the extension, as GEOPAK adds .inp to the field.  

Generate 
Superelevation 
Transitions 

Commence automatic superelevation calculations 

Profile  GEOPAK profile defined as the Shape Cluster Profile in the Auto Shape input 
file.   

Tie Offset - Horizontal distance from the Profile (PGL) to the Chain.  

PGL Chain - Chain stored in the gpk file that the shapes will be computed 
from. This chain does not require a profile be stored with it as the defined 
profile will be applied to this chain. 

Offsets Offsets define the dimension of the shape (usually a lane) by two offset 
distances from the baseline.  Note that tapers are not supported.  Offset 
distances are negative if measured to the left.  .  Each lane must have the 
same offset on the left as the left adjacent lane and must have the same offset 
on the right as the right adjacent lane (no gaps in offsets).  Computation may 
not proceed if this condition is not met. 
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% Slope Cross slope of each shape in normal crown in percent format.  A negative sign 
denotes the roadway going downward, while emanating away from the PGL.  
A Normal Crown section of 2.0% would, therefore, be entered as –2.0.  Lane 
offset values are entered in terms of master units, i.e., feet or meters. 

Dependent / 
Independent 

One dependent shape, which is based on the profile, is required for each 
cluster.  Other shapes, drawn not based on the profile, but on adjoining lanes, 
are independent.  For example, turn lanes are drawn abutting next to the 
mainline roadway, so they are independent.  However, a lane based on the 
profile for its initial elevation, such as one of the through lanes, is profile 
dependent. 

 

Edit buttons: 
Add 
Delete 
Edit 

To add a line to the list box, type in the values in the edit fields, then click the 
Add icon.  To delete a line, highlight the desired line, then click the Delete icon.  
To modify a line, highlight the desired line, (which is then displayed in the edit 
fields), change the desired values, then click the Edit icon, which updates the 
list box. 

Quick Entry 

 

 

Enables the user to populate the shape cluster list boxes quickly while entering 
the data using engineering terminology.  When clicked, the dialog box depicted 
below opens. 

 

Selection of the Generate Superelevation Transitions button performs the actual superelevation 
computations.  Three things happen at this point.   

● First, the superelevation transitions as 
computed by GEOPAK are written to 
the Autoshape Input File specified by 
the user (in the Create Input File field).  

● Second, the log file is written.   
● Finally, the Autoshape Input File is 

loaded into the text editor running 
within MicroStation.  This Autoshape 
Input File Editor has an icon at the top 
that allows the Autoshape Input File to 
be run.  Autoshape Input files can also 
be run from the Autoshape Builder. 
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11.2.1   Example - Auto Shape ASCII Input File 
/* Superelevation Settings and Parameters: 
Project Name:  C:\data\geo\vdot\road1\17682.prj 
User:          C:\data\geo\vdot\road1\projdbs\VDOT 
Run Name:      MAINLINE 
Unit System is english. 
Created input file "mainline_shapes.inp". 
Created activity log file "mainline_shapes.log". 
Created on Wed, Nov 06, 2002 at 13:11. 
Using Preference File "english standard" 
Using e Selection of "rural". 
Using Length Selection of "rural" 
Using Design Speed of 35.000000. 
  
*/ 
  
auto shape 
job number = 101 
  
   auto shape set 
      shape cluster baseline   = MAINLINE 
      shape cluster profile    = MAINLINE 
      shape cluster tie        = 0.0000 
      dependent shape 
      chain  /  offset 
         MAINLINE   -8.0000 
         MAINLINE   -20.0000 
      filler line station / slope 
           200+00.000000   -2.0000 
           206+46.876488   -2.0000 
           208+45.876488    4.8000  /* Curve ML-1 */ 
           209+80.032227    4.8000  /* Curve ML-1 */ 
           211+79.032227   -2.0000 
           213+13.162662   -2.0000 
           213+31.032227   -2.6000  /* Curve ML-2 */ 
           219+02.785686   -2.6000  /* Curve ML-2 */ 
           219+20.655251   -2.0000 
           222+06.840000   -2.0000 
  
   auto shape set 
      shape cluster baseline   = MAINLINE 
      shape cluster profile    = MAINLINE 
      shape cluster tie        = 0.0000 
      independent shape 
      chain  /  offset 
         MAINLINE   -20.0000 
         MAINLINE   -32.0000 
      filler line station / slope 
           200+00.000000   -2.0000 
           206+46.876488   -2.0000 
           208+45.876488    4.8000  /* Curve ML-1 */ 
           209+80.032227    4.8000  /* Curve ML-1 */ 
           211+79.032227   -2.0000 
           213+13.162662   -2.0000 
           213+31.032227   -2.6000  /* Curve ML-2 */ 
           219+02.785686   -2.6000  /* Curve ML-2 */ 
           219+20.655251   -2.0000 
           222+06.840000   -2.0000 
  



GEOPAK® __________________________________________________________  

11-6    VDOT Road I Training GEOPAK 2001MR 

   auto shape set 
      shape cluster baseline   = MAINLINE 
      shape cluster profile    = MAINLINE 
      shape cluster tie        = 0.0000 
      dependent shape 
      chain  /  offset 
         MAINLINE   8.0000 
         MAINLINE   20.0000 
      filler line station / slope 
           200+00.000000   -2.0000 
           207+63.935312   -2.0000 
           208+45.876488   -4.8000  /* Curve ML-1 */ 
           209+80.032227   -4.8000  /* Curve ML-1 */ 
           210+61.973403   -2.0000 
           211+94.032227   -2.0000 
           213+31.032227    2.6000  /* Curve ML-2 */ 
           219+02.785686    2.6000  /* Curve ML-2 */ 
           220+39.785686   -2.0000 
           222+06.840000   -2.0000 
  
   auto shape set 
      shape cluster baseline   = MAINLINE 
      shape cluster profile    = MAINLINE 
      shape cluster tie        = 0.0000 
      independent shape 
      chain  /  offset 
         MAINLINE   20.0000 
         MAINLINE   32.0000 
      filler line station / slope 
           200+00.000000   -2.0000 
           207+63.935312   -2.0000 
           208+45.876488   -4.8000  /* Curve ML-1 */ 
           209+80.032227   -4.8000  /* Curve ML-1 */ 
           210+61.973403   -2.0000 
           211+94.032227   -2.0000 
           213+31.032227    2.6000  /* Curve ML-2 */ 
           219+02.785686    2.6000  /* Curve ML-2 */ 
           220+39.785686   -2.0000 
           222+06.840000   -2.0000 
  
   Plot Parameters 
      Dependent Shape 
         lv = 63 
         co = 6 
         lc = 0 
         wt = 2 
      Dependent Text 
         lv = 63 
         co = 6 
      Independent Shape 
         lv = 63 
         co = 1 
         lc = 0 
         wt = 2 
      Independent Text 
         lv = 63 
         co = 1 
  
Write shapes into dgn = C:\data\geo\vdot\road1\d17682work.dgn 



___________________________________________________________GEOPAK® 

11.3   Draw Shapes into Plan View File 
Project Manager None 

Tools  

                       

 

 

Menu Bar Application GEOPAK Road > Cross Sections >Superelevation Shape Manager Tools 

 

Once the shape input file (fname.inp) has been created and reviewed, the designer can run the input 
file to place the superelevation shapes into the specified graphics file.  To use the interactive method 
to define roadway superelevation (in a .dgn file) the designer pushes the Autoshape Builder icon 
from the Superelevation Shape Manager Tools tool bar (or alternately from this same icon within the 
Text Editor as described above).  

 

Input File  Name of .inp file (fname.inp) created by the Automated superelevation 
generation containing the transitions. 

Display Only  Create the shapes in "Display Only" mode.  That is, they are not written to the 
design file and a view Update operation eliminates them, as does zoom in, etc. 

 

The shapes are placed in a 2D graphics file on level 63 by default.  The plot parameters can be 
modified in the input file with a text editor prior to building the shapes into the graphics file or with the 
User > Symbologies pull down on the Automated Superelevation dialog box. 
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11.4   Shape Analysis Tools 
Tools  

                         
          

 

 

Menu Bar Application GEOPAK Road > Cross Sections >Superelevation Shape Manager Tools 

 
The tools in the Superelevation Shape Manager Tools toolbox are detailed below. 

Auto. Superelevation 

 

Performs the actual calculations and stores the results in an ASCII file, known 
as the autoshape input file. 

Autoshape Builder 

 

Processes the autoshape input file and draws corresponding complex shapes in 
the specified 2D design file. 

Shape Maker 

 

Graphical method of drawing irregular superelevation shapes.  This method is 
utilized for gore areas, turn lanes, etc. 

Shape Analyst 

 

The Shape Analyst tool provides information on any point within a GEOPAK 
superelevation shape. 

Shape Profiler 

 

The Shape Profiler tool provides profile information based on user-define 
increments intersecting a GEOPAK superelevation shape. 

Shape Editor 

 

The Shape Editor tool enables the user to dynamically change parameters on a 
previously created shape.  This includes filler line stationing, dynamic moving of 
shapes, etc. 

Shape Selector 

 

The Shape Selector tool highlights or selects shapes based on a wide range of 
user queries or filters. 

Shape Properties 

 

The Shape Properties tool provides information on any GEOPAK 
superelevation shape.  In addition, this shape information can be modified on 
individual shapes of selections of shapes. 
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11.4.1   Shape Analyst 
The Shape Analyst tool is extremely useful, as it provides information on any point within a GEOPAK 
superelevation shape. 

 

Before using this tool, the Job Number must be selected.  Upon selecting a Job Number, a Chain 
must be selected that the shapes are defined relative to.  If Display Only is enabled, information like 
elevation and a flow arrow are drawn to the view, but they are not written as elements to the active 
MicroStation file. 

When the Cross Section toggle is not activated and a data point is issued within a shape, the 
elevation of the data point and a flow arrow are displayed.  When the toggle is activated, a dashed 
line is placed through the data point, radial to the shaped cluster baseline.  In addition to the elevation 
and flow arrow placed at the data point, elevations are displayed where the cross section line 
intersects any superelevation shape and cross slopes are labeled for each shape. 

The By Sta/Offset button causes the current Station / Offset value to be projected back onto the 
shape cluster baseline and the elevation of the projected point is displayed.  This option can be 
manual entry only and requires no data point on the screen. 

The DP button works within a superelevation shape whose X, Y coordinates are utilized to compute 
station / offset from the specified shape cluster baseline, which is subsequently utilized in conjunction 
with the shape to compute the various slopes and elevations.  After the DP button is clicked, 
numerous data points can be placed.  It is not necessary to click the DP button again.  Each 
corresponding station / offset is displayed along with the associated output information. 

The Dynamic button activates the dynamic mode.  As the cursor moves across the screen, any 
momentary pause places the elevation and flow arrow in the MicroStation file and computes and 
displays the analysis information. 

The Extrapolate Fixed Slope toggle is another option supported in the Shape Analyst tool.  The 
option is utilized when the data point, dynamic point or station / offset is outside of the shape.  When 
the option is not activated, the data point is projected back to the shape's chain.  The elevations at 
the edges of the shape are displayed and the slope of the outside shape is projected to the data 
point.  When the toggle is enabled, the user defined slope is projected from the outer most shape to 
the data point to determine an elevation. 
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11.4.2   Shape Profiler 
The Shape Profiler tool computes elevations along any GEOPAK Shape or MicroStation element at a 
user specified interval.  The element can be inside or outside of the shapes. 

 

The Job field can be populated by key in or using the Select… button.  After selecting a GPK file, 
click Identify Shape and data point on any shape along the desired Chain.  Set the From Station 
and To Station fields by keying in values or using the DP buttons. 

 

Even should be selected when it is desired to have the elevations compute at the even station 
values.  Increment will allow the elevations to be computed starting at the From Station, then adding 
the increment value to that station.  Intersect is used with an element to compute elevations at all 
locations that the element intersects the shape(s). 

The Elevation Along toggle can be set to Shape or Element.  When set to Shape, elevations will be 
computed based on the Even/Increment value along both longitudinal edges of the shape.  When set 
to Element the elevations are computed along the element based on the Even/Increment/Intersect 
toggle. 

Continuous Extrapolation allows the user to identify multiple longitudinal elements outside of the 
shape area and compute elevations by a user defined Slope and one of three methods:  Radial to 
Baseline, Radial From Element, or Radial to Element. 
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LAB 11:   Superelevation 
As a reminder, our project contains distinct sections: 

Section 1 4 lane divided highway with depressed median from Sta. 200+00 to Sta. 202+00. 
Left side of the roadway will be resurfacing while the right side is new 
construction. 

Section 2 4 lane divided highway with raised median from Sta. 202+00 to Sta. 204+25. Left 
side of the roadway will be resurfacing while the right side is new construction. 

Section 3 4 lane undivided highway from Sta. 204+25 to Sta. 211+00. 

Section 4 2 Lane highway with Entrances and Exit Ramps from Sta. 211+00 to Sta. 220+00. 

Section 5 Exit Ramp (RampA) 

 

Based on this information, we will need to process the Superelevation separately for each of the 
above sections. Each process will create a shape input file that can be run individually.  

11.1   Automated Superelevation – Section 1 
Step 1.  Execute C:\data\geo\VDOT\road1\LAB11.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682work.dgn 

Step 3. Open Project Manager. 

Step 4. Click Calculate Superelevation 
button from the Road Project: 
17682.prj workflow dialog box. 

Step 5. Create a new run called ‘ML1’ 
and click OK. Once the 
Automated Superelevation 
dialog box has been invoked, the 
dialog box on the right will be 
displayed. 

 Fill out the upper portion of the 
dialog box as shown. 

Step 6. The profile should be set to 
MAINLINE for both the Left and 
Right tabs. 

Step 7. The Tie option should be set to 
offset and the offset value 
should be set to 0.0 to force the 
PGL (Profile Grade Line) to run 
along the centerline of 
construction (MAINLINE). 
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Step 8. Press the Quick Entry icon as 
shown in the image below. 

 

 

 

Step 9. Fill out the Quick Entry dialog box as shown 
to the right and press OK. 

 

 

NOTE:  Quick Entry can be used only if the 
lane configuration to the left and right sides of 
the baseline are the same. 
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 The dialog box should appear as 
shown: 

 

 

NOTE:  Quick Entry may reset your 
OFFSET. Please ensure that the 
offset for both the left and right 
roadways is set to 0. 

 

 

Step 10. Provide an Input 
Filename 
(ml1_shapes.inp) to 
store the computed 
transitions for this station 
range. 

Step 11. Click the Generate 
Superelevation 
Transitions button to 
initiate the calculation of 
the transitions for the 
Left and Right roadway. 

Step 12. Review the 
computations within the 
Text Editor dialog box. 
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Step 13.  To build these shapes into the graphics file, click the Autoshape Builder 
icon within the Text Editor dialog box.  This will automatically draw the 
shapes into your design file on level 63.  

Step 14. Close the Text Editor dialog box as well as the automated superelevation dialog box.  
When prompted to Save Superelevation settings, click Yes. 

Step 15. Review the Superelevation shapes created in the design file. 
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11.2   Automated Superelevation – Section 2 
Step 1. Click the Calculate Superelevation button from the Road Project: 17682.prj workflow 

dialog box. 

Step 2. Create a new run called ‘ML2’ and 
click OK.  Once the Automated 
Superelevation dialog box has 
been invoked, the dialog box on 
the right will be displayed. 

 

 Fill out the upper portion of the 
dialog box as shown. 

Step 3. The profile from which the shapes 
should be computed should be set 
to MAINLINE for both the Left and 
Right roadway tabs. 

Step 4. The Tie option should be set to 
offset and the offset value should 
be set to 0.0 to force the PGL 
(Profile Grade Line) to run along 
the centerline of construction 
(MAINLINE). 

 

Step 5. Press the Quick Entry icon as shown in the image below. 
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Step 6. Fill out the Quick Entry dialog box as shown below and press OK. 

 

 

NOTE:  Quick Entry can be used only if the lane configuration to the left and right sides 
of the baseline are the same. 

 

 The dialog box should appear as shown: 

 

 

NOTE:  Quick Entry may reset your OFFSET. Please ensure that the offset for both the 
left and right roadways is set to 0. 

 

Step 7. Provide an Input Filename (ml2_shapes.inp) to store the computed transitions for this 
station range. 
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Step 8. Click the Generate Superelevation Transitions button to initiate the calculation of the 
transitions for the Left and Right roadway. 

Step 9. Review the computations within the Text Editor dialog box. 

 

 

Step 10. To build these shapes into the graphics file, click the Autoshape Builder 
icon within the Text Editor dialog box.  This will automatically draw the 
shapes into your design file on level 63.  

Step 11. Close the Text Editor dialog box as well as the automated superelevation dialog box.  
When prompted to Save Superelevation settings, click Yes. 

Step 12. Review the Superelevation shapes created in the design file. 
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11.3   Automated Superelevation – Section 3 
Step 1. Click the Calculate Superelevation button from the Road Project: 17682.prj workflow 

dialog box. 

Step 2. Create a new run called ‘ML3’ 
and click OK.  Once the 
Automated Superelevation 
dialog box has been invoked, the 
dialog box on the right will be 
displayed. 

 Fill out the upper portion of the 
dialog box as shown. 

Step 3. The profile from which the 
shapes should be computed 
should be set to MAINLINE for 
both the Left and Right roadway 
tabs. 

Step 4. The Tie option should be set to 
offset and the offset value 
should be set to 0.0 to force the 
PGL (Profile Grade Line) to run 
along the centerline of 
construction (MAINLINE). 

 

Step 5. Press the Quick Entry icon as shown in the image below. 
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Step 6. Fill out the Quick Entry dialog box as shown below and press OK. 

 

 

NOTE:  Quick Entry can be used only if the lane configuration to the left and right sides 
of the baseline are the same. 

 

 The dialog box should appear as shown: 

 

Step 7. Provide an Input Filename (ml3_shapes.inp) to store the computed transitions for this 
station range. 

Step 8. Click the Generate Superelevation Transitions button to initiate the calculation of the 
transitions for the Left and Right roadway. 
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Step 9. Review the computations within the Text Editor dialog box. 

 

 

Step 10.  To build these shapes into the graphics file, click the Autoshape Builder 
icon within the Text Editor dialog box.  This will automatically draw the 
shapes into your design file on level 63.  

Step 11. Close the Text Editor dialog box as well as the automated superelevation dialog box.  
When prompted to Save Superelevation settings, click Yes. 

Step 12. Review the Superelevation shapes created in the design file. 
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11.4   Automated Superelevation – Section 4 
Step 1. Click the Calculate Superelevation button from the Road Project: 17682.prj workflow 

dialog box. 

Step 2. Create a new run called ‘ML4’ 
and click OK.  Once the 
Automated Superelevation dialog 
box has been invoked, the dialog 
box on the right will be displayed. 

 Fill out the upper portion of the 
dialog box as shown. 

Step 3. The profile from which the shapes 
should be computed should be 
set to MAINLINE for both the Left 
and Right roadway tabs. 

Step 4. The Tie option should be set to 
offset and the offset value should 
be set to 0.0 to force the PGL 
(Profile Grade Line) to run along 
the centerline of construction 
(MAINLINE). 

 

 

Step 5. Press the Quick Entry icon as shown in the image below. 
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Step 6. Fill out the Quick Entry dialog box as shown below and press OK. 

 

 

NOTE:  Quick Entry can be used only if the lane configuration to the left and right sides 
of the baseline are the same. 

 

 The dialog box should appear as shown: 

 

Step 10. Provide an Input Filename (ml4_shapes.inp) to store the computed transitions for this 
station range. 

Step 11. Click the Generate Superelevation Transitions button to initiate the calculation of the 
transitions for the Left and Right roadway. 

Step 12. Review the computations within the Text Editor dialog box. 
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Here’s where the ability to review your calculations and make changes comes in handy. 
Notice that from Sta. 205+00 to Sta. 211+00 we used an Urban Low Speed standard, 
which gave us a slope of 0.4624% at Sta. 211+00. But notice now we’ve used a Rural 
standard from Sta. 211+00 to Sta. 220+00, which gives us a slope of 1.2037% at Sta. 
211+00. 
Let’s fix this by hand-editing the superelevation calculations and changing the 
slope at Sta. 211+00 from 1.2037 to 0.4624 to match the slope coming out of the 
urban area. 
Important: You must SAVE the file before processing it. 

 

 

Step 13.  To build these shapes into the graphics file, click the Autoshape Builder 
icon within the Text Editor dialog box.  This will automatically draw the 
shapes into your design file on level 63.  

Step 14. Close the Text Editor dialog box.  When prompted to Save Changes, click Yes. 

 Close the automated superelevation dialog box.  When prompted to Save Superelevation 
settings, click Yes. 

Step 15. Review the Superelevation shapes created in the design file. 
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11.5   Automated Superelevation – Section 5 
Step 1. Click the Calculate Superelevation button from the Road Project: 17682.prj workflow 

dialog box. 

Step 2. Create a new run called 
‘RampA’ and click OK.  
Once the Automated 
Superelevation dialog 
box has been invoked, 
the dialog box on the 
right will be displayed. 

 Fill out the upper portion 
of the dialog box as 
shown. 

Step 3. The profile from which 
the shapes should be 
computed should be set 
to RAMPA for both the 
Left and Right roadway 
tabs. 

Step 4. The Tie option should be 
set to offset and the 
offset value should be 
set to 0.0 to force the 
PGL (Profile Grade Line) 
to run along chain 
RAMPA. 

 

 

 

NOTE:  Quick Entry cannot be used this time since the lane configuration for RampA is 
not the same on both sides of the baseline. 
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Step 5. Since Quick Entry cannot be used for the lane configuration, we’ll fill out the lane offsets 
and slopes manually. 

 Fill out the %Slope and Offset fields as shown and then add them to the list box by 
pressing the Add icon. 

 

 The dialog box should appear as shown: 

 

Step 6. Provide an Input Filename (rampa_shapes.inp) to store the computed transitions for this 
station range. 

Step 7. Click the Generate Superelevation Transitions button to initiate the calculation of the 
transitions for the Left Roadway. 
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Step 8. Review the computations within the Text Editor dialog box. 

 

 

Step 9.  To build these shapes into the graphics file, click the Autoshape Builder 
icon within the Text Editor dialog box.  This will automatically draw the 
shapes into your design file on level 63.  

Step 10. Close the Text Editor dialog box as well as the automated superelevation dialog box.  
When prompted to Save Superelevation settings, click Yes. 

Step 11. Review the Superelevation shapes created in the design file. 
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11.6   Building Manual Shapes 

 

NOTE:  There are times when the Autoshape Builder cannot be used. These normally occur in 
areas of lane transition where standard offsets are not sufficient enough to define the shape. 

 

Step 1. From the MicroStation menu bar select Utilities > Saved Views, access the Saved View 
“TRANS1”. 

Step 2. Click the Superelevation Shapes button from the Road Project: 17682.prj workflow 
dialog box. 

 

NOTE:  When building manual shapes, it’s desirable to only display the graphics that are 
absolutely required to define edges of the shapes. Also note that there may be times you will 
need to add graphical elements to the design file (such as lane lines) in order to be able to 
build a shape correctly. 

  

Step 3. Turn off the Reference File Levels 4,7 and 31. Also, turn off the patterns (Level 50) in the 
active design file. 

Step 4. Create the first slope filler line by filling out the dialog box as shown and pressing Create. 

 

Style = 0 and Weight = 2 
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Step 5. Create the second slope filler line by filling out the dialog box as shown and pressing 
Create. 

 

Step 6. Now press the DRAW button and issue a DP inside the lane as shown in the image 
below. 
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Step 7. Repeat Steps 4-6, this time issuing a DP for the other inside lane as shown in the image 
below. 

 

 

X

 

X
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Step 8. Change the Class, Color and Fill in the dialog box as shown below. 

   

Step 9. Repeat Steps 4-6 twice more to create the shapes for the two outside lanes. 
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11.7   Draw Superelevation Diagram 
In the next steps we’ll draw a Superelevation Diagram on the Profile Cell using a custom 3PC 
application.  We will run this in two passes.  One from Station 205+00 R 1 to 211+00 R 1 and one 
from Station 211+00 R 1 to 220+00 R 1. 

Step 1. Open the MicroStation file c:\data\geo\VDOT\road1\d17682prof.dgn 

Step 2.  Open Design and Computation Manager.  Double click item Location & Design>Special 
Applications>Super Diagram. 

Step 3. Populate the dialog box as show below.  Click OK. 

205+00 R1 to 211+00 R 1 

 

 

NOTE:  Use the Identify Cell button to populate the upper left portion of the dialog box. 
Shapes Input File = ml3_shapes.inp 
Proposed Design File = d17682des.dgn 

 

Step 4. Click OK when the prompt below appears. 
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Step 5.  Double click item Location & Design>Special Applications>Super Diagram again. 

Step 6. Populate the dialog box as show below.  Click OK. 

211+00 R1 to 220+00 R 1 

 

 

NOTE:  Use the Identify Cell button to populate the upper left portion of the dialog box. 
Shapes Input File = ml4_shapes.inp 
Proposed Design File = d17682des.dgn 

Step 7. Click OK when the prompt below appears. 
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11.8   Update the Project Manager 
We are completing the Plan View category of the Working Alignment Definition in Project Manager. 

Step 1. From the Workflow dialog box of Project Manager, click the Define button. 

Step 2. Highlight the Plan View > Shapes option and populate the Shapes Design file as shown 
below: 

 

Step 3. Click the OK button to save the updates and close the dialog box. 

Step 4. Exit MicroStation. 
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Proposed Cross Sections 

12.1   Overview 
Objectives Use Project Manager to create proposed cross-sections. 

Project Manager Proposed Cross Sections 

Menu Bar Application Only batch processing of Input file is supported. 

When the Proposed Cross Sections button in the Road Project Manager is clicked, the Select Run 
dialog box is displayed.  An existing run may be selected or new run may be started.  When complete, 
click the OK button, which closes the Select Run dialog box and opens the proposed cross sections 
dialog box as depicted below.   

 
NOTE:  This dialog box cannot be accessed outside of the Project Manager. 

 

The left side of the dialog box contains 
the list of categories required to process 
proposed cross sections.  When each 
category is selected, the dialog box 
changes to reflect the requirement of 
each category.  For example, when Plot 
Parameters is selected, the dialog box 
changes to reflect the various plot 
parameters and text as depicted on the 
following diagram.  
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12.1.1   XS DGN File 
When XS DGN File is selected from the list box, the dialog box dynamically changes as depicted 
below.  XS DGN File defines the MicroStation file wherein the original ground cross sections are 
located as well as the location for the proposed cross sections. 

 

12.1.2   Pattern 
When Pattern is selected, the dialog box changes as illustrated below. 

 

This dialog box defines the type of Pattern Lines used on a project – By DGN or By Station – in 
addition to other parameters specific to each format. 
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Three dialog boxes (Pattern, Existing Ground, and Shapes) support a toggle to Use Working 
Alignment Definition.  For example, in the Pattern dialog box, if the toggle is not active, the user 
must supply all pattern information.  

 

However, if the toggle is active when one of these three categories is selected, the data information 
part of the dialog box is ghosted and the required information is utilized from the current working 
alignment definitions.  If the toggle is activated, and the required information is not stored within the 
current working alignment, an Alert message is displayed.  
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12.1.3   Existing Ground 

 
When the Existing Ground category is selected, the dialog box will appear as shown above.  In this 
dialog box the user can select the name of the file that contains the existing ground in addition to the 
symbology of the existing ground. 

12.1.4   Shapes 

 
Three Shape definition options are supported: 

All in DGN  All shape elements within the specified file are utilized. 

By Search Criteria  Only those shapes that match the specified search parameters are utilized. 

Shapeless No shapes are utilized, hence, there is no field for a shapes file name or files 
button. This option will be used with the first exercise to produce existing 
shoulders and pavement on the existing cross sections. 
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12.1.5   Shape Clusters 
When the Shape Clusters parameter is selected, the dialog box dynamically changes as depicted 
below (there should not be any definitions within the dialog box upon the initial invoking of this 
parameter): 

 

The user may Add, Delete, or Modify any specified shape cluster.  When the Scan button is clicked, 
GEOPAK scans the design file and search criteria specified in the Shapes dialog box and lists all 
matching clusters.  In the instance of shapeless criteria, the user must define each cluster by utilizing 
the Select button or typing in the Chain, Tie/PGL and Profile associated with this shape; then click 
the Add button. 
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Note the button labeled Typical.  This application enables the designer to relate specific criteria files 
from a standardized library to specific typical sections, thereby foregoing the need to pick and choose 
which criteria files they need.  They simply select the typical section(s) for their project and the criteria 
files are retrieved for them automatically from the library. 

When the Typical button is pressed, the Typical Section Generator dialog box appears as depicted 
below. 
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The user must simply select the typical section from the left, then press Apply.  For a divided roadway 
with a left and right Profile Grade Line, the user would apply the selected typical once to the left 
roadway and then once again to the right roadway. You can also apply the typical to the entire length 
of the alignment or only a portion of the alignment by changing the Apply to Whole Chain toggle to 
Apply to Station Range and specifying a beginning and ending station for the typical. 

 

12.1.6   Define DGN Variables 

 

The Define DGN Variables option allows the user to define how to locate MicroStation elements used 
by the criteria files.  Define DGN Variables can be determined from the element symbology, or from 
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the symbology and attributes assigned in the D&C Manager database.  Variables that are previously 
defined in the criteria will show up in the list.  If the Select button is unghosted, variables remain 
undefined and must be defined before processing the sections.  Click Select to see a list of undefined 
variables, assign a value, then click Add. 

12.1.7   Define Variables 

 

Define Variables enable the user to enter job specific values for certain variables.  (i.e. pavement 
thickness, ditch width, backslope, etc.)  The user can select the variable from the list, then enter the 
new value and click the Modify button.  The values of these variables are constant for all of the cross 
sections within a specific run. 

12.1.8   Redefinable Variables 

 

Redefinable Variables are variables that are made available to the designer for those features of the 
design that may need to vary from project to project or over the course of a single project.  This 
category will not appear until a typical has been selected that utilizes redefinable variables.  For each 
variable name highlighted in the Variable list box, The corresponding description and value will be 
displayed in the Redefine list box. 
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To modify the value of a variable, first highlight the name of the variable, then click Edit.  This will 
open the Redefinable Variables Editor window.  Note that this window is resizable.   

 

12.1.9   Plot Parameters 

 

Plot Parameters enables the user to determine how the data from the superelevation shapes are 
going to appear.  XS Lines determine the symbology of the pavement surface.  Text plots various 
pieces of text relating to the cross section.  The elevation of the PGL of each shape cluster is 
automatically plotted.  Enable the Line Text toggle to define this symbology for the PGL text.  The Plot 
group box enables the user to control different aspects relating to the cross sections and criteria files 
as detailed below. 

Pavement Thickness draws the bottom of shaped pavement for all clusters.  If the Thick button was 
utilized in the shape clusters dialog box, this should be disabled. 

Fill Gaps Between Clusters draws a line between two shape clusters if the criteria does not fill 
between them. 

Transition Definition defines the use of parabolic superelevation transitions.   

Intersect Between Clusters extends or trims elements in a median to create a finished, clean 
appearance. 
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Process Clusters as Indicated forces the criteria to process the clusters as they are listed in the 
Shape Clusters dialog box.  If this option is turned off, the clusters are processed left to right. 

Remove Skew Effect forces GEOPAK to correct itself back to the pattern line if a skewed element is 
encountered in the processing of the criteria files. 

Process Only Sections With Existing Ground - If only one group (color) is indicated in the input file 
for the existing ground in each run, the program loads into memory only the ground lines of the 
specified color, and processes only those sections.  The time reduction may vary depending on the 
specific conditions of the job and type of machine. 

12.2   Files 
Under Files, the options are Run, Save Settings, Export... and Exit.  To process the 
cross sections, click the Run button, which invokes the Process Cross Section dialog 
box.  Save Settings simply saves the current settings to the run.  When the File > 
Export option is selected, the user may save the dialog box information in an ASCII 
input file for review or subsequent processing.  The File > Exit option enables the user 
to exit the Proposed Cross Sections dialog box box.  The software also prompts the 
user with an Alert box if the settings should be saved before exiting.  Clicking the Yes 
button saves the current dialog box settings, No does not save the settings, but both 
buttons exit to the Project Manager. 

 

12.3   Processing 
When File > Run is chosen, the dialog box below appears. 

 

The output can be displayed on the Screen Only, or written to a Log File and displayed to the screen.  
The Pause On Each Section option enables the user to view each section as it is drawn.  Criteria 
View displays each step in the criteria file.  This is primarily for debugging purposes. 

12.4   Criteria Files 
One of the most powerful and flexible features of GEOPAK is the use of criteria in generating 
proposed cross sections.  Within criteria, design conditions can be evaluated and complicated design 
decisions executed in response to these design conditions.  The flexibility of criteria allows the 
designer to make the design as basic or as complex as the project requires.  Numerous baselines can 
interrelate as ditches and medians are drawn between roadways and ramps. Sophisticated drainage 
details can also be drawn with criteria.  The list is endless. 

Cross section criteria are used to draw cross section features outside of the mosaic of superelevation 
shapes typically representing pavement.  Operationally, the software constructs the cross section 
features derived from the mosaic of shapes first.  Then, the software constructs the remaining 
portions of the cross section through the application of criteria emanating out from the outer edges of 
the mosaic of shapes.  
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LAB 12:   Proposed Cross Sections 

12.1   Existing Pavement 
In this first section, a new run will be created and used to draw the existing pavement onto the cross 
sections. 

Step 1.  Execute C:\data\geo\VDOT\road1\LAB12.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsmainline.dgn 

Step 3. Open Project Manager.  It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

Step 4. Choose Proposed Cross Sections from the Project Manager dialog box and create a 
run called Exbase. Then double-click Exbase and the following dialog box will appear. 

 

Step 5. Complete the following items in the dialog box. 

XS DGN File This filename should be defined as d17682xsmainline.dgn 

Pattern Use Working Alignment Definition 

Existing Ground Use Working Alignment Definition 

Shapes Set the Shape Option to Shapeless. 
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Step 6. Next, select the Shape Clusters category to invoke the following dialog box. 

 

 

First, we will define the Chain, Tie and Profile for the 
shapes. 

 

Step 7.  Click the Select button to invoke the following 
dialog box. 

Step 8. For the Chain option, highlight the chain 
MAINLINE and click Apply. 
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Step 9. Change the option to Profile and select the 
profile MAINLINE and click Apply. 

 When the chain and profile have been 
selected, click the Done button. 

 

 

Step 10. Next, provide a Tie distance of 0 in the Tie field and click the Add button to include this 
shape cluster in the list box as shown below: 

 

Step 11.  Highlight the shape cluster that was just defined in the list box and click the Typical 
button. 

 

Note: The Typical button will not be available until a shape cluster has been selected from 
the list box. 

 

 If the following dialog box appears, click OK. 
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Step 12. Select Typical EXPVMT.  This typical will be used to draw the existing pavement for the 
length of the project. 

Step 13. Click Description.  This will open WordPad to show a complete description of what the 
typical will draw, all variables and their definition, in addition to any special notes or 
considerations. 

 After reviewing the description file, dismiss/exit the description file. 

 Press APPLY.  
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Step 14. Next we will need to define variables found in this criteria file. 

 Click the Define Variables category.  Modify the NAME OF SURVEY FILE variable as 
shown in the dialog box below.  

 Highlight the Variable you wish to change. 

 Change the name in the Value field and press Modify. 

 

 

 

NOTE: Although there is an option on the dialog for Define DGN Variables, this will never 
be used. 

 

Step 15. Select the Redefinable Variables category.  Review the values for each variable.   
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Step 16. Select the Plot Parameters category and set it as shown below (weight = 5). 

 

Step 17. Press the Define button beside the Line Text toggle to access the following dialog box: 

 

 Fill out the dialog box as shown above then push OK. 

 At this point we are ready to process the existing pavement for the chain MAINLINE. 

Step 18. From the Proposed Cross Sections dialog box, select Files > Save Settings, then Files > 
Run. 

 The following dialog box is invoked where you may define where you want to see the 
computed cross section information, in an output file or on the screen only. 
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Step 19. Select Screen Only and activate the Pause on Each Section toggle to view the first 
design section once it has been drawn.  The dialog should appear as below.  Click Apply. 

 

 

NOTE: When errors occur, change the Screen Only to Log File, the click Apply to 
generate the log file. Use the GEOPAK Editor to open the log file to determine the 
problem 

 

The error usually occurs at the end of the file. However, the error may be in the line(s) 
prior the error message. 

 

Step 20. When processing is complete, click Exit to return to the Process Cross Sections dialog 
box. 

Step 21. Close the Proposed Cross Sections dialog box box by using the “X” on the upper right of 
the dialog box or by using the Files > Exit pulldown. 

 When prompted to Save Settings, answer Yes. 

Step 22. Use Cross Section Navigator to review the existing base as drawn. 

12.2   Right of Way and Easements 
In this next section, a new run will be created and used to label the Right of Way and Easements on 
the cross sections. 

Step 1. Choose Proposed Cross Sections from the Project Manager dialog box and create a 
run called RW. Then double-click RW and the following dialog box will appear. 
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Step 2. As before, complete the following items in the dialog box. 

XS DGN File This filename should be defined as d17682xsmainline.dgn 

Pattern Use Working Alignment Definition 

Existing Ground Use Working Alignment Definition 

Shapes Set the Shape Option to Shapeless. 

 

Step 3. Next, select the Shape Clusters category to invoke the following dialog box. 

 

 

First, we will define the Chain, Tie and Profile for the 
shapes. 

 

Step 4.  Click the Select button to invoke the following 
dialog box. 

Step 5. For the Chain option, highlight the chain 
MAINLINE and click Apply. 
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Step 6. Change the option to Profile and select the 
profile MAINLINE and click Apply. 

 When the chain and profile have been 
selected, click the Done button. 

 

Step 7. Next, provide a Tie distance of 0 in the Tie field 
and click the Add button to include this shape 
cluster in the list box as shown below: 

 

 

Step 8. Highlight the shape cluster that was just defined in the list box and click the Typical 
button. 

 

Note: The Typical button will not be available until a shape cluster has been selected from 
the list box. 

 

 If the following dialog box appears, click OK. 
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Step 9. Select Typical DRROW.  This typical will be used to label the right of way and easements 
for the length of the project. 

Step 10. Press Apply. When you see the following dialog box, always press Yes to All. 

 

Step 11. Next we will need to define variables found in this criteria file. 

  Click the Define Variables category.   
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  Modify the variables as shown in the table below: 

Name of Proposed R/W File d17682des.dgn 

Name of Existing R/W File s17682.dgn 

 

 

NOTE: Although there is an option on the dialog for Define DGN Variables, this will never 
be used. 
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Step 12. Select the Redefinable Variables category.  Review the values for each variable.   

 

Step 13. Select the Plot Parameters category and set it as shown below (weight = 5). 

 

Step 14. Press the Define button beside the Line Text toggle to access the following dialog box: 
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  Fill out the dialog box as shown above then push OK. 

At this point we are ready to process the r/w and easements for the chain MAINLINE. 

Step 15. From the Proposed Cross Sections dialog box, select Files > Save Settings, then Files > 
Run. 

 The following dialog box is invoked where you may define where you want to see the 
computed cross section information, in an output file or on the screen only. 

 

Step 16. Select Screen Only and activate the Pause on Each Section toggle to view the first 
design section once it has been drawn.  The dialog should appear as below.  Click Apply. 

 

Step 17. When processing is complete, click Exit to return to the Process Cross Sections dialog 
box. 

Step 18. Close the Proposed Cross Sections dialog box box by using the “X” on the upper right of 
the dialog box or by using the Files > Exit pulldown. 

 When prompted to Save Settings, answer Yes. 

Step 19. Use Cross Section Navigator to review the right of way and easements as drawn. 

Step 20. Before moving on to the next section, lock all the elements in the design file by using the 
Microstation pulldowns 

 Edit > Select All 

 Edit > Lock 
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12.3   Proposed Cross Sections (Sta. 200+00 to Sta. 204+25) 
In this set of steps, a new run will be created and used to generate the proposed cross sections. 

Step 1. Choose Proposed Cross Sections from the Project Manager dialog box and create a 
run called ML1.  You may enter this station range in the description if you wish. 

Step 2. Complete the following items in the dialog box. 

XS DGN File This filename should be automatically defined as 
d17682xsmainline.dgn.   

Pattern See dialog box below 

Existing Ground Use Working Alignment Definition 

Shapes Use Working Alignment Definition 

 

  

Step 3. Click Shape Clusters to define shape clusters, side slope conditions and criteria files. 

Step 4. Click the Scan button to have the software scan the d17682work.dgn file for all of the 
shape clusters. 

 

 Select Chain MAINLINE. 

 On the Proposed Cross Sections dialog box, click Add to add the this cluster to the 
shape cluster list box 
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 Click Close to close the List of Clusters window. 

 

Step 5. Highlight the shape cluster option and click the Typical button. 

Step 6. Select the typical DRLNRU.  Set the option in the Template window area to Apply to Left 
Roadway.  Set the Range option to Apply to Whole Chain.  Click Apply. 
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 Click Yes to All when prompted to overwrite criteria files. 

 

Step 7.  Your dialog box should look like the following: 

 

Step 8. With the shape cluster still highlighted, click the Typical button again. 

Step 9. Leave everything the same, but set the option in the Template window area to Apply to 
Right Roadway. Click Apply. 

 

 Click Yes to All when prompted to overwrite criteria files. 
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Step 10. Your dialog box should update with 2 additional Side Slope conditions: 

 

Step 11. Select the Define Variables category.  Modify the following variables as shown: 

Name of Plan File d17682des.dgn 

Name of Profile File D17682prof.dgn 

Name of Proposed RW File d17682des.dgn 

Name of Existing RW File s17682.dgn 

Name of Survey File s17682.dgn 

Name of Working File d17682work.dgn 

Name of Cross-Section File d17682xsmainline.dgn 
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Step 12. Select Plot Parameters.  Set the XS Lines values as shown (Weight=5) and disable all 
options in the Plot section of the dialog box. Also set the Line Text to level = 63 as in the 
previous sections. 

 

Step 13. Click Files > Save Settings then click Files > Run. 

 Select Screen Only and activate the Pause on Each Section toggle to view the first 
design section once it has been drawn.  The dialog should appear as below.  Click Apply. 

 

Step 14. When processing is complete, click Exit to return to the Process Cross Sections dialog 
box. 

Step 15. Close the Proposed Cross Sections dialog box box by using the “X” on the upper right of 
the dialog box or by using the Files > Exit pulldown. 

 When prompted to Save Settings, answer Yes. 

Step 16. Use Cross Section Navigator to review the proposed cross sections as drawn. 

 

Note: At this point the sections will not be correct because we ran them with the default 
values. We’ll come back in subsequent sections and use our variables to modify our 
design. 

  

Step 17. Before moving on to the next section, let’s turn off certain levels to make our sections 
more readable.  
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 Turn OFF the following levels: 

51 Elevation Labels 

52 Offset Labels 

53 Existing Pavement Labels 

55 Warning Text Labels 

56 Feature Labels 

Step 18. File > Save Settings 

12.4  Proposed Cross Sections (Sta. 204+25 to Sta. 220+00) 
Step 1. Choose Proposed Cross Sections from the Project Manager dialog box and create a 

run called ML2. You may enter this station range in the description if you wish. 

Step 2. Complete the following items in the dialog box. 

XS DGN File This filename should be automatically defined as 
d17682xsmainline.dgn.   

Pattern See dialog box below 

Existing Ground Use Working Alignment Definition 

Shapes Use Working Alignment Definition 

 

 

Step 3. Click Shape Clusters to define shape clusters, side slope conditions and criteria files. 
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Step 4. Click the Scan button to have the software scan the d17682work.dgn file for all of the 
shape clusters. 

 

 Select Chain MAINLINE. 

 On the Proposed Cross Sections dialog box, click Add to add the this cluster to the 
shape cluster list box 

 Next, Select Chain RAMPA. 

 On the Proposed Cross Sections dialog box, click Add to add the this cluster to the 
shape cluster list box 

 Click Close to close the List of Clusters window. 

 

Step 5. Highlight the shape cluster entry for chain MAINLINE and click the Typical button. 
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Step 6. Select the typical UNPVT.  Set the Range option to Apply to Whole Chain.  

 Click Apply. 

 

 Click Yes to All when prompted to overwrite criteria files. 

 

Step 7. Highlight the shape cluster entry for chain RAMPA and click the Typical button. 
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Step 8. Select the typical UNPVT.  Set the Range option to Apply to Whole Chain.  

 Click Apply.   Click Yes to All when prompted to overwrite criteria files. 

 

Step 9. Select the Define Variables category.  Modify the following variables as shown: 

Name of Plan File d17682des.dgn 

Name of Profile File d17682prof.dgn 

Name of Proposed RW File d17682des.dgn 

Name of Existing RW File s17682.dgn 

Name of Survey File s17682.dgn 

Name of Working File d17682work.dgn 

Name of Cross-Section File d17682xsmainline.dgn 

 

Step 10. Select Plot Parameters.  Set the XS Lines values as shown (Weight=5) and disable all 
options in the Plot section of the dialog box. Also set the Line Text to level = 63 as in the 
previous sections. 

 



___________________________________________________________GEOPAK® 

GEOPAK 2001MR LAB 12:   Proposed Cross Sections    12-33 

Step 11. Click Files > Save Settings then click Files > Run. 

 Select Screen Only and activate the Pause on Each Section toggle to view the first 
design section once it has been drawn.  The dialog should appear as below.  Click Apply. 

 

Step 12. When processing is complete, click Exit to return to the Process Cross Sections dialog 
box. 

Step 13. Close the Proposed Cross Sections dialog box box by using the “X” on the upper right of 
the dialog box or by using the Files > Exit pulldown. 

 When prompted to Save Settings, answer Yes. 

Step 14. Use Cross Section Navigator to review the proposed cross sections as drawn. 

Step 15. Before moving on to the next section, delete all of the proposed xsections. We’ll re-run 
them again in the next section. You can do this easily by doing the following: 

 Edit > Select All 

 Press the Delete icon. 

12.5   Variables 
In this section we’ll learn how to use our variables to modify the xsections. 

12.5.1   Pavement Variables 
Step 1. Choose Proposed Cross Sections from the Project Manager dialog box and access 

the previously created run called ML1.  
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Step 2. Select the Redefinable Variables category to display all of the redefinable variables for 
the run. 

 

Step 3. Let’s change the variable _d_SurfaceThickness from 12 to 3. In order to change a 
variable, follow these steps: 

 Highlight the variable _d_SurfaceThickness. 

 Click the Edit button to access the Redefinable Variable Editor. 

 

 Change the value of _d_SurfaceThickness to 3 and click Save. 

Step 4. Modify these additional variables as shown: 

_d_Intermediate1Thickness 3 

_d_Base1Thickness 3 

_d_Subbase1Thickness 6 

_d_OverlaySurfaceThickness 3 

_d_OverlayIntermediateThickness 3 
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_d_OverlayBaseThickness 3 
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_d_MillingDepth 2.5 

_d_WideningSurfaceThickness 3 

_d_WideningBase1Thickness 3 

_d_WideningSubbase1Thickness 12 

_d_ShoulderSurfaceThickness 3 

_s_ExtendSubbase1 1 

 

Step 5. Click Files > Save Settings then click Files > Run. 

Step 6. When processing is complete, click Exit to return to the Process Cross Sections dialog 
box. 

Step 7. Close the Proposed Cross Sections dialog box box by using the “X” on the upper right of 
the dialog box or by using the Files > Exit pulldown. 

 When prompted to Save Settings, answer Yes. 

Step 8. Use Cross Section Navigator to review the proposed cross sections as drawn. 

12.5.2   Slope Variables 

12.5.2.1   Special Ditches 
Step 1. Choose Proposed Cross Sections and access the previously created run called ML2.  

Step 2. Select the Define Variables category and change the variable for Left Special Ditch 
Profile to “ditchlt1” as shown: 

 

 This is a special ditch profile that runs from Sta. 214+75 to Sta. 217+00. 
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12.5.2.2   Erosion Control Ditches & Berms 
Step 1. Under the Redefinable Variables category, select _s_DrawErosCtrlDitchFillLeft as shown 

in the dialog box below. 

 

Step 2. Click the Edit button to access the Redefinable Variables Editor. 

 

Step 3. Highlight the section as shown in the dialog box below and then use a CTRL-C and 
CTRL-V to make a copy of it. 
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Step 4. Change the station range as shown to specify a certain area where we want to draw an 
erosion control ditch. Click Save. 

 

 

Important: When you change a variable in the editor by specifying a station range, 
remember that you are responsible to make sure that any station to be processed has an 
assigned value for the variable. 

 

Step 5.  Make the same change to the variable _s_DrawBermFillLeft and click Save. 
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12.5.2.3   Force Slope Tie Inside RW 
Step 1. Under the Redefinable Variables category, select _s_ForceSlopeInsideRWLeft and 

make the changes as shown in the dialog box below. 

 

12.5.2.4   Force Cut and Fill Slopes 
Step 1. Under the Redefinable Variables category, select _d_ForcedCutSlopeRight. 

 Force the xsections to use a Cut slope of 2:1 on the right side from Sta. 205+75 to Sta. 
208+50. 

 

Step 2. Select _d_ForcedFillSlopeRight. 
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 Force the xsections to use a Fill slope of 2:1 on the right side from Sta. 205+75 to Sta. 
208+50. 

 

Step 3. Click Files > Save Settings then click Files > Run. 

Step 4. When processing is complete, click Exit to return to the Process Cross Sections dialog 
box. 

Step 5. Close the Proposed Cross Sections dialog box box by using the “X” on the upper right of 
the dialog box or by using the Files > Exit pulldown. 

 When prompted to Save Settings, answer Yes. 

Step 6. Use Cross Section Navigator to review the station ranges denoted for the variables to 
make sure the changes were picked up. 

12.6   Rootmat 
Step 1. Open the MicroStation file c:\data\geo\VDOT\road1\d17682work.dgn 

Step 2. Turn off levels 50 and 63. Review the design file and notice the elements on level 13. 
These elements were drawn via D&C Manager and reflect the following: 

 Location and Design > Ground Cover > WLFR (Woods Left Field Right) 

 Location and Design > Ground Cover > WOOD (Woodlands Throughout) 

 Location and Design > Ground Cover > FLWR (Field Left Woods Right) 

Step 3. Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsmainline.dgn 

Step 4. Choose Proposed Cross Sections from the Project Manager dialog box and create a 
new run called ROOTMAT. 
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Step 5. Complete the following items in the dialog box. 

XS DGN File This filename should be automatically defined as 
d17682xsmainline.dgn.   

Pattern Use Working Alignment Definition 

Existing Ground Use Working Alignment Definition 

Shapes Shapeless 

 

Step 6. Fill out the shape cluster category as shown and click the Typical button. 

 

Step 7. Select the rootmat typical (ROOTMT) as shown and click Apply. 
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Step 8. Select the Define Variables category.  Modify the following variables as shown: 

Name of Plan File d17682work.dgn 

Name of Cross-Section File d17682xsmainline.dgn 

 

Step 9. Review the Redefinable Variables. 

Step 10. Select Plot Parameters.  Set the XS Lines values as shown (Weight=5) and disable all 
options in the Plot section of the dialog box. Also set the Line Text to level = 63 as in the 
previous sections. 

 

Step 11. Click Files > Save Settings then click Files > Run. 

Step 12. When processing is complete, click Exit to return to the Process Cross Sections dialog 
box. 

Step 13. Close the Proposed Cross Sections dialog box box by using the “X” on the upper right of 
the dialog box or by using the Files > Exit pulldown. 

 When prompted to Save Settings, answer Yes. 

Step 14. Use Cross Section Navigator to review the cross sections. 
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12.7   Working Alignment 
Now that we have the information for our proposed xsections, we need to update our Working 
Alignment Definition in Project Manager. 

Step 1. From the Workflow dialog box of Project Manager, click the Define button. 

Step 2. Highlight the Proposed Finish Grade option and populate the dialog box as depicted 
below.  

 

Step 3. Click OK to save your changes and exit the dialog box. 

Step 4. Exit MicroStation. 
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Port Viewer 

13.1   Introduction 
Objectives Learn how to utilize the Port Viewer. 

Project Manager Port Viewer 

Menu Bar Application None 

 

The Port Viewer is a tool that enables the user to view and manipulate all three major aspects of a 
road design simultaneously, even though they are located in different files.  The Port Viewer tool is 
only available while working within the Project Manager application. These applicable views for design 
display include: 

• Plan view layout 
• Profile 
• Cross sections 
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13.2   Accessing the Port Viewer 
Prior to starting the Port Viewer the working alignment must be set up to include the plan view 
drawing file, centerline chain, profile name and location (optional), cross-section view file(optional), 
and digital terrain model information(optional).. 

To access the Port Viewer tool, click the Port Viewer button on the Project Manager workflow dialog 
box.  Note this is the only location from which the Port View can be accessed, as there is no GEOPAK 
Road tool supported for it. 

13.3   Port Viewer Dialog Box Settings 

 

The Port Viewer dialog box box allows the user to manipulate the design views in several different 
ways. 

13.3.1   Station Settings 
The user is able to manually enter the chain station that they want to view the plan, profile or cross 
section design file.  The cross hairs in the plan and profile views will move to the active station, and 
the section view will display the cross-section nearest that station. 

13.3.2   Traverse Buttons 
The “VCR” buttons (forward and backward arrowheads) allow the user to navigate station by station 
(>,<), or to the beginning or ending station (<<,>>). 

13.3.3   Offset Control 
The Offset option will control the location of the locator circle in the plan view and the vertical cross 
hair in the cross-section and profile view. 

13.3.4   Elevation Control 
The Elevation option will control the location of the horizontal cross hairs in the profile and cross-
section views. 
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13.3.5   Active Ground Setting 

 

If the TIN file is defined in the Working Alignment definition, the DTM view can be substituted for the 
cross-section view.  The DTM view cuts a section on the fly at the location of the cross hairs in the 
plan view. 

 

13.3.6   Active View Settings 
The Active option defines the view that controls the manipulation of the other two views. 

 

13.3.7   Set Button 
Once the Active View is selected, the user can click the Set button.  This will allow the user to move 
the cursor to the Active View and move the cross hairs.  As the user moves the cursor along the 
Active View, the other two views will be updated according to the placement of the cursor in the 
Active View. 

13.3.8   DP Button 
The DP button enables the user to issue a data point for a MicroStation command.  For example, if 
the user wanted to draw a line at the given station and offset listed in the Port Viewer dialog box, they 
would select the line tool, and click the DP button.  This would begin drawing a line at the given station 
and offset. 
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13.4   Port Viewer Menu Options 

13.4.1   View 
The View pulldown from the Port Viewer menu bar allows the user to fit one or all of the views, or to 
select the Active View.   

The Fit option will fit the entire horizontal alignment when selecting Plan View, the entire profile when 
selecting Profile View, or the current cross section when selecting XS View. 

The Active option set the active design file to be the one that contains either the Plan, Profile or Cross 
Section data and reference the others.  This is useful if you need to alter a section yet you are in the 
Plan View.  Since the Cross Section file is referenced, you can not modify the section.  However if you 
make the XS View ‘active’, then the port viewer will open the Cross Section file as defined in the 
Working Alignment dialog box, and reference the Plan and Profile views. 

                 

13.4.2   Options 

The Options menu controls which cross hairs to display, as well as the 
symbology of the DTM section view. 

 

 

Group boxes are supported for Plan, Profile and XS display options.   

Three toggles are located in the Plan group box:  Station, Offset Circle, and Auto Center Window.  
When the Station toggle is activated, the pattern line is displayed on the screen.  When the Offset 
Circle toggle is activated, a circle of the size specified in the Offset Circle is placed at the Station and 
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Offset specified in the Port Viewer dialog box.  When the Auto Center Window toggle is activated, the 
Station and Offset specified in the Port viewer dialog box is centered in the Plan window. 

The Profile group box has three toggles:  Elevation, Station and Auto Center Window.  When the 
Elevation toggle is activated, a horizontal line at the Marker Display element symbology is displayed 
in the Profile View at the Elevation specified in the Port Viewer.  When the Station toggle is activated, 
a vertical line, also at the Marker Display element symbology, is displayed on the Profile view at the 
Station specified at the top of the Port Viewer dialog box.  When the Auto Center Window toggle is 
activated, the Station and Elevation specified in the Port viewer dialog box is centered in the Profile 
window. 

The XS group box has two toggles:  Elevation and Offset.  When the Elevation toggle is activated, a 
horizontal line at the Marker Display element symbology is displayed in the XS View at the Elevation 
displayed in the Port Viewer.  When the Offset toggle is activated, a vertical line, also at the Marker 
Display element symbology, is displayed in the XS view at the offset specified in the Port Viewer 
dialog box.  The XS Group box also contains parameters for the XS DTM Left and Right specified in 
terms of master units.  The XS DTM Left and Right parameters are the horizontal distances from the 
specified alignment which define the limits of the cross section or DTM display line, similar to a cross 
section pattern line.  

The Dynamic to Cursor Sensitivity determines how close the MicroStation cursor must get to the 
data point cross hairs (dynamic cursor) before they begin to follow the MicroStation cursor dynamically 
in the Set mode.  This is to prevent the cross hairs from jumping over to the MicroStation cursor until it 
is within a certain distance from them.  This distance is set as a percentage of the diagonal size of a 
given view.  When the dialog box settings are complete, clicking the Apply button automatically 
updates the screen and revises the displays. 

The Marker Display group box contains the element symbology of the marker lines. 

After the desired settings have been completed, click the Apply button in the lower right corner to 
automatically close the dialog box and apply all settings. 
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 LAB 13: Port Viewer 
Step 1.  Execute c:\data\geo\VDOT\road1\LAB13.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682des.dgn 

Access Project Manager.  It should automatically access the Road workflow dialog box since we 
“remembered” the options in Exercise 2. 

Step 3. Use the Select button to make sure that you’ve got MAINLINE selected as your Working 
Alignment. 

Step 4. Select the Port Viewer button.  
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Step 5. The Port Viewer dialog box is displayed as shown below.  

 

 

Step 6. Use the VCR buttons to scroll through the design, profile and cross sections. 

Step 7. Dismiss the Port Viewer dialog box by pushing the “x” in the upper right hand corner. 

Step 8. Exit MicroStation. 
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Earthwork 

14.1   Introduction 
Objectives Learn the procedures for calculating earthwork quantities with GEOPAK 

Learn how to use Project Manager to set up and process an earthwork run. 

Project Manager Earthwork 

Menu Bar Application None, except batch processing of an input file. 

 

GEOPAK forms graphical earthwork shapes in a (MicroStation) cross section design file to represent 
the end areas used to calculate volumes by the end-area method.  These shapes are created when 
the designer processes an earthwork run in which the existing ground, finished grade, base, etc. are 
identified by level, color, weight and type.  

14.2   Accessing 
To access the necessary dialog boxes needed to create and process an earthwork run, select Project 
Manager > Earthwork.  Once the run is chosen or selected, the following dialog box appears.  

 

The left side of the dialog box contains the list of parameters required to compute earthwork.  When 
each parameter is selected, the dialog box changes the key-in fields to reflect the selection.  For 
example, when EW Shapes is selected, the dialog box changes as illustrated below. 
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14.3   Earthwork Dialog Box 
In XS DGN File the user can specify the file name in which to find the cross-sections.  Tolerance 
specifies the maximum distances between two elements (in a cross section) to be considered as 
adjoining.  Vertical Search Distance specifies the distance above and below the cross-section to 
look for elements pertaining to that cross-section.  Baseline specifies the GEOPAK COGO chain the 
cross-sections are based from.  Begin/End Station specifies the beginning and ending stations to 
perform the earthwork calculations. 

 

As noted in section 12.1.1, it is important that the Tolerance value be set to 0.01 to 
ensure proper cross section and earthwork processing. 

 

 

The Soil Types dialog box requires the user to define the symbology and shrinkage/swell factors to 
be used.   
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The user must first select the Class of the soil type, displayed in the 
exploded view below and detailed in the table.   

 

 

 

Existing Ground Identifies the surface of the existing ground.  This classification is required to 
calculate earthwork.  It also defines the default excavation material. 

Proposed Finish Grade Surface of the proposed roadway.  This classification is required to calculate 
earthwork and defines the default fill material. 

Existing Suitable Material between excavation limits that is to be removed only when it 
encroaches on the proposed design.  For example, if the proposed design is in 
fill, therefore above the existing suitable, it is not removed. 

Existing Unsuitable Material between excavation limits that is to be removed in all circumstances. 

Proposed Undercut Proposed layers that are not part of the finish grade, i.e. pavement layers, 
shoulder layers. 

Excavation Limit Pairs of vertical lines drawn in the cross-sections to demarcate the limits of 
removal for any existing suitable or unsuitable material.  Can also be used to 
isolate earthwork computations between any pair of lines 

 
Once the Classification is chosen, a Soil Type, the element symbology of the material, and the 
shrinkage/swell factors need to be entered.  A Classification, except Existing Ground, can be listed 
multiple times.  The Soil Type determines how the cut and fill are calculated.  For example, a user 
creates an earthwork run with a classification of Existing Ground with a soil type of Existing, 
classification of Proposed Finish Grade with a soil type of Suitable_Grading, and a classification of 
Proposed Undercut with a soil type of Pavement.  The output from the run would look as follows. 

Material Name  End Areas Unadjusted  Adjusted Mult  Mass 
Station     Volumes Volumes Factor Ordinate 
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(square (cubic (cubic                    
  ft)         ft)         ft)                  

--------------------------------------------------------------------------------- 
287+00   
SUITABLE_GRADING 
Excavation     0.00     0      0  1.00 
Fill     12.32    336     336 1.00  2887 
EXISTING 
Excavation   25.88     654    654 1.00 
Fill      0.00     0      0  1.00  3541 
 

In the same example, if both classifications of Existing Ground and Proposed Finish Grade had the 
soil type of Suitable_Grading, then the output would look as follows. 

Material Name  End Areas Unadjusted  Adjusted Mult  Mass 
Station     Volumes Volumes Factor Ordinate 

(square (cubic (cubic                    
   ft)   ft)          ft)                  

--------------------------------------------------------------------------------- 
287+00 
SUITABLE_GRADING 
Excavation   25.88     654    654 1.00 
Fill    12.32     336    336 1.00  3541 

As can be seen from the above examples, when the soil types for the Existing Ground and Proposed 
Finish Grade classifications were named differently, both soil types appeared in the output.  When the 
soil types for the Existing Ground and Proposed Finish Grade classifications were named the same, 
the quantities for each classification were combined into one soil type.  By paying close attention to 
the soil types, the user can specify when material can be re-used and exactly where a specific soil 
type should be placed. 

Once the Classification and Soil Type are chosen, the user can select the Element Symbology to 
define that particular Soil Type and the Multiplication Factors for the Soil Type.  The Match button 
can be used to select the Element Symbology.  Once the Match button is selected, the user can 
select the elements in the MicroStation view.  The symbology of that element will be added to the 
symbology list used to define the Soil Type. 

EW Shapes enables the earthwork shapes to be drawn and the associated symbology.  The colors of 
the earthwork shapes can be stratified, so that cut and fill or each soil type are different. 

 

Output Format enables the user to specify any additional columns for the report in addition to what 
combination of earthwork classifications to show in the earthwork report.  Users also can control the 
number of decimal places for end area calculations.  Calc Only Between Exc. Limits instructs the 
software to calculate quantities between each pair of excavation limits as defined in the soil types 
category. 
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With this command, any combination of the three classifications of excavation volumes can be 
formulated.  For example, if the user desires to combine all three into an earthwork listing of simply 
cut and fill, press the < or > arrows until the desired option is displayed.  Options include: 

? Common Exc, Subgrade Exc, Subsoil Exc, and Fill 
? Excavation (Common and Subgrade), Subsoil Exc, and Fill 
? Excavation (Common and Subsoil), Subgrade Exc, and Fill 
? Excavation (Subgrade and Subsoil), Common Exc, and Fill 
? Excavation (all types) and Fill 

Add/Sub Volumes allows the user to enter volumes to be added or subtracted from the total 
earthwork calculated from the available sections. The user can specify whether to add excavation or 
fill, the soil type, the station, and the volume to be added. 

 

Skip Areas enable the user to specify an area  in which to not calculate earthwork volumes. 
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Sheet Quantities allows a user to write an earthwork quantity file to be used when plotting the cross-
section sheets.  The name of the ASCII file can be chosen or entered.  The user then selects the 
columns in which to place the quantity, the number of decimal places, the total column width, the soil 
type, the earthwork operation, and the type of quantity.  This information is written to the ASCII file, 
and can be used to plot the quantities on the cross-section sheets.   

 

From the Files menu, the Run option processes all parameters that have been set in the Earthwork 
dialog box.  The Save Settings option saves all information in the Earthwork dialog box to the 
current run.  The Export option saves the parameters in the Earthwork dialog box box as an ASCII 
input file.  The Exit option exits the Earthwork dialog box. 

 

After all necessary information has been entered, the user has two options.  The preferred method of 
running the earthwork is to select the Run option.  The following dialog box appears and the user may 
proceed by entering a log file name, choosing the Pause On Each Section option and then selecting 
the Apply button.  The second method is to export the information as an ASCII input file, then use the 
Process Cross Sections tool. 

 

The earthwork quantities are written to the bottom of the log file and can be reviewed in any standard 
ASCII text editor.  Therefore it is recommended that the user create a log file of a user selected name 
for printing or reviewing at a later time. 
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LAB 14:   Earthwork 

14.1   Basic Earthwork Computations 
Step 1. Execute C:\data\geo\VDOT\road1\LAB14.EXE. 

Step 2. Open the MicroStation file:  c:\data\geo\VDOT\road1\d17682xsmainline.dgn. 

Step 3. Access Project Manager. It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

Step 4. Click Earthwork from the Project Manager dialog box and create a new run named ML.  
Open the new run. 

 

Step 5. Populate the XS DGN File section of the dialog box as shown below: 
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Step 6. In the Soil Types section of the dialog box, create the following classifications and soil 
types utilizing the parameters detailed in the table below.   

 

 

Class Soil Type Search Criteria 

Existing Ground Earth Working Alignment Definition 

Proposed Finish Grade Earth Working Alignment Definition 

Existing Unsuitable RootMat_Cut LV=29, WT=8, LC=0, CO=3, TYPE=Line 

Existing Unsuitable RootMat_Fill LV=29, WT=8, LC=0, CO=7, TYPE=Line 

Excavation Limit None LV=25, WT=0, LC=0, CO=55, TYPE=Line 

 

 You can manually define the symbologies using the settings in the Search Criteria portion 
of the dialog box. When using these settings, there are also three additional buttons to 
help you. 

Match Prompts you to identify an element. Once you do, it will fill in the symbology       
settings with the symbology of the identified element. 

Display/Undisplay  Highlights all elements in the design file matching the set symbology. 

Reset  Clears all symbology settings. 
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Step 7. In the EW Shapes section of the dialog box, toggle on Draw Earthwork Shapes and 
Stratify Shape Color.  Populate the dialog box with the parameters as shown below. 

 

Step 8. Change the Output Format as shown below.  

 

 NOTE: Use the arrows (< or >) to change the format to Excavation and Fill. 

Step 9. In the Sheet Quantities section, toggle on the Write Sheet Quantities File.  Name the file 
temp.txt.  Add the following columns to the file with Decimal Places = 0 and Total Quantity 
Length = 10: 

Col. Soil Type EW Operation Quantity Type +/- 

1 Earth Common Exc End Area + 

1 RootMat_Cut Common Exc End Area + 

1 RootMat_Fill Common Exc. End Area + 

2 Earth Fill End Area + 
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Step 10. Using the Files > Run pulldown, run the earthwork for the proposed cross sections.  
Place your output into a log file as shown in the dialog box below and Pause on Each 
Section. 

 

Step 11. Review the file earth.log using the GEOPAK editor. 

Step 12. Exit the Earthwork dialog box and save your run. 

Step 13. Review your cross sections using XS Navigator. Notice that GEOPAK has placed shapes 
onto your cross sections representative of the calculated earthwork areas.  These shape 
areas can be measured to verify earthwork areas if desired. 

14.2   Modify The Earthwork Text File 
Step 1. Open Design and Computation Manager.  Double click item Location & Design>Special 

Applications>EW Labels. 

Step 2. Populate the dialog box as show below.  Click OK. 
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Step 3. Review the file earth.txt using the GEOPAK editor.  C- should be added to all quantities 
in Column 1 and F- should be added to all quantities in Column 2. 

Step 4. Exit MicroStation. 
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Cross Section Sheets 
15.1   Introduction 
Objectives Learn the procedures for laying out cross section sheets. 

Project Manager Cross Section Sheets 

Menu Bar Application None, except batch processing of an input file. 

 

GEOPAK 2001MR 

To access the necessary dialog boxes needed to process the cross section sheet layout, select 
Project Manager > Cross Section Sheets.  Once the run is chosen, the dialog box shown below 
appears.   

 

15.2   Cross Section Sheets Dialog Box 
The left side of the dialog box contains the list of parameters required to define the geometry of the 
cross section sheets and its contents.  When each parameter is selected, the dialog box changes as 
do the key-in fields to reflect the selected parameter. 

Cross Section Sheets    15-1 
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Sheet Dimensions – The Sheet Height and Sheet Width define the size of the sheet. The Sheet 
Space defines the spacing between sheets. 

 

XS DGN – Tells the software where to locate the cross sections. The Chain and stationing will be 
filled out automatically if defined via the project manager. By default, the software will find all 
elements within the confines of the cross section cell. If you need to look farther than that (i.e. outside 
of the cell), you can set these values to extend beyond the cell limits. 
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XS Elements – Indicates the search criteria (symbology) for the data to be used as input to the sheet 
layout software. 

 

Left Hand Offset – Defines the distance from the left-hand edge of the sheet to the zero offset 
position (i.e. baseline) of the cross sections. 

 

Horiz Clear Zone – defines the clipping limits from the left hand edge of the sheet.  To the left of the 
Clip Lt remains clear space and to the right of the Clip Rt remains clear space. 
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Vert Clear Zone – defines all minimum spacing requirements as well as the maximum allowable 
vertical size of any cross section. 

 

Offset Labels – allows you to define your offset label positions, increments and plot parameters. 
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Elevation Labels – allows you to control the elevation label locations, increment and plot 
parameters. 

 

Station Labels – allows you to control the station label locations and plot parameters. 

 
Sheet Stack Orientation – determines whether you want the sheets to be stacked vertically or 
horizontally. Also allows you to set the maximum number of sheets you want placed per file. 
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Sheet Stack Single/Double – determines whether you want a single stack or a double stack of cross 
sections per sheet. If you select double, you can give an offset value which is the distance of the 
second stack from the left hand edge of the sheet. 

 

Earthwork Quantities – the user can define the ASCII file that contains the earthwork quantity 
information, as well as toggle on/off the plotting of the earthwork quantities.  This will use the 
information gathered during the earthwork run to place the quantities onto the cross section sheet. 
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Sheet DGN File - specifies which file the cross section sheets will be placed in. Also allows you to set 
the horizontal and vertical scale at which they are to be laid out and the coordinate location in the dgn 
file at which the sheets will be placed. 

 

Add Top Elevation - Activating this toggle adds another elevation label above the current labels 
placed within the elevation labels parameters.  If two sets of elevations labels are placed (one on 
each side of the section), the top elevation is added to both. 

Add Bottom Elevation - Activating this toggle adds another elevation label below the single label 
placed within the elevation labels parameters.  If two sets of elevations labels are placed (one on 
each side of the section), the bottom elevation is added to both. 
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15.3   Generating Sheets 
From the Files menu, the Run option will process all parameters that have been set 
in the Cross Section Sheets dialog box.  The Save Settings option will save all 
information in the Cross Sections Sheets dialog box.  The Export option will allow 
the user to save the parameters in the Cross Section Sheets dialog box as an 
ASCII input file.  The Exit option will exit the Cross Sections Sheets dialog box.  

Once the dialog box is complete, the user can select File > Run and the following dialog box will 
appear. 

 

The user can display the results to the screen only, or write them to a log file.  Once the Apply button 
is selected, the cross sections will be plotted in sheet format. 
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LAB 15:   Cross Section Sheets 
15.1   Cross Section Sheet Layout 

Step 1.  Execute C:\data\geo\VDOT\road1\LAB15.EXE. 

Step 2. Open the MicroStation file c:\data\geo\VDOT\road1\d17682xsheet.dgn 

Access Project Manager.  It should automatically access the Road workflow dialog box 
since we “remembered” the options in Exercise 2. 

Step 3. Select the Cross Section Sheets button from the Road Project: 17682.prj workflow 
dialog box. 

Step 4. Create a new run called ML. 

Step 5. Fill in the Sheet Dimensions as shown. 

 

Step 6. Make sure that the XS DGN portion is filled out correctly. 
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Step 7. Using the XS Elements item, enable the toggle for Levels. 

 Access the Level Mask dialog box using the Select button and set the levels as shown: 

      

Step 8. Fill out the Left Hand Offset as shown. 

 

Step 9. Set the Horizontal Clear Zone as shown. 
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Step 10. Set the Vertical Clear Zone as shown. 

 

Step 11. Set the Offset Labels as shown, using the Define button to set the text Plot Parameters 
(wt=4). 

     

Step 12. Set the Elevation Labels as shown, using the Define button to set the text Plot 
Parameters (wt=4). 
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Step 13. Set the Station Labels as shown, using the Define button to set the text Plot Parameters 
(wt=4). 

     

Step 14. Set the Sheet Stack Orientation to Vertical with the Max Number of Sheets (per stack) 
set to 10.  

 

Step 15. Set the Sheet Stack Single/Double to Single Stack. 
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Step 16. Set up the Earthwork Quantities as shown (wt=5). 

 

Step 17. Set up the Sheet DGN File section as shown. 

 

Step 18. Process the cross sections onto the sheets using the File > Run pulldown.  Create a log 
file called xssheets.log. 

Step 19. Exit Cross Section Sheets dialog box and save your run.  Review the results. 
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15.2   Cross Section Sheet Numbering 
Step 1. Zoom in on the lower right corner of the lower left sheet to see the title block more 

clearly. 

Step 2.  Open Design and Computation Manager.  Double click item Location & Design>Special 
Applications>XS Sheet Number. 

Step 3. Populate the dialog box as show below.  Note that your Total Sheets may be different.  
The Begin Station Prefix is followed by a space, and the End Station Prefix has a 
space at the beginning and end.  Click OK. 

 

Step 4. Use the File button to select the xssheets.log file created previously then push OK. 

 

Step 5. Snap to the existing text in the Sheet Number box when the prompt below appears. 
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Step 6. Snap to the existing text in the Project Number box when the prompt below appears. 

 

Step 7. Place a data point at any location you desire when the prompt below appears.  This will 
be Right Justified. 

 

Step 8. Place a data point at any location you desire when the prompt below appears.  This will 
be Left Justified. 

 

Step 9. Push OK when the prompt below appears. 

 

NOTE: The Sheet number, Project Number, From Station and To Station text strings are in their own 
graphic groups.  If necessary, each can be relocated on all sheets by turning on the Graphic Group 
Lock and using the MicroStation Move element command. 

Step 10. Exit MicroStation. 
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XS Reports & Limits of Construction 
16.1   XS Reports 

GEOPAK 2001MR 

Objectives Create various cross section reports:  
 - for plan use (design elements and quantities) 
 - as input for other programs and/or applications of GEOPAK 
 - for construction layouts. 
Create and draw construction limits in the plan view file. 

Project Manager Reports and XS Quantities 
Limits of Construction 

Tools 

            

Menu Bar Application GEOPAK Road > Cross Sections > Cross Section Reports 
GEOPAK Road > Cross Sections > Construction Limits 

 

The GEOPAK Cross Section Report Utility can extract up to sixteen 
different reports from original and design cross-sections.  For each report 
generated, the user must set the parameters of the existing and/or design 
cross sections.  GEOPAK also provides an option to make custom 
headers for each of the reports via the User pull down menu. 

16.1.1   Custom Header 

 

From the XS Report dialog box, select User > Preferences.  A Report 
Header dialog box will appear with all options ghosted out.  To activate the 
individual fields simply toggle on the box next to the desired field.  Once 
you have completed the dialog box, the information will be saved as an 
.hdr file.  This allows for the creation of a separate header for each type of 
report.  The tolerance field determines the maximum gap allowed between 
cross section elements.   
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16.1.2   Blue and Red Top 
Based on the dialog box settings, GEOPAK determines the offset and elevation of a slope and its 
breakpoints.  Blue refers to the top of pavement and Red is the top of subgrade.  The user must 
determine this by indicating text and level, color, weight and style for each surface. 

16.1.3   Clearing 
The Clearing Report is useful for obtaining clearing and grubbing quantities.  For each station, 
GEOPAK will list the clearing distance on each side of the chain and the width of any exception.  You 
can obtain the results in the appropriate units.  Toggle boxes for Cut Slope Rounding, Additional 
Clearing in Cut and Fill, and Minimum Clearing Width are provided for increased control over the 
output. 

GEOPAK can also generate quantity sub-totals based on the value specified in Sub Every. 

To use the Except Width option, you must have an existing ASCII file that includes the Beginning 
and Ending Station and Exception Width. 

Once everything is set, you can output the information to an ASCII file 

16.1.4   Closure 
The Closure Report provides information on the intersection point between the user defined 
proposed finish grade and existing ground.  In addition to the ASCII report, the designer may instruct 
GEOPAK to close any gap either by drawing a vertical line between the endpoint of the proposed 
finish element and the existing ground or extending the slope of the last proposed element to 
intersect existing ground.  The procedure will not extend existing ground.  The Closure Report can 
be accessed within any MicroStation cross section file by selecting Closure from the main XS 
Reports dialog box. 

16.1.5   DTM Input 
This process generates XYZ coordinates from cross section elements and places this information into 
an ASCII file for use by the DTM portion of GEOPAK.  To use this dialog box simply enter the .gpk job 
number, chain name and station range.  GEOPAK will read the cross section elements based on 
level, weight, color and style. 
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16.1.6   DTM Proposed 3D 
This report is similar to DTM Input except that you can set both original and proposed cross sections 
at the same time.  This report also differs in that it makes break lines across the cross sections.   

16.1.7   HEC – 2 
This process reads cross section elements and formats the information in an ASCII text file suitable 
for use in the HEC-2 hydraulic program. 

16.1.8   HEC RAS 
This process reads cross section elements and formats the information in an ASCII text file suitable 
for use in the HEC RAS hydraulic program. 

16.1.9   Multi-Line 
This report is useful in creating cross-sections for staged construction.  Begin by entering the job 
number, chain name and station limits.  Primary cross section element parameters must be 
completed before secondary element parameters.  This is important due to the order in which 
GEOPAK reads the information.  Once all the parameters have been entered, the new cross sections 
may be drawn to the design file or you may choose the display only option.  An ASCII text file will be 
generated. 

16.1.10   Profile Grade 
The Profile Grade Report is one of the most versatile reports available.  It prints existing ground and 
design grade elevations and low point elevations for each cross section.  Additionally, this report has 
the ability to search either for the low points or any text string that you specify and create horizontal 
and vertical alignments and store them directly into the .gpk.  Horizontal alignments created from this 
report will have no curves. 

16.1.11   Radial Staking 
The Radial Staking Report is a specialized report created for the U.S. Federal Highway 
Administration (FHWA). 

 16.1.12   RT 40 
The RT 40 Report produces RDS based RT40 data.  To use this dialog box simply fill in the job chain 
name, stationing range and the parameters of the cross section elements you wish to use. 

16.1.13   Seeding 
Other than the usual entries, the user must enter the parameters of the elements to be seeded. 

This dialog box includes slope and subtotal options as well as a way to limit the number of segments 
read (By-Pass Segments).  The user may also establish additional seeding specifications 
(Additional Distance). 
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Once all of the settings are complete, the report will produce seed or sod quantities written to an 
ASCII output file for use in plan quantities.  

16.1.14   Slope Stake 
The Slope Stake Report is a special format report developed for the FHWA.  This report generates 
offsets, elevations and superelevation information for each cross section.  To generate this report fill 
in the usual cross section parameters plus Subgrade and Hub Staking information. When complete, 
push Apply and the report is written into an ASCII file. 

 16.1.15   Staking Detail 
The Staking Detail Report determines the tie down point between the proposed finished grade and 
the existing ground.  GEOPAK will list the right and left offset, elevation, and slope of the finish grade 
and superelevation rate for each cross section.  To create this report, fill in the project information and 
desired cross section elements’ parameters.  Once complete, you have the choice between two 
formats, a FHWA ASCII report or a Montana DOT report (includes ditch elevations). 

16.1.16   WSPRO 
This report takes the cross section elements and turns them into an ASCII file for use as input in the 
WSPRO hydraulic analysis program. 

 16.1.17   XS List 
This report creates a listing of elevations and offsets for each cross section element according to user 
defined parameters.  You have the option of creating either an original cross section list or a design 
cross section list.  These reports are very similar to RDS cross section lists. 
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16.2   Limits of Construction 
Project Manager Limits of Construction.  Note a run must be created. 

Tools 

                      

Menu Bar Application GEOPAK Road > Cross Sections > Cross Section Reports 
GEOPAK Road > Cross Sections > Construction Limits 

 

When the Limits of Construction dialog box in invoked, 
the Limits of Construction dialog box opens.  

The user must specify the Job number, the chain name, and 
the file containing the plan view information.  The Existing 
Ground and the Proposed Finish Grade sections should 
be filled by the run if Project Manager is utilized.   

The Parameters button opens the dialog box below.  The 
symbology for the cut, fill, and transition construction limits 
can be set in this dialog box.  

 

 

The Place Construction Limit toggle allows the user to place various text strings along the 
construction limits.  Selecting the Parameters button, and making the desired changes in the dialog 
box shown on the next page will set the symbology for these text strings. 
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The Radius of Display field is the size of the display circle when GEOPAK is scanning the cross-
sections. 

The last option in the main Limits of Construction dialog box is the Tie Down Option.  There are 
two Tie Down Options.  If the All Tie Down option is set, all tie downs within a section are plotted.  
(I.e. wide medians, outer roadways, ramps, etc. may have tie downs in between the limits of the main 
roadway, and the outer roadway or ramp.)  If the Outer Tie Down option is selected, then only the 
outmost tie downs are plotted.   

 

Once the Apply button is clicked, the limits of construction and the optional text are drawn into the 
plan view file at the specified symbology. 
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LAB 16:   Cross Section Reports,Driveway Profiles, and 
Limits of Construction 

16.1   Cross Section Reports 
Step 1. Execute C:\data\geo\VDOT\road1\LAB16.EXE. 

Step 2. Open c:\data\geo\vdot\road1\d17682xsmainline.dgn. 

Step 3. Access Project Manager. 

Step 4. Select Reports and XS Quantities. 

Step 5. From the XS Reports dialog box, select the User > Preferences 
dialog box. 

 

 Set the tolerance to .01. 

 Dismiss the Report Header dialog box. 

Step 6. From the XS Reports dialog box, select the Profile Grade report. 

 

We are going to use this report to create a Chain and Profile along our left edge of shoulder. We’ll 
use this information later to help in the creation of our driveway profiles. 
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Step 7. Fill out the Profile Grade dialog box as shown and click Apply.  To add the Text Search 
information to the collection box, push the ADD button.  (Store Text:  EOSLOUT) 

 

Step 8. After processing is complete, dismiss the dialog box. 

Step 9. Access COGO. 

Step 10. Access COGO Navigator using the icon  

  or use the Tools > Navigator pulldown. 
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Step 11. Use the Chain option to see a list of the stored chains. 
Notice EOSL has been stored. 

 

 

Step 12. Use the Profile option to see a list of the stored 
profiles. Notice EOSL has been stored 

Step 13. Exit COGO. 

 

Step 14. From the XS Reports dialog box, select the DTM 
Input report. 

We’ll use this report to create a proposed model (dtm) from our 
cross sections. We’ll also use this information later in the creation 
of our driveway profiles. 

Step 15. Fill out the DTM Input dialog box as shown and click 
Apply. 

 

 

 

Note: The levels for XS Elements should only refer to 2-4. These are the levels that 
make up the top of Finish Grade. 

Note that in Step 15 we only created a .dat file. This is an ascii file that is used to create 
the DTM. We’ll create the dtm in the next section. 

 
Step 16. After processing is complete, dismiss the DTM Input dialog box. 
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Step 17. Also dismiss the XS Reports dialog box. 

16.2   Driveway Profiles 
Step 1. Before beginning the process to create the driveway profiles, we’ll need to create the 

proposed DTM.  

 Select the Existing Ground button from the Road Project: 17682.prj workflow dialog 
box. 

Step 2. Select the previously created run ‘ground1’ and press OK. 

Step 3. Select the Build Triangles icon from the DTM Tool Palette. 

 

Step 4. Fill out the Build Triangles dialog box as shown and click Process. 

 

Step 5. Dismiss the Build Triangles dialog box.  When prompted to save settings, push Yes.   
Dismiss the DTM Tool Palette. 

Step 6. Open the Microstation design file c:\data\geo\vdot\road1\d17682work.dgn.  

 Note that pattern lines have been placed at the driveway locations. These pattern lines 
have the following symbology: LV=51, CO=2, WT=2. 

Step 7. Open the Microstation design file c:\data\geo\vdot\road1\d17682driveways.dgn. 

Step 8. Select the Existing Ground Cross Sections button from the Road Project: 17682.prj 
workflow dialog box. 

 Create a new run ‘driveway’ and click OK. 
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Step 9. Fill out the dialog boxes as shown and click Draw. 

   

 

 

Proposed Surface Symbology (lv = 1, co=4, wt=3, lc=0) 

Existing Surface Symbology (lv=1, co=1, wt=5, lc=2) 

 

Step 10. Dismiss the Draw Cross Sections dialog box and Save Settings. 

 

Review the ground lines drawn. Notice that the proposed ground line may not terminate 
precisely on the existing ground. This is because elevations are being interpolated 
between proposed cross sections. 

You can tie this down manually or you can use the XS Reports > Closure Report. 

 

Step 11. Select the Proposed Cross Sections button from the Road Project: 17682.prj workflow 
dialog box. 

 Create a new run ‘driveway’ and click OK. 
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Step 12. Fill out the XS DGN File category as shown: 

 

Step 13. Fill out the Pattern category as shown: 

      

Step 14. Fill out the Existing Ground category as shown: 
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Step 15. Fill out the Shapes category as shown: 

 

Step 16. Under the Shape Clusters category, add the Mainline chain and profile to the list box as 
was done in previous exercises. 

 

Step 17. Press the Typical button to access the Typical Section Generator.  

 Select the Typical ENTR and press Apply. 
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NOTE:  Press the Description button and review the documentation. 

Step 18. Your dialog box should fill out automatically and look like the following: 

 

Step 19. Select the Define Variables category.  Modify the following variables as shown: 

Name of Plan File d17682work.dgn 
Name of Cross-Section File d17682driveways.dgn 
Lt Ent Take-Off Align Name EOSL 

16-14    VDOT Road I Training GEOPAK 2001MR 



___________________________________________________________GEOPAK® 

Step 20. Select the Plot Parameters category and fill out as shown. Don’t forget to set the Line 
Text level to 63 as in previous exercises. 

 

Step 21. Process the cross sections. When complete, Exit the run but don’t forget to Save Settings. 

Step 22.  Review the Driveway Profiles using XS Navigator. 
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16.3   Plan View Limits of Construction 
Step 1. Open the Microstation design file c:\data\geo\vdot\road1\d17682xsmainline.dgn. 

Step 2. From the Road workflow dialog box, select Limits of Construction.  Create a run called 
Mainline. 

Step 3. Populate the Limits of Construction dialog box as shown: 

      

Step 4. Click the Parameters button to open the Plot Parameters dialog box. Populate as shown: 

 

 Note: Cut Line Style = 5;Fill Line Style = 3;Transition Line Style = 4 

Step 5. Click OK to close the Plot Parameters dialog box.   

Step 6. Click Apply to process the Limits of Construction. 

16-16    VDOT Road I Training GEOPAK 2001MR 



___________________________________________________________GEOPAK® 

Step 7. Exit the Limits of Construction dialog box and Save Settings. Review the limits of 
construction in c:\data\geo\vdot\road1\d17682des.dgn. 

 

Since GEOPAK does not create the Limits of Construction exactly like VDOT would like to see them, 
we will use a special application to update them to the correct symbology. 

Step 8. From the Road workflow dialog box, select Plan View Design.  

Step 9. From the Plan View Design tool palette, select D&C Manager.   

Step 10. Navigate to the category Location & Design > Special Applications. 

Step 11.  Important!   Make sure that all of your Limits of Construction are shown in View 1. 

Step 12. Within this category, double-click on the item Update LOC. 

Step 13. At the following prompt, click OK. 

 

Step 14. Enter the Job Number as shown and click OK. 

 

Step 15. Enter the baseline name as shown and click OK. 

 

Step 16. Set the units to English as shown and press OK. 

 

 

Step 17. Set the scale as shown and click OK. 
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Step 18. Dismiss D&C Manager and review the changes made to the Limits of Construction. 

Step 19. Exit MicroStation. 
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Labeling 
17.1   Introduction 

GEOPAK 2001MR 

Objectives Learn how to label plan information with Plan View Labeler. 

Familiarize the user with the Cross Section Labeler. 

Project Manager Plan View Design 

Tools 

            

Menu Bar Application GEOPAK Road > Plans Preparation > Plan View Labeling 
GEOPAK Road > Plans Preparation > Profile Labeling 
GEOPAK Road > Cross Sections > Labeling 

17.2   Plan View Labeling 
GEOPAK’s labeling tools allow a user to place “smart” labels in a MicroStation drawing.  These labels 
have the ability to calculate XYZ coordinates, station, offset, direction, length, radius, degree of 
curvature, etc. of the associated element. When the Plan View Labeling icon is selected, the dialog 
box depicted below is displayed. 

 

The label to be placed is displayed in the box on the right side of the dialog box as shown above.  
The Space button places a space in the label at the cursor position.  The Return button starts a new 
line of text.  The Clear button starts a new label.  The Delimit button places a line above or below a 
line of text.  The Place Label button attaches the label to the cursor for placement in the drawing.   

The user can select the various tabs to define / modify the label appearance. 
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17.2.1   Text 
For data to be computed, the job number and the chain need to be selected.  If elevations are to be 
calculated, a TIN file needs to be chosen.   

The Computed Inserts are items that Geopak has the ability to calculate for the chosen item.  The 
list of Computed Inserts changes with the type of element that is chosen.  If a line is chosen, the list 
of Computed Inserts will show inserts of bearing, and length.  If a curve is chosen the list of 
Computed Inserts will change to show inserts of radius, curvature, chord length, etc. 

The User Inserts are inserts that a user may use on a regular basis.  This list can be customized for 
a specific user’s needs. 

There are several methods allowing the user to choose the element to use for calculations in the 
label.   

Select GEOPAK or 
MicroStation Element 

 

The icon to allows the user to identify either for labeling. 

Data Point Location 

  

Selects a location in the design file that may or may not be 
associated with an element. 

2 GPK Point Line  

 

Selecting lines or points that have been visualized via COGO. 

3 GPK Point Arc  

 

Selection of visualized arcs and points 
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17.2.2   Params. 

 

The Parameters tab enables the user set up the text size and symbology for the label. 

By Current sets the symbology to the current MicroStation settings.  By Element allows the user to 
set the symbology by choosing a MicroStation element.  Set All sets the symbology for all elements 
in the label (text, delimiters, leader lines, etc.).   

By Current 

 

After pressing this button, GEOPAK determines the active 
MicroStation symbology (level, weight, color and style) and 
populates the dialog. 

By Element 

 

After pressing this button, GEOPAK prompts to select a 
previously drawn MicroStation element, and populates the dialog 
with its element symbology. 

D & C Symbology 

 

Pressing this button invokes the Design and Computation 
Manager, wherein the desired item may be selected.  By double 
clicking on an Item, the associated element symbology within the 
Design and Computation Manager is applied to the Labeling 
dialog. 

Set All  

 

GEOPAK reads the current settings (level, weight, color and 
style) within the dialog, and populates the Parameter, Shape and 
Leader dialogs. 
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17.2.3   Shape 

 

The Shape tab allows the user to place a shape around the label, and set the symbology for the 
shape. 

17.2.4   Leader 

 

The Leader tab allows the user to attach a leader from the label to the point.  Different leader types 
and terminators can be chosen.  The active terminator can also be used. 
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17.2.5   Rotate 

 

The Rotate tab allows the label to be rotated.   The rotation can be determined from the current 
angle, the angle of the element, or the alignment angle.  The angle can also be set by two data points 
(first data point set the location, next data point sets the angle) or the active angle. 

17.2.6   Styles 

 

The Styles tab allows a user to choose label symbology from a library of pre-defined styles.  When 
the user chooses the style, all symbology, leaders, shapes, etc. is set up for the user. 
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17.2.7   Menus 
The Style Files menu allows the user to open a new style library.  You must be under the Styles tab 
in order to open a style library. 

 

In the Options menu, Minimize Dialog Box will minimize the dialog box when Place Label is 
chosen.  The Use Reference File Coordinates option uses the coordinates from the master plan 
view file when placing a label in a plan sheet. 

 

Options > Label Tools invokes the tool frame shown below which enables the user to modify 
Geopak labels.  

 

Options > Label Viewer brings up a dialog box that allows a user to view and place a label.  

 

The Scale > Scale Style menu allows the user to choose a plan scale.  All labels will be adjusted 
according to the plan scale.  The user simply keys in a scale, and chooses a Labeling Style.  The 
corresponding label will be placed at the correct size for the scale that was chosen.  
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17.3   Cross Section Labeling 
The Cross Section Labeling dialog box differs from the Plan View Labeling dialog box only on the 
text tab.  Cross Section Labeling works with the Cross Section Navigator.  The current Cross 
Section Navigator station is shown on the Text tab.  The Computed and User Inserts contain 
values and phrases related to cross-sections. 

 

17.4   Profile Labeling 
The Profile Labeling dialog box differs from the Plan View Labeling dialog box only on the text tab.  
The Chain and Profile must be defined, in addition to profile settings.  The Computed and User 
Inserts contain values and phrases related to profiles. 
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LAB 17:   Labeling 
17.1   Accessing the Labeler 

Step 1. Execute C:\data\geo\VDOT\road1\LAB17.EXE. 

Step 2. Open the MicroStation file c:\data\geo\vdot\road1\d17682des.dgn. 

Step 3. Access Project Manager. 

Step 4. Select the icon Plan View Design button from the Road Project: Road1.prj workflow 
dialog box. 

Step 5. From the Plan View Design tool bar, select the Plan View Labeler icon. 

 

17.2   Using Predefined Label Styles 
Step 1. Select the Styles Tab. 

Step 2. Traverse with the Item Selector box to locate the following style: 
Labels>Point Labels>StaOff.   Next, double click the StaOff style. 

 

Step 3. Move back to the Text tab and complete as defined below: 

Job No. 101 

Chain MAINLINE 

TIN File SURVEY.TIN 

In the following steps, we will use the Plan View Labeler to label the beginning and ending points for 
pavement transitions. 
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Step 4. Use the MicroStation pulldown Utilities > Saved Views to access the saved view 
“TRAN1”.  

Step 5. To create a label, select the DP button and then identify the location as shown by the “X” 
in the following image.  The labeler automatically calculates the information.  

   

X

 

 

Step 6. Use the Params., Shape, Leader and Rotation tabs to experiment with different labeling 
styles.   

Step 7. To place the label, return to the Text tab and click the Place Label button. 

 The label is now attached to your cursor (without the leader for the delimiter). 

Step 8.  Datapoint at the location you wish the text to be located. 
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Step 9. A second datapoint will define the side of the label from which the leader line will 
be drawn from the delimiter line to the computed location. 

 

 

Step 10. Repeat Steps 5-8 to label other points of the transition area. 

Step 11. Exit MicroStation. 
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Plan and Profile Sheets 

18.1   Overview of Features 
Feature / Function Drawing of plan or plan / profile sheets. 

Tool 

   

Project Manager (Road) Plan and Profile Sheets 

Menu Application GEOPAK Road > Plans Preparation > Plan and Profile Sheets 

 

The main feature of the 2001 Plus application is a simplified user interface, compared to the Classic 
application.  In this way, users can quickly and easily generate a variety of plan, plan / profile and 
tabular data sheets. 

In order to maintain compatibility with the Classic application and ease the transition for those users 
who want to utilize the 2001 Plus application, 2001 Plus supports importing .dat files utilized in the 
Classic application, and converting them to the new Port-oriented format.  Dat files were the 
equivalent of the Sheet Library in the Classic application. 

2001 Plus supports any combination of Ports on a sheet for maximum flexibility. 

2001 Plus provides powerful handling of MicroStation reference files.  This is accomplished by having 
other MicroStation files serve as patterns for the reference file attachments.  These are called motif 
files. 

2001 Plus has the option to automatically make a notch in the clipping shape at layout time to make 
room on the sheet for a title block.  This is done by putting the clipping shape pattern into the sheet 
cell. 

Extended Stationing is used as a means to allow sheets to be placed partially off of an alignment or 
even completely off of the alignment. 

2001 Plus has the ability to place sheets with a Right to Left Station progression, which is opposite of 
the standard used in roadway design.  This was added for users doing rail design. 

A thorough capability is provided to perform sheet numbering.  Alphanumeric prefixes and suffixes as 
well as changing the start number of the sheets and rearranging the ordering are all supported in 
2001 Plus. 

2001 Plus supports Profile Stair Stepping.  In situations with steep grades or narrow profile ports, 
sometimes the profile goes off the top or bottom of the port before it gets to the end of it.  To handle 
this, users would put a break in the profile port and adjust the elevations to bring the coverage up or 
down to where it needs to be.  Within 2001 Plus, GEOPAK automatically locates these breaks and 
plots the profile clipping shapes in accordance with that.  This adjustment carries through, then, to the 
sheet design file. 
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Profile Gap Equalities -- If a Profile has been plotted with the Gap option turned on, the coverage of 
the sheet is now adjusted so that subsequent sheets remain aligned with the grid. 

Raster Manager -- Descartes is not supported by the application.  Raster Files are now to be 
referenced via the Raster Manager application available via Bentley Select. 

Tabular Data Application -- Sheet Clip places Clipping Shapes suitable for Tabular Data.  However, 
the actual placement of the tabular values in the dgn file is now done via the Draw Tabular Annotation 
(Sheet Clip Mode) tool.  This approach allows the power and flexibility of the Draw Tabular Annotation 
application to be used with sheets. 

 

18.2  Invoking 2001 Plus Main Dialog Box 
When the GEOPAK User Preferences is set to 2001 Plus and Plan and Profile Sheet tool is selected, 
the GEOPAK Sheet Layout dialog box depicted below opens. 

 

The dialog box is comprised of the title bar which displays the current Sheet Library, the main menu 
bar, short-cut icons, and the Sheet Name Selector and Plot Scale fields. 

The first time the application is invoked, it opens up a default.psl sheet library located in the 
\geopak\bin\ folder if the configuration variable isn’t defined. 

The Plot Scale will be displayed in the proper units depending on how it is set in the User 
Preferences. 

18.2.1   Sheet Library 

 

The parameters for each sheet are defined in a Sheet Library.  In order to lay out or clip sheets, a 
Sheet Library must be attached to the current session.  The name of the currently attached Sheet 
Library is shown in the title bar.  Sheet Libraries have an extension of psl.  An unlimited number of 
different sheets can be stored within one library. When the user begins the sheet process, they select 
the desired sheet layout from the attached library, which loads the associated parameters. 

If a different Sheet Library is needed, it can be attached via the menu items Sheet > Library > Attach.  
It is also possible to review or make changes to the Sheet Library by selecting Sheet > Library > Edit.  
Detailed information on the set-up of the Sheet Library can be found in the online help section entitled 
"Sheet Library Set-up." 
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18.2.2   Main Menu Bar Overview 

 

Four options are supported in the main menu bar: 

? Sheet 
? Tools 
? View  
? Settings 

18.2.2.1   Sheet Menu Options 
Five tools are supported in the Sheet pulldown and are detailed in the sub-sections below. 

? Library 
? Composition 
? Layout 
? Clip 
? Exit 

18.2.2.1.1   Library 
The Library file contains the various parameters, cells, and dimensions for creating sheets.  In this 
menu option, a new Library can be created, an existing Library can be edited, or the user can define 
(Attach) the desired Library.  For a detailed discussion of setting up and editing a Library, refer to the 
online documentation "Sheet Library Set-Up." 
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18.2.2.1.2   Composition 
This menu item opens the Sheet Composition dialog box, wherein drawing area, overlapping options 
and other project specific variables are defined.  One sample dialog box is depicted below. 

 

18.2.2.1.3   Layout 
The Layout dialog box is utilized to define the GEOPAK Job Number, alignments, and / or profiles for 
the desired sheets.     

 

Fields are also supported for stationing, if only part of the chain is being utilized for sheet layout. 
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18.2.2.1.4   Clip 
Once the sheets have been laid out and any modifications complete, the sheets are ready to be 
clipped and drawn for the final production sheets.  The Clip dialog box is utilized to complete these 
tasks, as detailed below. 

 

18.2.2.1.5   Exit 
Exits the Plan and Profile Sheets application, but does not close the MicroStation file. 

18.2.2.2   Tools Options 
Four tools are supported in the Tools pulldown and are detailed in the sub-sections below. 

? Modify 
? Sheet Number Manager 
? Draw Tabular Annotation (Sheet Clip Mode) 
? Identify Sheet 
 

18.2.2.2.1   Modify 
After the sheets are laid out, the user may want to adjust individual sheets to conform to the project 
limits, etc.  This can be accomplished utilizing the tools in the Modify dialog box, which is illustrated 
below. 
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The two icons in the upper left corner are utilized to Slide sheets (along the alignment, rotating, 
offsetting) and Modify Drawing Area.  The Slide options are illustrated above, while the graphic below 
depicts the Modifying Drawing area. 

 

The user can select the sheet to be modified from the pick list or by graphic identification.  Sheets can 
also follow the movement of the selected sheet, i.e., moving one sheet to left moves all proceeding or 
following sheets to the left by the same amount. 

18.2.2.2.2   Sheet Number Manager 
After the sheets are laid out, the Sheet Number Manager can be invoked as depicted below, 
populated with the current sheets. 

 

The actual sheet number can be modified, prefix and suffix added, and other labeling options by 
utilizing the Edit Sheet Number (fourth icon down in the grouping to the right of the list box). 
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Another option is changing the order the sheets are drawn. 

18.2.2.2.3   Draw Tabular Annotation (Sheet Clip Mode) 
When the Draw Tabular Annotation tool is selected, the Draw Tabular Annotation dialog box is 
opened, as depicted below.  

 

The user can define the tabular data to be included within the plan /profile sheets.   

18.2.2.2.4   Identify Sheet 
Select Identify Sheet, then select and accept a previously placed clipping shape.  GEOPAK 
determines the settings utilized to place the original sheet and automatically populates the dialog box 
with the Sheet Name and Scale.  In addition, the Sheet Name, Scale, Sheet Number and Port are 
displayed in the MicroStation prompt field at the bottom of the screen.  If the parameters for the 
selected sheet are not found within the current library, a warning message is displayed indicating the 
sheet is not found, the name of the current library, and the name of the library used to place the 
original sheet.  
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18.2.2.3   View Menu Options 
Three tools are supported in the View pulldown and are detailed in the table below. 

Filter by Sheet 
Name 

The clipping shapes of the currently selected sheet name are displayed.  A 
MicroStation update view will need to be issued if “Automatic Update” is not 
toggled on. 

Filter by Scale The clipping shapes of the currently selected Scale are displayed.  A 
MicroStation update view will need to be issued if “Automatic Update” is not 
toggled on. 

NOTE:  “Filter By Sheet Name” and “Filter By Scale” can be used together. 

Automatic 
Update 

If this is toggled on when “Filter By Sheet Name” or “Filter By Scale” is 
selected the view is automatically updated. 

 

18.2.2.4   Settings Menu Options 
One tool is supported in the Sheet pulldown and is detailed in the table below. 

Sheet Layout 
Settings 

When the Sheet Layout Settings tool is selected, the dialog box depicted 
below opens.  Three settings are supported within the dialog box including 
Left to Right or Right to Left layout, Stair Stepping for profiles, and sheet 
view attributes. 

 
• Sheet Layout Progression: 

Left To Right (Standard) 
   Right To Left (Rail) 

• Profile Stair Stepping: 
Off 
On 

• Sheet View Attributes: 
Use Current Design File 
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Customize With Motif File 
  

18.2.3   Dialog Box Icons 
Six short-cut icons are supported for ease of use.  These icons correspond to tools located within the 
menu bar pulldowns and are detailed in the table below. 

 
Sheet Composition  (Sheet > Composition). 

 
Layout Sheets  (Sheet > Layout). 

 
Clip Sheets  (Sheet > Clip). 

 
Modify Sheets  (Tools > Modify). 

 
Sheet Number Manager  (Tools > Sheet Number Manager). 

 
ID button (Tools > Identify Sheet). 

 

18.2.4   Sheet Name Selector and Plot Scale 

 

Two parameters are global to the entire application and are shown on the main dialog box:  

? The Sheet Name Selector enables the user to select which sheet is to be placed in the next 
Layout operation.  The drop down list displays all sheets in the currently attached Sheet 
Library. 

? The Plot Scale text item determines the scale at which sheets will be placed in the 
layout.dgn. 

18.3  Primary Work Flow 
The approach taken by this application is to represent the reference-clipping boundary of each Port 
on each Sheet.  The clipping boundary is represented by MicroStation Shapes, referred to as Clipping 
Shapes. 

For each project, there is one design file which contains all of the Clipping Shapes for a project, for 
example, layout.dgn.  All design elements exist in files referenced to layout.dgn.  It is recommended 
that layout.dgn have only Clipping Shapes in it. 

The Primary Work Flow consists of two operations: 
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? Layout of sheets – places clipping shapes into layout.dgn file. 
? Clipping sheets - reads the Clipping Shapes from the Layout dgn and creates new design 

files which include all required reference files which are clipped at the correct boundaries 
along with the Sheet Cell and other annotations. 

 

There are two options for Clipping Sheets: Rotate View and Rotate Reference. 

When Sheets are clipped using the Rotate View option, the sheet cell and the view are moved and 
rotated such that they are coordinately correct with the clipping shape of Port One.  This arrangement 
allows only one sheet per design file. 

When Sheets are clipped using the Rotate Reference option, the sheet cell and view are not rotated.  
The reference files are rotated and moved to be in the correct location with respect to the sheet cell.  
The arrangement allows multiple sheets to be placed in one design file. 

18.4   Ports 
Each Sheet consists of one or more Ports.  A Port can be considered a window into the design.  For 
each sheet that is placed into a layout.dgn, each Port on that sheet is placed as a Clipping Shape. 

18.4.1   Port Types 
There are three types of Ports: Plan, Profile, and Tabular Data.  It should be noted the 2001 plus 
version of Plan and Profile Sheet Composition does not place tabular data values.  The application 
places Clipping Shapes designed to include Tabular Data.  The actual placement of the Tabular Data 
values is accomplished by the Draw Tabular Annotation (Sheet Clip Mode) tool in coordination with 
the Plan and Profile Sheet Composition application. 

18.4.2   Port Information 
Before laying out sheets, each Port must have its Port Information filled out.  The Port Information 
Dialog boxes are opened by double-clicking the corresponding row in the Layout Dialog box. 

Plan Ports only need the controlling chain, an offset value, and the name of the motif file for the given 
Port.  If the “Use Current Design File” option is selected, Current will be displayed in the dialog box 
instead of a Motif File name. 

Motif files are used to determine reference file attachment.  

Profile Ports require the name of the controlling profile in addition to all the information found in a 
profile cell. 

Tabular Data Ports require the same kind of information that Profile Ports do, but also may optionally 
have the ability to stagger the placement of the ports.  This staggering allows the Clipping Shapes to 
be longer without conflicting so that they may accommodate margin labels. 

18.5   Sheet View Attributes 
Two options are supported for Sheet View Attributes: 
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Use Current Design File – All reference file attachments, active levels, etc., are based on the current 
design file.  An optional toggle is supported to Save the Full Path of reference files.  This toggle is 
only for the design file that contains the clipping shapes. 

Customize with Motif Files - A blank file is utilized as a pattern file for the reference file 
attachments.  Also levels can be turned on or off as desired.  We call these files motif files.   

18.5.1   Use Current Design File 
The user can control reference file attachment without the use of Motif Files by selecting the Use 
Current option for Sheet View Attributes.  When this option is used, the Current dgn file (in which 
clipping shapes have been layed out) is used like a Motif file in that it’s reference file attachment 
information carries over to each Port during Clipping. 

Also the design file containing the clipping shapes will be attached as a reference file for each port to 
accommodate users that wish to place there clipping shapes in the proposed design file. 

The advantage of Use Current Design File is that the user does not need to concern themselves with 
setting up motif files.  What they see in the layout design file is what they will get in clipped sheet files.  
However, when Use Current Design File is that selected option, it is not possible to have different 
reference file settings for different Ports on the same sheet.  All Ports must have the same 
attachment information and can’t be customized. 

The Save Full Path toggle is used when the sheets will be placed in a different directory than the 
reference files. 

NOTE:  If the sheets are to be placed in a different directory, then the reference files must be 
attached to the current design file with “Save Full Path” toggled on. 
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18.5.2   Customize With Motif Files 
It is sometimes necessary to have two or more Ports on a sheet which have differing reference file 
attachment settings.  This could happen with two Plan Ports which cover the same area but show 
different aspects of the project.  For example, the top Port would show the proposed design and the 
bottom Port would show traffic control.  This could be considered as the two Ports on the same sheet 
having different themes or different motifs. 

The question arises as to how the various reference file settings are to be controlled for each Port.  
This is done by using another design file to serve as a pattern for the reference file attachment 
information.  For every Port, there would be a motif file specified by its file name.  The Ports on each 
sheet may have the same or different Motif Files. 

During a Clip operation, the reference file attachment information is read from the motif file for each 
Port.  When a Port is placed into the final sheet file, all reference files which are attached to the 
corresponding Motif File are attached to the final sheet design file.  All reference level view on/off 
settings of the motif file are also applied to the reference file attachment in the final sheet design file.  
Note the clipping shapes are still used to define the Clip Boundary of each reference file associated 
with that Port. 

In the example described above of a sheet with Design and Traffic Control, the top Port could have a 
Motif File named design_motif.dgn.  The bottom Port could have a Motif File named Traffic_motif.dgn.  
At any time before sheets are clipped, the Motif Files (which would normally be blank) must be 
opened, desired levels should be active, and the reference files attached.  The reference file names 
and their paths used for the motif file must match exactly to the reference files and associated paths 
in the original file.  Therefore, the user will normally set up the motif files on a project by project basis, 
unless an organization has a standardized set of file naming conventions and level structure utilized 
on every project, where a single set can be developed for the entire organization. 

NOTE:  If the sheets are to be placed in a different directory, then the reference files must be 
attached to the motif file with “Save Full Path” toggled on.   
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18.6   Sheet Composition 
When the Sheet Composition tool is accessed, the dialog box depicted below opens. 
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The graphic illustrates the various values required in the dialog box.  Directly below, four options are 
supported, as illustrated in the exploded view above: 

? By Begin Station/Overlap 
? By Station Range:  Inside Out 
? By Station Range:  Outside In 
? By Station Range:  Radial 

 

18.6.1   By Begin Station/Overlap Option 
When the By Begin Station/Overlap option is selected, the Clip group box containing the Drawing 
parameters, Overlap options and associated fields as depicted in the graphic below: 
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Before these options are reviewed, a discussion of the Active Drawing Area, located within the Clip 
group box, is warranted.  Several dimensions are found within the Clip group box.  These include: 

? Maximum Drawing Area (display only) 
? Horizontal 
? Drawing Shown 
? Vertical 
? Active Drawing Area (display only, calculated by GEOPAK) 
 

The graphic below illustrates each dimension for the subject sheet.  In addition, a portion of the 
adjoining sheet to the left is shown in order to depict the overlap.  Notice that the alignment is also 
displayed from approximately station 289+00 to 292+00. 

 

First, GEOPAK utilizes the Maximum Drawing Area based on the Sheet Name and Scale selected in 
the main Sheet Layout dialog box, in our example, 400.00 x 176.75.  Then the Clip Vertical is 
subtracted twice, once for the top and once for the bottom.  In this case,  
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   176.75 - 10 - 10 = 156.75 

which is shown in the Active Drawing Area.  The same method is utilized for the Horizontal 
computations.  The horizontal clip is subtracted twice, once for the right side and once for the left 
side.  In this case,  

   400.00 - 10 - 10 = 380.00 

which is shown in the Drawing Shown and the Active Drawing Area. 

 

Once again referring to the graphic above, GEOPAK considers the Overlap shown on the left side 
between the two adjoining sheets.  The Overlap toggle has two options as depicted in the exploded 
view below: 

 

? Percentage 
? Fixed Distance 

When the Percent option is selected, the designer keys in the desired overlap in percent format in the 
Overlap field.  Note the percent sign (%) is not required.  The Percentage is calculated utilizing the 
Drawing Shown value.  In this example, the 5.26% overlap is 156.75 feet (5.26% of 176.75). 

In our Percentage example, the overlap is 5.26%.  Therefore, a 20.00 foot overlap in clip areas is 
present between successive sheets. 

If the Fixed Distance option is utilized, the Value field is in master units, i.e. feet or meters.   
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When placing sheets on a curve, the chord of the curve where it intersects the inside border is utilized 
to orient the sheet as depicted in the graphic below: 

 

Since the By Begin Station/Overlap Sheet Composition option uses a chord distance to compute 
the length of the sheet, in the area of a curve more stationing will be covered.  On a Plan/Profile 
sheet, this means there will be unequal coverage between the Plan and Profile.  With this in mind, it is 
recommended that By Begin Station/Overlap Sheet Composition option be used for a Plan only 
case. 

18.6.2   By Station Range  Inside Out Option 
The By Station Range:  Inside Out option orients sheets between a rounded station interval.  This 
interval is entered in the Station Range field.  When utilizing this option, the Clip group box also has 
a slightly different look as seen in the graphic depicted below. 

 

Now the Active Drawing Area is not constant, but displays Variable in the output field.   
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The Horizontal keyin has a slightly different meaning which can be best illustrated with an example.  
Let's use 500 feet for the Station Range, and 15 feet Horizontal.  The dialog box is depicted below. 

 

Utilizing the dialog box above, the following sheets are generated. 

 

The first step when the sheets are drawn is to determine the stationing for each sheet.  Our first sheet 
will be oriented between stations 115+00 to 120+00. GEOPAK then expands the sheet clip area by 
the Horizontal keyin distance.  Looking at a detail of the beginning of the project, the clip area is 
expanded fifteen feet before station 115+00 as seen in the graphic below.  Note the inside border is 
the dashed line, and station 115+00 and its associated tick mark are shown. 

 

The curve is calculated slightly different.  The second sheet in this series is on a curve.  The station 
range is 120+00 to 125+00.  A chord is drawn for the curve between stations 120+00 and 125+00 as 
seen in the graphic below. 
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Notice that the inside sheet border is wider than the chord.  The software will extend the chord the 
amount of the Horizontal keyin (in our example, fifteen feet) to establish the vertical edge of the inside 
border as seen in the detail below. 

 

18.6.3   By Station Range  Outside In Option 
The By Station Range:  Outside In option orients sheets between a rounded station interval.  This 
interval is entered in the Station Range field.  When utilizing this option, the Clip group box also has 
a slightly different look as seen in the graphic depicted below. 

The Outside In option is slightly different as seen in the dialog box below. 

 

The Clip Area is no longer variable, but a constant based on the Sheet Size as well as the 
Horizontal and Vertical fields.  In our example, the same 500 feet is keyed in.  When generating the 
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sheets, GEOPAK determines the center of the sheet, and the corresponding station.  In our example 
the midpoint of the stationing for the sheet from 120+00 to 125+00 is 122+50.  This point will be 
placed at the midpoint of the sheet as depicted in the drawing below: 

 

Since the clip area covers a constant station range, the length of the clipping shape will vary 
depending on the curvature of the alignment. 

18.6.4   By Station Radial Option 
The By Station Range:  Radial option orients sheets between a rounded station interval.  This 
interval is entered in the Station Range field.  An example best describes how this feature works.  In 
the dialog box below, each sheet has a station range of 500 feet.  Based on the station ranges in the 
bottom of the dialog box, the first sheet would encompass station 120+00 to 125+00, while the 
second sheet would include stations 125+00 to 130+00. 

 

To draw this second sheet, GEOPAK locates the midpoint station 122+50, which in our example is on 
a curve.  Utilizing the chord of curve as the vertical center, GEOPAK draws the top and bottom of the 
clip regions 217.5 feet from the chord, making the clip region 435 feet high.  This is computed from 
the sheet size of 475 minus the vertical keyin of 20 for the top and 20 for the bottom, resulting in a 
435 feet height. 

In the next step, GEOPAK moves to station 125+00 and draws the clip border radial to the alignment 
at the specified station until it intersects with the previously computed top and bottom clip regions.  
The same process is repeated at the other end of the sheet, i.e., 130+00.  Therefore, the inside clip 
region is trapezoidal as depicted in the graphic below. 



___________________________________________________________GEOPAK® 

GEOPAK 2001MR     18-21 

 

Since the clip area covers a constant station range, the length of the clipping shape will vary 
depending on the curvature of the alignment. 

 

Note:  Any time sheets are deleted from the file using MicroStation commands, the file 
must be compressed before laying out the sheets again. 
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LAB 18:   Plan and Profile Sheets 

18.1   Getting Started 
Step 1. Execute C:\data\geo\VDOT\road1\LAB18.EXE. 

Step 2. Open the Microstation file c:\data\geo\VDOT\road1\d17682work.dgn.   

 Access Project Manager. 

18.2   Plan Sheet Layout Process 
Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 

dialog box. 

Step 2. Create a run named Plan to set up the plan sheets. Initially, the dialog box will appear 
similar to the one shown below. 

 

Step 3. Select Settings>Sheet Layout.  Change “Sheet View Attributes” option to Customize 
with Motif Files then click OK.  The completed dialog box is shown below. 

 

Step 4. On the GEOPAK Sheet Layout dialog box, select PLAN from the sheet list then set the 
scale to 25.0000 ft/in.  The GEOPAK Sheet Layout dialog box should appear as below. 
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Step 5. Press the Sheet Composition icon.  Populate the Sheet Composition dialog box as 
below. 

 

 

Note:  The Vertical setting will trim off the top and bottom of the clipping shape so that 
plan data will not be placed inside the title blocks on the sheet. 

 

Step 6. Dismiss the Sheet Composition dialog box by pressing the X in the upper right hand 
corner. 

Step 7. Press the Layout Sheets icon.  Click OK on the information modal. 

Step 8. Press the Open GEOPAK Job icon then select job number 101. 

Step 9. Double click on Port 1.  Set the Chain to Mainline by selecting it from the option list. 

Step 10. Press the Create Motif File icon. 
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Step 11. Populate the Create Plan Motif File dialog box as below. 

 

 

Note:  The Seed File can be selected by pressing the Select Seed Motif File icon then 
selecting Plan-Motif.dgn.  The Target File name should be entered manually. 

 
Step 12. Press OK on the Create Plan Motif File dialog box.  A file named Plan-Motif.dgn should 

be created in the working directory and the Plan Port Data dialog box should appear as 
below. 

 

Step 13. Press OK on the Plan Port Data dialog box.  The Layout Sheets dialog box should now 
appear as below. 

 

Step 14. In the Layout Sheets dialog box, set the Extend value for the Begin Station to –200.00.  
This will force the first sheet to end at Station 205+00.00.  The dialog box should appear 
as below.  Click the Layout 4 Sheets button to draw the clipping shapes into the design 
file. 
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 4 clipping shapes should be placed for the Plan port. 

Step 15. Dismiss the Layout Sheets dialog box by pressing the X in the upper right hand corner. 

Step 16. Exit the Plan and Profile Sheet dialog box and save your run.  Review the results. 

18.3   Profile Sheet Layout Process 
Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 

dialog box. 

Step 2. Create a run named Profile to set up the profile sheets. The dialog box should appear as 
shown below. 

 

Step 3. Select Settings>Sheet Layout.  Change “Profile Stair Stepping” option to On and 
“Sheet View Attributes” option to Customize with Motif Files then click OK.  The 
completed dialog box is shown below. 

 

Step 4. On the GEOPAK Sheet Layout dialog box, select PROFILE WITH SUPER from the 
sheet list then set the scale to 25.0000 ft/in.  The GEOPAK Sheet Layout dialog box 
should appear as below.  
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Step 5. Press the Sheet Composition icon.  Populate the Sheet Composition dialog box as 
below. 

 

Step 6. Dismiss the Sheet Composition dialog box by pressing the X in the upper right hand 
corner. 

Step 7. Press the Layout Sheets icon. 

Step 8. Press the Open GEOPAK Job icon then select job number 101. 

Step 9. Double click on Port 1.  Set the Profile to Mainline by selecting it from the option list. 

Step 10. Populate the remaining fields on the Profile (Port 1) dialog box by pressing the Identify 
Cell button then graphically identifying the profile cell.  The dialog box should appear as 
below. 
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Note:  The X and Y coordinates may be different than what is shown in the dialog box.  
They should match the insertion points of your profile cell. 

 

Step 11. Press the Create Motif File icon. 
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Step 12. Populate the Create Profile Motif File dialog box as below. 

 

 

Note:  The Seed File can be selected by pressing the Select Seed Motif File icon then 
selecting Profile-Motif.dgn.  The Target File name should be entered 
manually. 

 

Step 13. Press OK on the Create Profile Motif File dialog box.  A file named Profile-Motif.dgn 
should be created in the working directory and the Profile (Port 1) dialog box should 
appear as below. 

 

Step 14. Press OK on the Profile (Port 1) dialog box.  The Layout Sheets dialog box should now 
appear as below. 
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Step 15. Double click on Port 2.  Set the Profile to Mainline by selecting it from the option list. 

Step 16. Populate the remaining fields on the Tabular (Port 2) dialog box by pressing the Identify 
Cell button then graphically identifying the profile cell.  The dialog should appear as 
below. 

 

Step 17. Press the Create Motif File icon. 
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Step 18. Populate the Create Profile Motif File dialog box as below. 

 

 

Note:  The Seed File can be selected by pressing the Select Seed Motif File icon then 
selecting SuperDia-Motif.dgn.  The Target File name should be entered 
manually. 

 

Step 19. Press OK on the Create Tabular Data Motif File dialog box.  A file named SuperDia-
Motif.dgn should be created in the working directory and the Tabular (Port 2) dialog box 
should appear as below. 
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Step 20. The X an Y Coordinates need to be reset in order for the clipping shapes to be placed on 
the Superelevation Diagram.  Press the By DP button then snap to the line immediately 
left of the Superelevation Diagram lines.  The dialog should appear as below. 

 

Step 21. Press OK on the Tabular (Port 2) dialog box.  The Layout Sheets dialog box should 
now appear as below. 

 

Step 22. In the Layout Sheets dialog box, set the Extend value for the Begin Station to –200.00.  
This will force the first sheet to end at Station 205+00.00.  The dialog box should appear 
as below.  Click the Layout 4 Sheets button to draw the clipping shapes into the design 
file. 
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 4 clipping shapes should be placed for the Profile and Tabular Data ports. 

Step 23. Dismiss the Layout Sheets dialog box by pressing the X in the upper right hand corner. 

Step 24. Exit the Plan and Profile Sheet dialog box and save your run.  Review the results. 

18.3   Motif File Setup 
In the following steps we will set up the Motif Files created in the previous section so that the Plan 
view file will be displayed in the Plan Port and the Profile view file will be displayed in the Profile 
and Tabular Data Ports. 

Step 1. Open Plan-Motif.dgn. 

Step 2. Attach d17682des.dgn as a reference file.  Do a Fit View and Save Settings if 
necessary. 

Step 3. Open Profile-Motif.dgn. 

Step 4. Attach d17682prof.dgn as a reference file.  Turn off levels 30 and 63 in the reference 
file.  Do a Fit View and Save Settings if necessary. 

Step 5. Open SuperDia-Motif.dgn. 

Step 6. Attach d17682prof.dgn as a reference file.  Turn off level 63 in the reference file.  Do a 
Fit View and Save Settings if necessary. 

Step 7. Open d17682work.dgn. 

 

Note:  Any design file that needs to be clipped to the sheets should be attached to the 
Motif Files (e.g. Survey, Utilities, Contours, etc.). 

 

18.4   Move The Profile Clipping Shape 
You should notice that the vertical curve data doesn’t fall inside the second Profile Clipping Shape.  In 
the following steps we will move the Profile Clipping Shape utilizing the Modify tools in Plan and 
Profile Sheet Composition. 

All work should be done in c:\data\geo\VDOT\road1\d17682work.dgn.   
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Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 
dialog box.  Access the Profile run. 
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Step 2. Press the Modify Sheets icon.  The dialog box below should appear. 

 

Step 3.  Press the Identify button then graphically select the second Profile Clipping Shape.  The 
dialog box should now appear as below. 

 

Step 4.  Toggle on Bottom Elevation then enter 2000.00 for the elevation.  The dialog box 
should now appear as below. 

 

Step 5.  Press Apply.  Sheet 6, Port 1 should be moved down so that the bottom of the clipping 
shape is at elevation 2000.00. 

Step 6. Dismiss the Modify Sheets dialog box by pressing the X in the upper right hand corner. 

Step 7. Exit the Plan and Profile Sheet dialog box and save your run. 
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18.5   Renumber Sheets 
Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 

dialog box.  Access the Plan run. 

Step 2. Press the Sheet Number Manager icon. 

Step 3. Select Sequence Numbers 1 through 4 then press the Edit Sheet Number button. 

 

Step 4. Populate the Edit Sheet Number dialog box as below then push OK. 

 

The Sheet Number Manager dialog box should appear as below. 
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Step 5. Select Sequence Numbers 5 through 8 then press the Edit Sheet Number button. 

 

Step 6. Populate the Edit Sheet Number dialog box as below then push OK. 

 

 The Sheet Number Manager dialog box should appear as below. 

 

Step 7. Dismiss the Sheet Number Manager dialog box by pressing the X in the upper right 
hand corner.  Press Yes when prompted to Save Settings. 
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18.6   Clip Plan Sheets 
You should still be in the Plan run from the previous section. 

Step 1. Press the Clip Sheets icon.  Populate the Clip Sheets dialog box as below.  

 

 

Note:  The Sheet Title field will be used to place the Route Number. 

 

Step 2. Click the Process Sheets button to create the plan sheets. 

Step 3. Dismiss the Clip Sheets dialog box by pressing the X in the upper right hand corner. 

Step 4. Exit the Plan and Profile Sheet dialog box and save your run. 

Step 5. Open any of the newly created Plan Sheet files to see the resulting sheets. 
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18.7   Clip Profile Sheets 
The following steps should be done in design file d17682work.dgn. 

Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 
dialog box.  Access the Profile run. 

Step 2. Press the Clip Sheets icon.  Populate the Clip Sheets dialog box as below.  

 

 

Note:  The Sheet Title field will be used to place the Route Number. 

Step 3. Click the Process Sheets button to create the profile sheets. 

Step 4. Dismiss the Clip Sheets dialog box by pressing the X in the upper right hand corner. 

Step 5. Exit the Plan and Profile Sheet dialog box and save your run. 

Step 6. Open any of the newly created Profile Sheet files to see the resulting sheets. 

Step 7. Exit MicroStation. 
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D&C Manager - Quantities 
19.1   Introduction 
Objectives Understand the operational modes of the D&C Manager including 

calculating automated quantities. 

Project Manager Plan View Design 

Tools 

                      

Menu Bar Application GEOPAK Road > Design and Computation Manager 

GEOPAK 2001MR 

 

The Design and Computation Manager (D&C Manager) is a tool that enables the user to standardize 
graphics elements for drafting and pay item quantities.  To review how to access the Design and 
Computation manager, see session 7. 

One of the major goals of any design project is the cost-effective development of plans production 
sheets.  This includes construction plans, profile sheets, estimated quantities, and various other 
sheets needed to actually construct the design.  Although generic MicroStation commands can be 
utilized to produce the required sheets, several GEOPAK tools can be used in conjunction with the 
Design and Computation Manager and these MicroStation commands  to help automate the process.   

Other GEOPAK tools are within the Design and Computation Manager and various plan view 
functions: 

• Controlling Various MicroStation Copy Functions utilizing the Place Influence option and the 
Design mode 

• Controlling the MicroStation Display Filters (Display mode) 
• Changing the MicroStation symbology via GEOPAK Items (Set mode) 
• Identification of plan view areas to incorporate into the automated quantities (Shape mode) 
• Plan view quantities (Compute mode) 
• Pavement Markings 
• Pavement Symbols 

19.2   Operational Modes 
Several operational modes are supported within the Design and Computation Manager.  The Design 
mode was discussed in session 7.  In this session, the following modes are reviewed: display, set, 
shape, compute and pavement markings. 

19.2.1   Display 
Display mode is used to enhance on screen visualization by enabling the user to manipulate the 
display of GEOPAK intelligent elements.  
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The feature(s) to be visualized are added to the Collection box – the bottom window of the D&C 
Manager dialog box when set to Display or Compute modes.  Individual items or entire categories 
can be placed in the collection by utilizing the Add to Collection icon as shown below. 

     

Three display options are supported for the display of the items in the Collection box. 

• Highlight - changes those items stored in the collection area to the MicroStation highlight 
color. 

• Not - simply turns off the display of the collection items leaving everything else on. 
• Only - will turn off everything but the collection items. 

Before utilizing the display filters, visualization is enhanced if all the elements on the screen are gray, 
or another singular color, rather than the vast conglomeration of color seen on the screen for a typical 
project.  Therefore, to set the color, select Settings > Display from the menu bar.  The Display 
Preferences dialog box appears. 

 

19.2.2   Set 
The Set mode allows the user to assign attributes from the ddb database to existing graphical 
elements in the file.  Three methods are available for specifying the graphic elements to be changed: 
individual element selection, Complex Chain or MicroStation Selection Set. 

When changing individual elements, highlight the desired item in the D&C Manager dialog box.  Click 
Set, then datapoint the element to modify, then datapoint off the element to accept. 

Complex Chain automatically creates a chain from graphic elements and applies the attributes of the 
highlighted item in the content box. 
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To modify the symbology of many elements to a single item, create a MicroStation Selection Set of 
the elements.  Next, click Set to transfer the attributes of the item selected in the D&C Manager to the 
items identified in the MicroStation design file. 

     

19.2.3   Compute 
An important, yet time-consuming part of any project is the computation of quantities. Through the 
Compute mode of the Design and Computation Manager, GEOPAK offers tools that make the 
completion of this task much quicker and easier.  In addition, since the software utilizes the plan view 
construction drawings to compile quantities, discrepancies between the drawings and the tabulated 
quantities are non-existent.  Chosen items within either the View or a Fence are calculated 
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Once the MicroStation plan view design file is accessed, the first step is to invoke the Design and 
Computation Manager and click the shortcut button at the top of the dialog box to Compute. 

The dialog box changes dynamically to reflect the compute operation. 

The Design and Computation Manager dialog box is resizable.  Within the dialog box, the sash (long, 
thin bar between list boxes) enables the user to adjust the partition between the list and collection 
boxes while the overall dialog box size remains constant.  Simply place the cursor over the sash and 
dynamically move. 

In addition to dynamically adjusting the main dialog box to reflect the compute operation, the auxiliary 
dialog box is invoked as depicted below.  Note if the auxiliary dialog box was already invoked from 
another operation, it dynamically changes to reflect the Compute operation. 

The next step is the selection of the correct item from the hierarchy.  GEOPAK computes quantities 
only for those hierarchical items that are configured for the computation of quantities. 

Two selection methods can be employed.  The first method is to select an entire category.  GEOPAK 
computes quantities for every item found in the selected category as well as any child categories.  
This is accomplished by double clicking through the groups until the desired category is contained in 
the Content list box.  Single click onto the desired category and click the Add to Collection button at 
the top of the dialog box. 

The second method involves the selection of individual features.  This is accomplished by double 
clicking through the categories until the desired item appears in the hierarchy list box.  When seen in 
the hierarchy list box, a single click onto the desired item and subsequent click of the Add to 
Collection button places the item in the Collection box. 

Several output formats are available as described in the table below. 

Item Report  Quantities Summary listing pay items, descriptions, units and total quantities for 
located elements.  File is in ASCII format. 

Comp Book  A more detailed report that lists not only quantity summaries, but also geometric 
properties such as plan view coordinates and station/offsets for located elements.  
File is in ASCII format. 

Item Tables  Contains the same information as the Item Report, but formatted in tabular form. 

SDF Item 
Report 

Quantities Summary listing pay items, descriptions, units and total quantities for 
located elements.  Format is in SDF or CSV format. 

SDF Comp 
Book  

A more detailed report that lists not only quantity summaries, but also geometric 
properties such as plan view coordinates and station/offsets for located elements.  
Format is in SDF or CSV format. 

DBMS Very detailed information including calculated and rounded quantities, geometric 
properties, pay item numbers, descriptions, station / offset values, etc. The format 
is the selected database (i.e., Microsoft Access, Oracle, SQL Server, and dbase. 
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An option button located on the left side of the Compute auxiliary dialog box dictates the Output.  
Options that apply to various Output types are detailed in the table below 

View / Fence If the View toggle is selected, only selected items that can be seen in 
MicroStation view one will be computed.  If the view includes area outside of 
the Range, the Range will override.  If the Fence toggle is selected, a fence 
must be placed, and all specified graphical features which are inside both 
the fence and the Range will be tabulated.  The Fence mode is sensitive to 
the MicroStation Inside, Overlap and Clip modes. 

File / Preview If set to File, GEOPAK creates the file whose file format is based on the 
Output type and whose name is defined in the key-in field to the right of the 
File option.  The name can be manually entered or selected via the Files 
(folder) icon.  The file can be created or appended to an existing file.  If 
desired, a full path may be specified, otherwise, the report will be found in 
the current directory.   

If the option is set to Preview, the file is not created and the output is 
displayed in a GEOPAK window. 

Description Any description keyed within this field will be printed at the top of the report.  
There is a maximum of 48 characters supported for this field. 

Display These short cut icons are functionally identical to the Display mode in the 
main dialog box and are discussed in the next section.\ 

Highlight in 
Computation 

When activated, all MicroStation elements utilized in computations are 
highlighted. 

Compute Commences the computation process. 

Job Number  GEOPAK Coordinate geometry database (GPK) file wherein the specified 
chain is stored.  

Chain Requires a minimum of one chain which must be stored in the specified job 
number.   

Select When selected, the Chain Selector dialog box appears, wherein the user 
can select the desired chain.   

Range Left and right offset limits (in master units) from the chain where the 
quantities will be computed.  Any specified item located outside of the limits 
is not included in the report 

Phase Quantities can be separated into various phases, as a means to group 
various pay items.  Default phases include:  Design, Preliminary, and Final.  
Note the user can add new phases, but must be aware of naming limitations 
of downstream applications (i.e., Transport links in Quantities Manager.) 

Run The user may also runs as a method of grouping various quantities and / or 
pay items.   

19.2.4   Shape 
The placement of shapes for area quantities is simple and fast when utilizing the shape mode.  In 
order to place a shape, GEOPAK must identify a closed area.  This area can be defined by 
intersecting elements, which do not have to be clipped or shortened to define the closed area.  There 
are three options for placing shapes depending on the complexity of the plan view and the type of 
area where quantities are desired: 
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• Automatic - best utilized when the elements forming the shape do not conflict with other 
elements in the view. 

• Semi-auto - utilized when the plan view has more conflicting elements or where the selection 
of an area produces very small shapes.  In this method, the user is prompted when each 
element is selected to determine the path of the software in producing shapes. 

• Exclusive - This option utilizes the automatic option, but in addition, prompts the user for the 
identification of an area inside the original shape that is excluded from the area quantity.  The 
Exclude mode is useful for curb and gutter around a traffic island. 

Any of the three options may be chosen during the course of shape placement.  To change from one 
option to another, simply adjust the option button on the right side of dialog box. 

 

 

19.2.5   Pavement 

 

The Pavement mode allows the user to place pavement marking including striping, and symbols. 

The various tools are detailed in the table below. 
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Striping 

 

Places single or double, solid or skip pavement stripes. 

Separation 

 

Places traffic separation pavement marking. 

Chevron Diverge  

 

Places pavement chevrons in areas of diverging traffic. 

Chevron Merge 

 

Places pavement chevrons in areas of merging traffic. 

Symbols 

 

Places pavement marking symbols with a specified pattern. 

19.2.5.1   Single Striping  
This dialog box offers predefined configurations for single stripe 
and double stripe options to easily control the type of striping 
being placed. 

The pay item reflects the currently selected pay item in the D&C 
Manager dialog box; however, it may be changed at any time 
during the process. 

Next, define the start option by selecting Solid or Skip (or a 
combination thereof).  If Skip is active, the user must define the 
stripe and skip lengths.  If an ending stripe is shorter than the 
Tolerance value, it will not be drawn. 

A beginning and ending point for the limits of striping are 
entered from digitized points on the screen. 

The lower portion of the dialog box provides tools for identifying 
the reference element on which the striping will be based. 

 

After clicking Apply, the user must enter a data point on either side of the reference element to begin 
striping.  Striping is placed at the indicated offset value; the data point controls whether striping is 
offset left or right.  Striping is placed as a graphic group. 
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19.2.5.2   Double Striping 
The process for Double Striping is the same as Single, except 
for having two pay item placement options, Inside and Outside 
and a user definable Distance Between Stripes.  The user must 
select either the Inside or Outside button for the highlighted 
(D&C Manager) pay item to be displayed in the dialog box.  
Separate quantities are calculated for each stripe.  

The remaining process is the same as described above. 

 

19.2.5.3   Separation 
This option draws pavement markings between two sets of 
selected elements.  Elements may be either GEOPAK or 
MicroStation generated.  

Once a pay item has been selected, the user may set the 
Distance Between Stripes and the Slash Stripe Angle.  
Tolerance functions the same as for striping. 

A Begin DP and End DP should be issued before the Reference 
DP is identified.  The Reference DP must fall between the 
beginning and ending DP.  It marks the location of the first 
pavement marking and determines the direction of the slashed 
stripe.  All other markings will be based on the first stripe. 

Tools for defining the limits of the pavement markings are located 
at the bottom of the Separation dialog box.  ID Intersection 
identifies the elements where the striping will terminate.  ID 
Location is the set of elements from which the striping begins. 

After the Apply button is selected, the user must issue a data point in the graphics file for the 
pavement markings to be displayed. 
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19.2.5.4   Chevron Diverge 
Once the pay item and its relative parameters have been defined, 
there are three points needed to define the chevron: Gore, 
Breaking Line and Point. 

The Gore point defines the wide end of the gore. 

The Breaking Line point must fall between the two sides of the 
gore and sets the location of the point at which the chevron 
diverts in a different direction. 

The Point represents the narrow end of the gore where chevrons 
are to stop. 

Use the two ID buttons to identify the sides of the gore.  Once the 
Apply button is selected, the chevrons are displayed. 

19.2.5.5   Chevrons Merge 
This process works basically the same as Chevron Diverge 
except the two points, Gore and Breaking Line, have been 
combined into one point that serves both functions.  

The Gore and Break DP should be located near the wide end 
of the chevron.  It simultaneously sets the beginning of the 
pavement markings and the point at which the chevron will 
break. 

The remainder of the process is as described above. 
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19.2.5.6   Symbols 
The Cell Group Info defines the cells to be 
placed. 

Layout enables the user to repeat the cells, and 
to set the locations of where the cells are placed.  
The cells can be placed offset to element(s) in a 
MicroStation Selection Set, Complex chain or any 
COGO Chain. 

The Limits can be defined via XY coordinate 
pairs projected to the elements in the Selection 
Set or Complex Chain.  If a COGO chain is 
utilized, beginning and ending stations fields are 
utilized. 

Once all values are set as desired, click Apply to 
begin placing the cells.  One additional DP is 
required to define the offset direction relative to 
the selected element. 

** Note:  This dialog box works in conjunction with 
the pulldown User > Hierarchical Paths on the 
main dialog box. The symbols dialog box 
searches all items listed under the category 
specified by Hierarchical Paths and then lists all 
cells referred to by those items. 
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LAB 19:   Quantities with D&C Manager 
19.1   Accessing Plans Production Tools 

Step 1. Execute C:\data\geo\VDOT\road1\LAB19.EXE. 

Step 2. Open the MicroStation file c:\data\geo\vdot\road1\d17682des.dgn. 

Step 3. Access the Road Workflow dialog box in Project Manager. 

 Click the Plan View Design button.  This opens the Plan View Design tools tool 
frame.  Open Design and Computation Manager by clicking the left most icon. 

 

Step 4. D&C Manager should open up to the standard VDOTenglish.ddb. 

  Navigate to the category Location & Design > Curbing as shown. 
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19.2   Compute Quantities 
Step 1. Set the current D&C mode to Compute. 

 Highlight the item 012020 Standard Curb CG-2. This will make it the active item for 
computing quantities. 

 

 

Step 2. Set the output option to Item Report in the supplemental dialog box. 

Step 3. Since we are doing the quantities based on what is displayed in View 1, be certain to fit 
all graphics in View 1. 

Step 4. Before clicking the Compute button, use the Display options to make sure there are 
graphics to compute for this item. 

 By clicking on the icon as shown below, all graphics except the appropriate curb graphics 
should be turned off. 

 

Step 5. Click Compute.  Review the output.   
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 Dismiss the Output dialog box. 

Step 6. Now let’s see how to compute multiple items at one time. 

 Returning to the main D&C dialog box, add the curb item to the collection box as shown: 
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Step 7. Navigate down and add another curb item to the collection box as shown: 

 

Step 8. Click Compute.  Review the output.   

 

 Dismiss the Output dialog box. 

Step 9. Exit Design and Computation Manager. 

Step 10. Exit MicroStation. 
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3D Modeling   

20.1   Introduction 
Objectives  - Create 3D cross sections from 2D cross sections 

 - Interpolate between 3D cross sections to create B-spline 
   surfaces. 
 - Use Drive Through to view the model 
 - Place pavement markings on the 3D model 

Project Manager 3D Models 

Tools 

                     
 

Menu Bar Application GEOPAK Road > 3D Tools > 3D Modeling 

 
GEOPAK 3D Modeling is a process of deriving three-dimensional cross sections from two-
dimensional cross sections and interpolating between the three-dimensional cross sections to create 
b-spline surfaces that represent the design. 

20.2   Prerequisites 
Before a 3D model can be extracted from 2D cross sections, there are a few prerequisites that must 
be met.  They are: 

? 2D design cross sections - The user should have an existing design file where 2D cross 
sections are stored and know which levels contain the existing ground line and proposed 
finished grade. 

? Plan view graphics - The user must also have another 2D-design file containing plan view 
graphics.  The plan view graphics should include the elements that match the cross section 
features such as EOP, shoulders, etc specified in the Run. 

? 3D design file - A blank 3D-design file must exist to store the 3D cross sections as they are 
generated.  Enter the 3D-design file and attach the 2D-plan file as a reference file (the 
baseline must be plotted in the plan file).  Save the settings of this file with only the Top View 
displayed. 
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20.3   3D Modeling Tools 
From a 3D-design file, access the 3D modeling tools by selecting Project Manager > 3D Models or 
by selecting the 3D Models icon.   

 

The dialog box appears requiring a Job number and Chain name.  This session primarily focuses on 
3D Cross Sections, Interp Between XS and Pavement Markings.  Descriptions of available 3D 
modeling tools follow:  

? 3D Alignment - draws elements into a 3D file, at correct coordinates, using the specified 
alignment and profile. 

? Superelevation Surfaces - is used to draw GEOPAK generated 2D shapes into B-spline 
surfaces, within a 3D model, following user defined plotting parameters. 

? 3D Cross Sections - references your 2D cross section file and create a 3D complex chain to 
represent the 3D cross sections. 

? Interp Between XS - interpolates between the 3D cross sections to create B-spline surfaces. 
? Pavement Markings - adds pavement markings to a 3D model.  The pavement-marking tool 

scans pavement markings in a 2D file and draws the markings in the 3D file based on user 
defined parameters. 

20.4   3D Modeling Process 
GEOPAK opens the 2D cross section file, scan the cross sections and create a complex line-string 
based on the cross sections.  GEOPAK then returns to the 3D design file to draw the 3D cross 
sections.  B-spline surfaces must be created using Interp Between XS. 
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20.5   Generate 3D Cross Sections 
Enter the 2D cross-section file containing design cross-sections; GEOPAK reads the file to determine 
the beginning and ending station of the cross-sections.  These stations are automatically displayed in 
the dialog box, however, the user may key in a different range. 

Define the attribute information for Existing Ground Line and Proposed Finished Grade.  If Project 
Manager is active, these attributes can be filled out automatically by the Working Alignment. 

Select Apply to commence processing. 

GEOPAK opens the 2D cross-section file and begins creating 3D complex line-strings from each 
cross-section.  Each 2D cross-section will highlight as the line string is formed.  This gives the user a 
brief opportunity to check for errors.  When the process is complete, GEOPAK returns to the 3D file to 
draw the cross-sections. 

A visual inspection of the 3D cross-sections should be performed to verify their integrity.  The colors of 
the 3D-line string should reflect the same colors as shown in the 2D-design cross section.  If an error 
has occurred, the user should return to the 2D-design cross section file and fix the appropriate cross 
section(s) using GEOPAK and/or MicroStation.  Repeat the 3D cross-section process for any revised 
cross-sections and review. 

20.6   Interpolation Between XS 

 

Two Methods exist for interpolating cross-sections:  

? Longitudinal - is used when a 2D-plan view is referenced to the 3D cross-section file.  
This is the most common method. 

? Surfaces - should be selected when your plan view reference file is a 3D file. 

Beginning Station and Ending Station - values will automatically be displayed when each of their 
offsets are defined.  Offset information must be entered in order and is controlled by successive 
activation of the DP buttons.  The user must define the Beginning Station offsets by first issuing a DP 
for the left and right offset locations.  The same process is repeated for the End Station box. 

Highlight Applied Breaklines - will highlight the break lines used in interpolation when toggled on. 

Select the Draw Surfaces bar at the bottom of the dialog box to begin the interpolation process.  The 
user is encouraged to process a small range of cross sections until the entire project has been done.  
When GEOPAK interpolates 3D cross sections, it projects like color to like color between cross-
sections.  All MicroStation elements should maintain a consistent color scheme throughout the 
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project.  For example, within a 2D file, all ditch slopes should be drawn the same color and roadway 
lines should also be drawn using one color.  If colors do not correspond, you will get a “Color 
Mismatch” error and the process terminates.  There are two ways to correct this error: 

? Check the cross sections for an inconsistent color scheme, correct any errors, then 
regenerate the necessary cross sections, or 

? Activate the Force Color toggle; this will allow GEOPAK to ignore the color of the cross 
section elements and interpolate using only the specified color. 

After interpolation is complete, review the 3D model using GEOPAK Drive Through. 

20.7   GEOPAK Drive Through 
Project Manager 3D Models 

Tools 

                      

Menu Bar Application GEOPAK Road > Other Components > Drive Through  

 

GEOPAK Drive Through provides the user realistic visualization of 3D surfaces.  When invoked, the 
dialog box below is displayed.  

 

The user must enter the Job Number and a Chain name.  The drive through will follow this chain or 
may be offset from the chain by entering a value in the Plan View Offset box. 

Two options are available to define the distance the driver is from the roadway vertically: 

? Constant Elevation will place the driver at a fixed elevation, as defined by the user, 
throughout the drive through process. 

? Vertical Offset places the driver at a specified distance above the model, meaning the 
elevation of the view changes with the elevation of the model. 

The Station value automatically displays the beginning station of the selected chain, but may be 
changed by user key-in. 

Step Increment defines the distance traveled between each camera view. 

Target Offset defines how far down the road the viewer is looking (the focal point). 
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Pressing the Locate Starting Point button finds the first station on the alignment where a 3D graphic 
element is present.  This is a convenient way to locate the start of a model. 

View indicates the MicroStation view to be processed. 

Press the Apply bar to activate the first camera view.  Once the first view is displayed, the user may 
pan the view by moving the slide bar to the desired angle and pressing the Apply button again. 

After viewing the model: 

? Restore the view by rotating to the top view. 
? Access the Settings > View Attributes dialog box from the MicroStation command 

window and toggle Camera off (automatically toggled on during drive through process). 

20.8   Pavement Markings 
This tool places pavement markings in a 3D file by extracting graphic information from the plan view 
2D file.  

 

Note: Pavement markings created by copying parallel a complex element must be dropped before 
they can be included in a 3D model. 

Enter the name of the 2D graphics file containing pavement markings. 

Provide Search Criteria by entering the graphic attributes of the pavement markings. 

Stripe Width reflects the actual width of the plan view stripe you want to create. 

Surface Elevation Offset is the distance from the B-spline surface the stripe shape is drawn.  Special 
attention needs to be applied to this value.  If the distance is too low, the stripe may fade into the 
roadway; if the distance is too high, the stripe may cast a shadow on the road surface when the model 
is moved to a visualization software package.  It is desirable to place the stripe just above the surface.  
Begin by using a value of 0.10; if adjustments are necessary, use small increments. 
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LAB 20:   3D Modeling 

20.1   3D Alignments 
Step 1. Execute C:\data\geo\VDOT\road1\LAB20.EXE. 

Step 2. Open the MicroStation file c:\data\geo\vdot\road1\d176823d.dgn 

Step 3. Click 3D Models from the Project Manager dialog box and populate the dialog box as 
shown.  Chain – MAINLINE. 

 

Step 4. From the 3D Modeling Toolbox click 3D Alignment.  Be sure the chain Mainline and 
profile Mainline are selected.  Populate the rest of the dialog box as shown below. 

 

 Click the Apply button. A 3D alignment is created in your design file. 

Step 5. Dismiss the 3D Alignments dialog box. 
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20.2   Generate 3D Model 

 

 

 

Step 1. Select 3D Cross Sections from the 3D Modeling Toolbox. 

Step 2. Set the Active MicroStation level to 2 and Save Settings.  Each line representing the cross 
section will be drawn on this level. 

Step 3. Populate the dialog box as shown, then press Apply.  The software scans each section 
and draws the 3D Cross Sections. 

 

 Dismiss the 3D Cross Sections dialog box. 

Step 4. Select Interp Between XS from the 3D Modeling Toolbox. 

 

Step 5. Attached the Saved View “BEGIN” (Utilities > Saved Views). 

Step 6. Set the active MicroStation level to 30 and Save Settings.  This will force the B-spline 
elements to level 30. 
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Step 7. Click File > Reference on the Microstation menu bar.  Turn on the reference file display 
for the design file d17682des.dgn. 

Step 8. Fill in the dialog box as shown below and click Draw Surfaces.  

 

  

Use the Station button to identify the appropriate 3D Cross 
Section. This will fill out all the fields automatically.  

 

Step 9. You will see the following warning message. Click OK. 

 

Notice that several areas were not able to be completed because of the color mismatch 
between stations 202+00 and 202+25. In the next several steps you’ll see how to 
handle these situations. 

Step 10. Use the MicroStation pulldown Edit > Undo to delete the elements that were just drawn. 
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Step 11. Fill in the dialog box as shown below and click Draw Surfaces. This will complete the 
interpolations between 200+00 and 202+00. 

 

Step 12.  Fill in the dialog box as shown below and click Draw Surfaces. This will complete the 
interpolations between 202+25 and 204+25. 

 

Step 13. Attach the Saved View “COLOR1”. Notice that this area was not interpolated because of 
a color mismatch. We will handle this area in the next step. 

Step 14. Fill out the dialog box as shown below and click Draw Surfaces. 
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Step 15. Attach the Saved View “COLOR2”. Notice that this area was not interpolated because of 
a color mismatch. We will handle this area in the next step. 

Step 16. Fill out the dialog box once again as shown below and click Draw Surfaces. 

 

Step 17. Attach the Saved View “HOLE”. Notice that this area was not interpolated because of a 
color mismatch. We will handle this area in the next step. 

Step 18. Fill out the dialog box as shown and click Draw Surfaces. 

 

Step 19. Dismiss the Interpolation Between XS dialog box. 

Step 20. Dismiss the 3D Modeling Tools dialog box. 
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20.3   Drive Through 

 

 

 

Step 1. Open the MicroStation file c:\data\geo\vdot\road1\3DModel.dgn 

Step 2. Click the GEOPAK Drive Through tool from the Road Tools toolbox. 

Step 3. Populate the dialog box as shown below. 

 

Step 4. Click the Locate Starting Point. 

Step 5. Click the Apply button to move through the model.  For each click on the Apply button, 
the current station is incremented by the value in the Step Increment field. 

Step 6. Exit MicroStation. 
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